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About this manual 
This data management manual will explain in detail all data management procedures for the 
Assessment of Minimum Proficiency Levels (AMPL). 

Chapter 1 is an introductory chapter. In this chapter the data management tasks for the AMPL are 
outlined, the roles of different data management staff are defined, and the terminology used in this 
manual is explained. 

Chapter 2 gives a short overview of the data management software ACER Maple and describes its 
installation, initialisation, and user settings. The main ACER Maple functions available to AMPL users 
are also outlined in this chapter. 

Chapter 3 details all the documentation that is necessary for data management. 

Chapter4 explains how to prepare for data administrator training. 

Chapter 5 first provides instructions on checking and importing List of Classes and List of Students data 
into ACER Maple to be sampled for assessment1.  

When these data is imported, ACER Maple performs some checks of the data and if discrepancies are 
found produces the Import Field Data Validity Report. The second part of chapter 5 explains how to 
resolve these discrepancies.  

Chapter 6 provides instructions on how to undertake class and student sampling in ACER Maple. 

Chapter 7 provides instructions on how to populate tracking form templates with data from ACER 
Maple. The tracking form Excel templates that are despatched with ACER Maple are used for this 
process. Any discrepancies that may be produced in the Export Field Data Validity Report are also 
explained. 

Chapter 8 provides instructions on labelling and packaging materials. 

Chapter 9 Explain procedures related to the receipt of materials after the assessment:  
• First it provides instructions on how to check the materials received from Test Administrators  
• Then it explains how to check and import updated tracking form data into ACER Maple, and the 

errors and warnings that may be listed in the Update Field Data Validity Report.  
• Finally it describes how to update the School Participation Form and what to do with the Update 

Institution Participation Validity Report which may be generated if there are discrepancies in the 
school participation data. 

Chapter 10 explains how to organise data entry of responses after the assessment and provides 
instructions for data entry operators that can be used for their training. 

Chapter 11 is the data submission chapter. It describes the tasks for explaining any discrepancies 
remaining in data and then submitting the data to ACER for further processing. 

Appendix 1 contains checklists that have to be filled when data is ready to be submitted to ACER. 

Appendix 2 contains troubleshooting advice. 

Appendix 3 contains procedures for ‘blind’ sampling. 

Appendix 4 contains an index of tables. 
 

 
 
1 In this manual, student refers to a learner or a pupil to be assessed and class refers to a grouping of students in the same 
grade level, taught by the same teacher. 
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Appendix 5 contains an index of figures. 

This manual uses acronyms and technical terms. You can find the list of the most common acronyms 
at the end of this section. The terms are explained where they first used.  

Throughout the manual important notes and warnings are indicated using the following formatting:  
  

 
This is an important note or an ACER Maple tip. Many of these notes are AMPL 
requirements. 

 
  

 
This is a warning. Information in these boxes is crucial for correct procedures and must be 
read and followed carefully. 

 
  

 
This is a Note to National Centres participating/not participating in certain options  agreed 
upon with ACER. 

 

In this manual, screenshots are used to illustrate examples of how the different ACER Maple features 
are used. 
  

 
Please note that although ACER Maple functionality in screenshots corresponds to version 
2. 16 or higher, some details, like version number, user details, or template column names 
can be different from what you will see on your screen. 

 

Acronyms used in this manual 

ACER Australian Council for Educational Research 

AMPL Assessment of Minimum Proficiency Level 

AMPLa AMPL design a is intended for the students from the end of lower primary school 

AMPLb AMPL design b is intended for the students from the end of upper primary school 

AMPLab AMPL design a+b is intended for the students from the end of upper primary school with 
the link to the students from the end of the lower primary school. 

DMR Data Management Resources are various Excel templates and Word documents that are 
necessary to complete data management tasks 

DMTP Data Management Training Package Part 1 contains a Power Point presentation and other 
materials related to the data management tasks to be completed by the National Centre 
before the assessment 

LCL List of Classes from which a class eligible to participate in the AMPL is sampled 

LSS List of Sampled Schools agreed between ACER and the National Centre and imported into 
ACER Maple by ACER 

LST List of Students from the sampled class. Only these students are eligible to participate in 
the AMPL. 

MRWF Main and Replacement Warning Form – one of the ACER Maple forms used to explain 
warnings produced when field data is imported or updated. 

NC National Centre 
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PC Personal Computer running a Microsoft® Windows operating system (laptop or desktop) 
 

QAS Questionnaire Adaptation Spreadsheet agreed between the ACER and the NC 

QSA Questionnaire Structural Adaptation form agreed between the ACER and the NC and 
imported into ACER Maple by the ACER 

SC School Coordinator 

SCL Sampled Class form is filled with the details about sampled class 

SEN Special Education Needs 

SALF Student Assessment Labelling Form used to label student assessment instruments 

SPF School Participation Form used to register school participation status 

SQTF School Questionnaire Tracking Form used to label School Questionnaires and to record the 
receipt of the School Questionnaires 

SCQ School Questionnaire filled by school principals 

STF Student Tracking Form populated with sampling data from ACER Maple and used by Test 
Administrators to record student attendance and participation. 

STQ Student Questionnaire administered after the AMPL test 

TA Test Administrator 

TCS Target Cluster Size 

VM Virtual Machine Oracle VM VirtualBox software version 6.1.42 
(https://www.virtualbox.org/wiki/Download_Old_Builds_6_1) 

 

 

https://www.virtualbox.org/wiki/Download_Old_Builds_6_1
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1.2 Terminology......................................................................................................................... 11 

1.2.1 Domain (Survey ID, Entity ID and Admin ID) ....................................................................... 11 
1.2.2 Templates and related terms .............................................................................................. 12 
1.2.3 Discrepancies in validity reports .......................................................................................... 12 
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1.1 Overview of data management tasks 
  

 
Data management with ACER Maple is a requirement for the AMPL. 

Data management is a critical part of the AMPL data collection. It is preceded by school sampling, 
AMPL questionnaire adaptations, and preparation of all assessment instruments for printing. Once 
school sampling and all adaptations have been completed and all assessment instruments have been 
prepared for printing, the ACER data management team customises the data management software 
ACER Maple for your National Centre (NC). 

When the ACER data management team complete customisation of ACER Maple for your NC, you will 
be notified by ACER that a version of ACER Maple pre-configured for your NC has been uploaded to 
designated website. ACER will also explain how to download ACER Maple from designated website and 
will provide you with temporary login details to log into ACER Maple for the first time. 
  

 
Please make sure that well before you start on any other data management tasks. the List 
of Sampled Schools (LSS) and the Questionnaire Structural Adaptations (QSA) have been 
agreed between your NC and ACER; and you are familiar with the content of these files (see 
section 2.4 for details). 

The entire data management process involves the following major tasks performed at the NC: 

Before the assessment 
1. Installation and initialisation of ACER Maple (chapter 2). 

2. Checking documentation and training test administrators (chapters 3 and 4). 
3. Checking and importing data for sampling (chapter 5). 
4. Class and student sampling (chapter 6). 
5. Populating tracking form templates with data from ACER Maple (chapter 7). 

6. Labelling assessment instruments (chapter 8). 

After the assessment 
7. Updating data from tracking forms in ACER Maple (chapter 9). 

8. Organising data entry and entering response data (chapter 10). 
9. Data submission to ACER and data cleaning participation (chapter 11). 

The sequence of data management tasks is illustrated in Figure 1. This figure shows which tasks are 
performed before the assessment and which are performed after the assessment. It also shows that 
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different tasks are performed by different personnel: data manager, data administrators and data 
entry operators. Their roles are defined in section 1.3. 

 
Figure 1: Data management tasks for the AMPL 

All tasks illustrated by Figure 1 are first outlined in this chapter and then explained in detail in the 
subsequent chapters of this manual.  
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Before the assessment: 

A) Make sure that: 
• you have enough workstations for data administrators; 
• the PC on which you intend to install ACER Maple (called the host PC) satisfy all system 

requirements (section 2.2); 
• check the PC set-up (section 2.3);   

ACER Maple should then be downloaded from designated website, installed and initialised (sections 
2.5 -2.9). 

B) After you download and initialise ACER Maple you need to prepare and check all materials necessary 
for student sampling and data entry. These are: 
• initial data: 
• templates for field operation forms such as List of Classes (LCL), List of Students (LST) and Student 

Tracking Forms (STF); and 
• the data entry screens for the AMPL assessment instruments such as tests and questionnaires. 

Chapter 3 explains how to prepare and check necessary materials. 

C) After ACER Maple has been installed on a host PC, and all materials have been prepared and 
checked, the data manager can train data administrators (chapter 4). 

D) After data administrators have been trained, they will start checking class lists received from schools 
and formatting them into LCL files, then importing the LCL data into ACER Maple (sections 5.2 and 5.4).  

E) After data from the LCL have been successfully imported into the ACER Maple database, class 
sampling is undertaken, which results in the one class being sampled (chapter 6) and SCL form 
populated with the sampled class data (chapter 7).  

F) The SC must be contacted and asked for the student lists from the sampled class. Data administrators 
will check and format the student lists received from schools into the LST files, then import the LST 
data into ACER Maple (sections 5.3 and 5.4). 

D&F validation) Each time the data is imported into ACER Maple, the software will check the imported 
data for inconsistencies. Detected inconsistencies will be listed in the Import Field Data Validity Report. 
Some of these inconsistencies may be errors that must be corrected before student sampling can 
proceed, while others may be warnings of missing data that can be completed later by Test 
Administrators on the tracking forms (section 5.5). 
  

 
Data will only be transferred into the ACER Maple database when all errors have been 
corrected. 

G) After data from the LST have been successfully imported into the ACER Maple database, student 
sampling is undertaken in order to produce tracking forms with student identification and instrument 
allocation designated to each student (chapter 6). 

H) After students are sampled, the data from ACER Maple is used to fill:  
• the STF Excel template (chapter 7) and  
• the SALF and SQTF templates used to label assessment instruments (chapter 8).  

STFs that have been pre-populated with data from ACER Maple are then sent to the SC to be checked 
and updated before the assessment. Once finalised, the STF is then sent, together with other materials, 
to the TA to be used during the assessment.  
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After the assessment: 

A) The materials received from Test Administrators are checked, further updated (if necessary) and 
prepared for processing in ACER Maple (chapter 9). This involves: 
• Checking all student assessment instruments (test booklets and questionnaires) against the STF 

and arranging assessment instruments for data entry (section 9.1). 
• Updating student demographic data (if corrected by the TA/SC) and participation data in ACER 

Maple, from the returned STF checked against student assessment instruments. This is usually 
done school by school. Errors that appear in the Update Field Data Validity Report must then be 
corrected in the data. Records that classified as warnings and found to be true do not need to be 
corrected (see details in sections 9.2, 9.4, and 9.5). 

• Maintaining the School Questionnaire Tracking Form (SQTF) on receipt of the School 
Questionnaire. The SQTF is also updated by the data administrator in ACER Maple after all 
materials are returned and all student tracking data has been updated. Errors that appear in the 
Update Field Data Validity Report must then be corrected in the data. Records that classified as 
warnings and found to be true do not need to be corrected (sections 9.3 and 9.5). 

• Maintaining the school participation status for each school during field operations. The School 
Participation Form (SPF) is updated by the data manager in ACER Maple after all student tracking 
data and the SQTF have been updated. Errors that appear in the Update Institution Participation 
Validity Report must then be corrected in the data. Records that classified as warnings and found 
to be true must be explained (sections 9.6 and 9.7). 

B) While students are being assessed, office space and PCs for data entry operators must be prepared, 
and data entry operators should be employed and trained (section 10.1). 

C) When most of the materials have been received, checked, and prepared, data entry of responses 
can commence (section 10.2). 

D) After data entry is completed, it must be validated in ACER Maple against the updated tracking data. 
Errors that appear in the Respondent Validity Report must then be corrected in the data. Warnings 
found to be true must be explained (sections 10.3 and 10.4). 

E) After all data has been checked, corrected, and warnings have been explained (where necessary), 
the data is submitted to ACER. The data manager then works with a member of ACER data 
management team to verify the data further (chapter 11). 

1.2 Terminology 

This section provides definitions for terms that are used throughout the manual that have not been 
explained in previous sections. 

1.2.1 Domain (Survey ID, Entity ID and Admin ID) 

Due to the secure nature of the AMPL data, each member of the NC data management team will only 
be able to access part of the AMPL database. The part of the database to which an ACER Maple user 
has access is called the domain. 

Domain is defined combination of Survey ID, Entity ID and Admin ID. 

Survey ID for the AMPL is defined as 033. 

Entity ID is a 6-digit string based on your country 3-digit ISO code and year level assessed (see Table 1). 
One NC can have one or more entities depending on how many grade levels they are assessing in how 
many languages. This will allow countries assessing more than one grade level to have more than one 
data manager (one data manager for each grade level and for each language of assessment). 
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Table 1:Entity IDs for countries participating in the AMPL 

Country Grade Test design Entity ID Language 

India 

3 a 035631 ENG 

5 b 035651 ENG 

5 b 035652 HIN 

Kenya  6 ab 040460 ENG 

Lesotho 
4 ab 042640 ENG 

7 ab 042670 ENG 

Zambia 
4 a 089440 ENG 

7 ab 089470 ENG 
 

Admin ID is an administrative set of schools within each entity. The Admin ID values are assigned in 
the List of Sampled Schools (LSS). Each set of schools is assigned a different two-digit Admin ID value 
(starting from '01') within each entity as required. This is done to allow several data administrators to 
work simultaneously each one administering data for the set of schools within a particular Admin ID.  
  

 
In addition to the Admin ID values assigned in LSS, a special value of Admin ID='00' is used 
by the data manager for operations related to all schools in the entity. This value is not 
used in LSS. 

 

1.2.2 Templates and related terms 

An Excel template is an Excel file that has been formatted in a particular way. ACER Maple uses two 
types of Excel templates: 
1. Input template is an Excel file intended to be populated with data by users and imported into 

ACER Maple, for example: 
 LSS and QSA templates: ACER populates these with initial data (in consultation with NCs) and 

imports them into ACER Maple before the software is despatched to NCs; or 
 LCL and LST templates: The SC fills this spreadsheet with details, which are then imported into 

ACER Maple by the data manager for sampling. 
2. Output template is an Excel file intended to be populated with data by ACER Maple as a result of 

sampling or validation. For example, STF templates are populated with sampling data by ACER 
Maple and later updated by Test Administrators. 

An Excel template can have several worksheets. A worksheet containing sections that need to be filled 
with data is called a data worksheet. The section containing data is called a data section. 

Field operation forms comprise LCL, LST, SCL, STF, SQTF, SALF and SPF. 

An ACER Maple template is a software structure that corresponds to a data worksheet within an Excel 
template. It enables ACER Maple to either import data from a corresponding input template into ACER 
Maple, or to populate a corresponding output template with data from ACER Maple. 

1.2.3 Discrepancies in validity reports 

The various validity reports generated during the data management process list discrepancies found 
in the data by ACER Maple. Validity reports are generated whenever a user attempts to import data 
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from Excel, when students are sampled, or when a user attempts to export data to Excel. There are 
two types of discrepancies:  
• Errors are incorrect records that must be corrected, for example, ID discrepancies.  
• Warnings are inconsistent records that may be correct but must be double-checked and either 

corrected or explained. 

Resolution of discrepancies involves correcting of all incorrect records and providing an explanation as 
to how any correct but inconsistent records have occurred, for any remaining warnings. Explanations 
are required by ACER as a part of the data submission task which is explained in detail in Chapter 11. 

1.3 Data management staff employed by NCs 

NCs are advised to employ the following staff: 
• One data manager per entity: this is the person responsible for all data management operations 

in the entity (see section 1.2.1 on page 11 for definition of an entity), including class and student 
sampling. The data manager must be trained by ACER staff for data management procedures. One 
NC can have one or more entities depending on how many grade levels they are assessing in how 
many languages and as many data managers as there are entities2. 

• Two to five data administrators per entity: these staff members are trained by data managers and 
work under their instruction. Data administrators assist their data manager with operations 
designated on Figure 1, page 9 in blue boxes (  ). If necessary, the data manager can work as 
one of the data administrators3. 

• Data entry operators: up to ten data entry operators can work under the instruction of each data 
administrator. Data entry operators are employed for a short period of time to enter test and 
questionnaire responses into ACER Maple after assessment. Data entry operators must be trained 
by the data manager. 

 
 

 
 
2 If there is one data manager in your NC and more than one entity, this data manager will need to login in ACER Maple with 
different login details for every grade level and language of assessment he /she is managing. 
3 If there are no data administrators in your NC, the data manager will still need to create an administrator login when 
initialising ACER Maple and use this login for various ACER Maple functions as instructed throughout this manual. However, 
this will slow down student sampling and reduce the number of data entry operators that can enter data simultaneously 
and delay the completion of data management tasks 

 



Chapter 2: ACER Maple AMPL DMM 

ACER © 2023 Commercial in Confidence Page 14 of 197 

2 ACER MAPLE 
2.1 Overview of ACER Maple ..................................................................................................... 14 
2.2 System requirements .......................................................................................................... 15 

2.2.1 ACER Maple on a virtual machine ....................................................................................... 15 
2.2.2 System requirements for the host PC .................................................................................. 15 
2.2.3 System requirements for all user PCs .................................................................................. 16 
2.2.4 Security recommendations .................................................................................................. 16 

2.3 PC Setup .............................................................................................................................. 17 
2.3.1 Download and install VirtualBox software on a host PC ..................................................... 17 
2.3.2 Defining your default browser ............................................................................................. 20 
2.3.3 Disabling browser default download location ..................................................................... 21 
2.3.4 Checking display and resolution .......................................................................................... 21 

2.4 Initial data readiness ........................................................................................................... 21 

2.5 Despatch .............................................................................................................................. 22 
2.6 ACER Maple installation ...................................................................................................... 23 

2.6.1 Initial checks before installation of ACER Maple ................................................................. 23 
2.6.2 Different modes of ACER Maple VM deployment ................................................................ 24 
2.6.3 Installation instructions ....................................................................................................... 24 

2.7 Access, exit and back-up ..................................................................................................... 32 
2.7.1 Starting ACER Maple VM on the host PC ............................................................................. 32 
2.7.2 Accessing ACER Maple Login window ................................................................................. 34 
2.7.3 Information section on the left-hand side of the Login screen ............................................ 34 
2.7.4 Closing a connection to an active ACER Maple session and creating a back-up ................. 35 
2.7.5 Closing ACER Maple on a host PC ........................................................................................ 36 
2.7.6 Closing ACERMapleVM on a host PC ................................................................................... 37 
2.7.7 Exporting ACER Maple database backup for archiving/storage ......................................... 37 

2.8 User Settings........................................................................................................................ 39 
2.8.1 First login ............................................................................................................................. 39 
2.8.2 Changing your password (all users) .................................................................................... 42 
2.8.3 Creating and deleting data administrator logins ................................................................ 43 

2.9 Navigation and functions of ACER Maple............................................................................ 45 
2.9.1 The ACER Maple Main screen .............................................................................................. 45 
2.9.2 Main functions of ACER Maple ............................................................................................ 46 
2.9.3 Returning to the ACER Maple main screen (Back button) ................................................... 47 
2.9.4 Session timeout ................................................................................................................... 48 

 

2.1 Overview of ACER Maple 

The data management software ACER Maple is a tool that is used to complete the following data 
management tasks: 
• Before the assessment ACER Maple is used to: 

1. import list of classes and sample a class of students to be assessed in each grade level agreed 
with ACER; 
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2. import list of students from the sampled class(es), sample students, and allocate survey 
instruments to the candidates;  

3. populate preconfigured tracking form templates with sampling data from ACER Maple. 
• After the assessment ACER Maple is used to: 

1. import tracking data collected by Test Administrators into ACER Maple; 

2. enter responses from paper-based instruments into ACER Maple;  

3. validate response data against the tracking data; and 

4. submit anonymised data to ACER for further processing and analysis. 

ACER Maple is developed in R programming language and runs as a host-user system. The host is a PC 
that runs an R session that operates ACER Maple. Installation of R is provided in the ACER Maple 
package. ACER Maple has two databases: a confidential database that is available to the NCs and an 
anonymised database that is submitted to ACER for further processing. 

This chapter describes the system requirements, installation steps, user settings and general 
navigation rules for ACER Maple. 
  

 
Throughout the manual, screenshots are used to illustrate various functions of the ACER 
Maple software. Some details, like version number, or user details, or column names in 
some templates on the screenshots may vary, but illustrated functions are the same as in 
the version you are going to use. 

 

2.2 System requirements 

2.2.1 ACER Maple on a virtual machine 

For the AMPL survey, the preferred mode of deployment for ACER Maple is through a Linux-based 
virtual machine. Specialised software, VirtualBox, is installed on a dedicated host PC, which hosts the 
virtual machine. ACER Maple software is then loaded onto the virtual machine using a disk image. The 
dedicated host PC will always keep the virtual machine running, and users (single or multiple) can 
access ACER Maple from either the same host PC or separate PCs at any time using the IP address 
specified by ACER Maple, in a web-based browser. Using ACER Maple in this mode requires that: 
• all user PCs and the host PC must be within the same LAN;  
• the IP address and port of the host PC is fixed (permanent); and  
• within the LAN, access to the host PC is not blocked by a firewall or network policy. 
  

 
You may need to ask your IT department to ensure that the LAN requirements described in 
this section, and the PC requirements described in sections 2.2.2 and 2.2.3, are met. 

 

2.2.2 System requirements for the host PC 

The host PC must have:  

• Microsoft Windows 64-bit version; 

• a standard installation of Microsoft Office (no earlier than Office 2013), since data is imported into 
and exported from ACER Maple in Excel format; and 
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• preferably Mozilla Firefox4 browser; and 

• Oracle VM VirtualBox software version 6.1.42 downloaded from 
https://www.virtualbox.org/wiki/Download_Old_Builds_6_1. 

• Recommended 80GB disk space (minimum 50GB) and 16GB of RAM (minimum 8GB) to download 
and install ACER Maple in VirtualBox software: 
 Installation of VirtualBox software and disk image to install ACER Maple requires at least 23GB 

of disk space. 
 Users will need additional hard disk space to be available for database backups. 
 The ACER Maple VM (virtual machine) will utilise approximately half of the host PC’s total 

RAM for optimum performance. For example, on a host PC with 16GB RAM, the VM will only 
utilise 8GB 

 
  

 
Make sure that the chosen browser is the default internet browser on the host PC and 
allows a user to specify where any downloaded files are to be saved. 

 

2.2.3 System requirements for all user PCs 

All user PCs (connected to the host PC via LAN) must have:  
• Microsoft Windows 64-bit version; 
• A standard installation of Microsoft Office no earlier than Office 2013. This is necessary because 

data is imported into ACER Maple from Excel and also exported from ACER Maple into Excel; and 
• Preferably Mozilla Firefox internet browser. 
  

 
Google Chrome is also acceptable, but NO OTHER browser except Mozilla Firefox or Google 
Chrome is supported. 

 
  

 
Make sure that the chosen browser is the default internet browser on the user’s PC and 
that the browser’s default download location is disabled. 

 

2.2.4 Security recommendations 

The following security recommendations apply to all PCs within the LAN that will be used to access 
ACER Maple: 

• all PC drives are encrypted using BitLocker or similar; 

• the host PC firewall is deployed so that HTTP ports are accessible from other machines on the same 
network.  

• the PC hosting the ACER Maple VM should be either: 
 a dedicated server; or 
 a desktop PC; or 

 
 
 
4 Google Chrome is also acceptable, but no other browser is supported 

https://www.virtualbox.org/wiki/Download_Old_Builds_6_1
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 if it is a laptop, the firewall rule for exposing the HTTP ports must be specific to the LAN where 
the work is performed; 

• all PCs have antivirus systems which are kept up to date; 

• all PCs are subject to a patching schedule for the operating system and any other relevant 
software; and 

• ACER Maple is not accessible from outside the LAN. 
  

 
Note that although Mozilla Firefox or Google Chrome internet browser is a requirement, 
an internet connection is NOT REQUIRED. In the case of data entry operators or data 
administrators, an internet connection is NOT RECOMMENDED for security reasons. 

 

2.3 PC Setup 

Before downloading ACER Maple, check that the system requirements are met on all PCs intended for 
the use of ACER Maple (see sections 2.2.2 and 2.2.3 for details). Once this has been confirmed, follow 
the instructions in this section to set up each of the PCs for ACER Maple. 

2.3.1 Download and install VirtualBox software on a host PC 
  

 
You may need to ask your IT department to download VirtualBox software on a host PC 

 

To download Oracle VM VirtualBox software and install it on the host PC: 
1. Navigate to the website https://www.virtualbox.org/wiki/Download_Old_Builds_6_1 in your 

internet browser (Figure 2). 

 
Figure 2: VirtualBox website landing page 

2. Click the Download VirtualBox 6.1 button in the middle of the page (see Figure 2). You will be 
taken to the Downloads page. 

https://www.virtualbox.org/wiki/Download_Old_Builds_6_1
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Figure 3: VirtualBox website Downloads page 

3. Click on the Windows hosts option under VirtualBox … platform packages (Figure 3).  
4. You will be prompted to download the software installer. Save it in an appropriate location then 

run it. The VirtualBox setup wizard will open (Figure 4). Click Next to start the setup process. 

 
Figure 4: VirtualBox setup wizard screen 1 

5. On the next two screens that appear, click Next and Next without changing any options 
(Figure 5). 

6.1.42 
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Figure 5: VirtualBox setup wizard screens 2 and 3 

6. The third screen will display a warning that installing the VirtualBox Networking feature will reset 
your network connection and temporarily disconnect you from the network. Click Yes to proceed 
(Figure 6). 

 
Figure 6: Networking feature warning 

7. Click Install on the Ready to Install screen that appears. (Figure 7) 
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Figure 7: VirtualBox setup wizard screen 5 

8. Once the installation is complete, click ‘Finish’ (Figure 8). 

 
Figure 8: VirtualBox setup complete 

2.3.2 Defining your default browser 

Only Google Chrome or Mozilla Firefox can be used for ACER Maple. 

To set Mozilla Firefox as your default browser: 
1. Open Mozilla Firefox. 

2. In the top right corner of the screen click . 
3. Click Options in the middle of the list. 

4. In the General > Startup section click Make default. 

6.1.42 
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To set Google Chrome as your default browser: 
1. Open Google Chrome. 

2. In the top right corner of the screen click . 
3. Click Settings near the bottom of the list. 
4. Scroll down to Default browser. 

5. Click Make default. 

2.3.3 Disabling browser default download location 

To disable the default download location in Mozilla Firefox: 
1. Open Mozilla Firefox. 

2. In the top right corner of the screen click . 
3. Click Options in the middle of the list. 
4. Scroll down to the Files and Applications > Downloads section. 

5. Select Always ask you where to save files. 

To disable the default download location in Google Chrome: 
1. Open Google Chrome. 

2. In the top right corner of the screen click . 
3. Click Settings near the bottom of the list. 
4. Scroll down to the bottom and click Advanced. 

5. Scroll down to the Downloads section. 
6. Click Ask where to save each file before downloading. 

2.3.4 Checking display and resolution 

1. In the Windows taskbar click Start ( ). 

2. Click Settings ( ). 
3. Click System. 
4. On the Display page, in the Scale and layout section, ensure that the “…(Recommended)” options 

are selected under the Change size of text, apps and other items drop-down list, and the Display 
resolution drop-down list. Repeat this step for all monitors that are connected to your PC by 
selecting the corresponding numbered display listed at the top of the screen. 

2.4 Initial data readiness 

At the beginning of the sampling process, sampling tasks containing country-specific sampling information 
are agreed between your NC and ACER and uploaded onto ACER Teams. This process is finalised by 
agreement of the School Tracking Form. Excerpt from the School Tracking Form is imported into ACER 
Maple as a List of Sampled Schools (LSS).  

At the same time, your Questionnaire Adaptation Spreadsheet (QAS) must be agreed with ACER. Excerpt 
from the QAS is imported into ACER Maple as a Questionnaire Structural Adaptations (QSA).  
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Please check the data in the agreed LSS and QSA carefully before any data is imported into ACER 
Maple: 
• If you think that minor changes to the School Tracking Form are still required, the LSS can be re-

negotiated by sending an e-mail to Clare Ozolins at Clare.Ozolins@acer.org. 
• If you think that minor changes to the QSA are still required, the QAS can be re-negotiated by 

sending an e-mail to Jennifer Hong at Jennifer Hong@acer.org. 

The data from LSS and QSA are imported into ACER Maple by the ACER data management team before 
a customised national version of ACER Maple for your NC is uploaded to ACER Teams. 
  

 

ACER Maple cannot be customised and despatched to the NC until the School Tracking 
form and QAS are agreed between your NC and ACER 

 
  

 

If the School Tracking form or QAS are re-negotiated after LSS and QSA have been 
imported into ACER Maple the re-negotiated file must be re-imported into ACER Maple by 
ACER.  

Please let Alla Routitsky at Alla.Routitsky@acer.org (cc to Maple Helpdesk 
maplehelpdesk@acer.org and Jennifer Hong@acer.org.) immediately if you start the 
process of re-negotiation after ACER Maple had been despatched. 

Try to avoid this situation by carefully checking the LSS and QSA files beforehand. 
 
  

 

If you have received and downloaded ACER Maple before realising the LSS or QSA needs to 
be changed:  
• wait for ACER to notify you that an updated version of the database can be 

downloaded; 
• download, and replace database as explained in [##]-. 

 
 

2.5 Despatch 

The ACER Maple software for the AMPL, and all related files, can be downloaded from the designated 
website nominated by ACER at the time of despatch. 

ACER_MAPLE_AMPL_[CNT].ZIP5 contains ACER Maple as well as a number of supplementary files 
organised into the following folders: 
• ACER_MAPLE_V<#>6: contains the disk image file ACERMapleVBox.ova. 
• AMPL_DMR: contains other Data Management Resources such as templates for field operation 

forms and various checklists to help with data management processes. 
 

 
 
5 CNT will be replaced with your 3-letter code as indicated in Table 2. 
6 <#> is a version number, e.g. 3.01 

mailto:Clare.Ozolins@acer.org
mailto:Jennifer%20Hong@acer.org
mailto:Alla.Routitsky@acer.org
mailto:maplehelpdesk@acer.org
mailto:Jennifer%20Hong@acer.org
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Table 2: 3-letter country codes [CNT] for countries participating in the AMPL survey 

Country 3-letter country code [CNT] 

India QIN 

Kenya KEN 

Lesotho LSO 

Zambia ZMB 
 

2.6 ACER Maple installation 
  

 
Policies and procedures for the purpose of supporting local security and privacy legislation 
for individual ACER Maple deployments are outside the scope of this document. 

To install ACER Maple: 
1. Check that you are ready to use ACER Maple (section 2.6.1). 

2. Decide on the mode of deployment (section 2.6.2). 
3. Download ACER_MAPLE_AMPL_[CNT].ZIP file from designated website (the details will be sent 

to you by ACER once your customised version is ready).  
4. Set up ACER Maple in the VM deployment configuration (section 2.6.3). 

2.6.1 Initial checks before installation of ACER Maple 

Before downloading ACER Maple, ensure that the system checks and PC setup tasks described in 
sections 2.2– 2.3 have been completed on all PCs to be used for ACER Maple. 
  

 
You will not be able to use ACER Maple if the system requirements are not met. 

ACER will notify your NC by email when your customised national version of ACER Maple is ready and 
has been uploaded to designated website. This email will also contain instructions for downloading 
ACER Maple from this site. Check with your NPM when this is scheduled. 
  

 
ACER Maple cannot be customised until the data from LSS and QSA have been agreed and 
uploaded into ACER Maple by ACER. 

 
  

 
Note to the India NC: In addition to the above, ACER Maple cannot be customised until 
Hindi assessment instruments are: 

1. prepared for printing (but not printed); 
2.  sent for final optical check to ACER; 
3. agreed upon. 
Hindi assessment instruments must be sent for final optical check at least two month 
before the start of the assessment and should not be printed untile final optical check is 
agreed upon. 
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2.6.2 Different modes of ACER Maple VM deployment 

ACER Maple VM can be deployed either: 

• for a single user for the purposes of accessing the system and data solely on one workstation. 
No other users or workstations are connected to the local area network (LAN) and the 
workstation is not connected to the internet while ACER Maple is running; or 

• for multiple LAN users for the purposes of accessing the system using their workstations. One 
of the workstations will host the ACER Maple VM; or 

• on a dedicated server which hosts the ACER Maple VM, which can be accessed from a single 
or multiple PCs within the same LAN. 

In each of these settings, the ACER Maple VM is installed on a single host PC/server (laptop or desktop). 
A user (or users) within the same LAN can then connect to the ACER Maple VM using an internet 
browser. In this way, multiple users can access ACER Maple (at the same time, if necessary) to perform 
all required data management tasks, without needing the ACER Maple VM to be installed on every PC. 
ACER Maple can also be accessed by a user directly on the host PC. Network security and firewall rules 
should allow other PCs within the LAN to connect to the ACER Maple host PC. 

A NC can have as many data administrators for each entity as there are values in the Admin ID column 
in the agreed LSS for this entity. 
  

 
If Admin ID is ‘01’ for all schools in the LSS , contact Clare Ozolins at Clare.Ozolins@acer.org. 
Your LSS should then be re-negotiated and re-uploaded into ACER Maple by ACER to 
accommodate the number of data administrators you are employing. 

2.6.3 Installation instructions 

To install ACER Maple on a virtual machine: 
1. Create a directory on the host PC named C:\MapleFiles. This will be a shared folder accessible by 

both the host PC and the VM. 
2. Download the VM image shared by ACER (through designated website) to a convenient location. 

It may take a while to download depending on your internet connection. 
  

 
The VM image is a large file of around 5GB. After the image is unpacked by VirtualBox it 
will require around 20GB of storage space and 2GB of RAM allocated to the ACER Maple 
VM on the host PC. 

 

3. Open Oracle VM VirtualBox software if it is not already open, either through the Start ( ) 
menu or the icon on desktop (Figure 9). 

 
Figure 9: VirtualBox desktop icon 

4. Click on File > Import Appliance, or the Import button (Figure 10).  

mailto:Clare.Ozolins@acer.org
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Figure 10: The Oracle VM VirtualBox Manager screen  

5. Another window will appear asking you to choose the appliance to import (Figure 11). Under 
Source select Local File System. 

6. Under File manually enter or navigate (using the  button) to the location where the VM image 
shared by ACER was saved in step 2. 

 
Figure 11: Select appliance to import screen 

7. Click Next. A screen will appear specifying the appliance settings (Figure 12). 
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Figure 12: Appliance settings screen 

8. In the Machine Base Folder field, specify an appropriate location for the VM base folder where 
the VM resides on the host PC (see Figure 12). Note it must be a different location to the 
C:\MapleFiles folder created in step 1. The folder will be created automatically if it does not 
already exist. 

9. Click Import.  
• The ACERMapleVBox VM will be imported into the Oracle VM VirtualBox Manager environment (it 

may take a few minutes depending on your PC).  
• Note that an error will occur if the C:\MapleFiles directory was NOT created in step 1 (page 24). If 

this occurs, you will need to: 
 click OK to dismiss the error message(Figure 13);  

 
Figure 13: ACERMapleVBox VM import error 
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 create the missing directory, and  

 delete anything in the VM base folder (i.e. C:\temp\VMs) before attempting to import the VM 
image again.  

10. Once the import process is completed, the name of the VM will appear in the list of available 
virtual machines (Figure 14). 

 

 
Figure 14: ACERMapleVBox VM loaded in VirtualBox 

11. Click on the ACERMapleVBox machine on the left-hand side of the screen to select it and click 
Start (see Figure 14).  

12. If initiating the ACERMapleVBox machine for the first time it will likely display an error message 
saying that the network adapter settings need to be changed (Figure 14) 

 
Figure 15: Network adapter settings error message 

13. Click Change Network Settings (see Figure 15) to open the network settings screen (Figure 16). 
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Figure 16: ACERMapleVBox VM network settings screen 

14. Make sure that “Bridged Adapter” is selected (see Figure 16) then click OK. 
15. Once the network adapter is configured properly a new window will appear displaying the Oracle 

VM VirtualBox loading screen followed by the Ubuntu loading screen (Figure 17). 

 
Figure 17: Oracle VM VirtualBox and Ubuntu loading screens 

16. Once the VM has finished loading the ACERMapleVBox VM login screen will appear (Figure 18). 
The ACERMapleVBox VM is running successfully. Dismiss any messages that appear at the top of 
the screen7. 

 
 
 
7 If instead of UBUNTU screen  a pop-up errors message appears saying “Not in a hypervisor partition”, see section A2.1, 
Appendix 1 for instructions. 
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Figure 18: ACERMapleVBox VM login screen 

  

 
The ACERMapleVBox VM login screen can be minimised but must remain open while ACER 
Maple is in use. Closing this window will shut down ACER Maple and all unsaved work 
will be lost. 

 

17. The VM will be registered within your Local Area Network (LAN) in accordance with LAN policies, 
and it will obtain a local IP address. This IP will need to be used by all users to connect to the 
ACER Maple interface. Obtain the IP address of the VM by running the following commands in 
either Command Prompt or Powershell (both native Windows 10 applications) on the host PC: 

• Using Command Prompt (CMD) on the host PC run below commands: 
set PATH=%PATH%;"C:\Program Files\Oracle\VirtualBox" 
VBoxManage guestproperty get "ACERMapleVBox" 
"/VirtualBox/GuestInfo/Net/0/V4/IP" 

• Using Powershell on the host PC run below commands: 
$env:PATH = $env:PATH + ";C:\Program Files\Oracle\VirtualBox" 
VBoxManage guestproperty get "ACERMapleVBox" "/VirtualBox/GuestInfo/Net/0/V4/IP" 

18. The IP address of the VM will be displayed in the Command Prompt/Powershell window (Figure 
19) 
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Figure 19: ACERMapleVBox VM IP address displayed in Windows Powershell application 

19. Enter the IP address into the address bar of a new internet browser tab (e.g. http://<IP>)8.  
  

 
The numeric value in Figure 19 is an example. The value displayed on your machine can be 
different and can change over time if LAN configuration had been changed (e.g. more PCs 
are added) 

 

20. The first time a user connects to the IP address of the VM, a warning about the connection not 
being private (Figure 20) is displayed9. To dismiss the security certificate warning click Advanced. 

 
Figure 20: VM security certificate warning 

 
 
 
8 If you are unable to reach the URL perform the following steps to check the network settings: 

1. Right click on the VM in the Oracle VM VirtualBox Manager 

2. Select Settings 

3. Select Network 

4. Ensure that Enable Network Adapter is selected, and Bridged Adapter is selected from the Attached 
to drop-down list (see Figure 16) 

9 The security warning is displayed because the ACER Maple VM is configured with a self-signed security certificate supplied 
by ACER. It is possible to replace the self-signed certificate supplied by ACER with your organisation’s security certificate. 
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21. Click Proceed on the Advanced screen (see Figure 21). 

 
Figure 21: VM security certificate warning advanced 

22. The ACER Maple Login screen will be displayed (Figure 22). 
 

 
Figure 22: ACER Maple Login screen 
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2.7 Access, exit and back-up 

2.7.1 Starting ACER Maple VM on the host PC 

To start up the ACER Maple VM on the host PC: 

1. Open Oracle VM VirtualBox software if it is not already open, either through the Start ( ) 
menu or the icon on desktop (Figure 23). 

 
Figure 23: VirtualBox desktop icon 

2. Click on the ACERMapleVBox machine on the left-hand side of the screen to select it and click 
Start (Figure 24). 

 
Figure 24: ACERMapleVBox VM loaded in VirtualBox 

3. Once the VM has finished loading the ACERMapleVBox VM login screen will appear (Figure 25). 
The ACERMapleVBox VM is running successfully. Dismiss any messages that appear at the top of 
the screen. 
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Figure 25: ACERMapleVBox VM login window 

  

 
The ACERMapleVBox VM login screen can be minimised but must remain open while ACER 
Maple is in use. Closing this window will shut down ACER Maple and all unsaved work 
will be lost. 

 

4. Obtain the IP address of the VM by running the following commands in either Command Prompt 
or Powershell (both native Windows 10 applications) on the host PC: 

• Using Command Prompt (CMD) on the host PC run below commands: 
set PATH=%PATH%;"C:\Program Files\Oracle\VirtualBox" 
VBoxManage guestproperty get "ACERMapleVBox" 
"/VirtualBox/GuestInfo/Net/0/V4/IP" 

• Using Powershell on the host PC run below commands: 
$env:PATH = $env:PATH + ";C:\Program Files\Oracle\VirtualBox" 
VBoxManage guestproperty get "ACERMapleVBox" "/VirtualBox/GuestInfo/Net/0/V4/IP" 

5. The IP address of the VM will be displayed in the Command Prompt/Powershell window (Figure 
19) 

 
Figure 26: ACERMapleVBox VM IP address displayed in Windows Powershell application 



Chapter 2: ACER Maple AMPL DMM 

ACER © 2023 Commercial in Confidence Page 34 of 197 

  

 
The numeric value in Figure 26 is an example. The value displayed on your machine can be 
different and can change over time if LAN configuration had been changed (e.g. more PCs 
are added) 

 

6. You can now access ACER Maple Login window on the host PC as well as on any other PC within 
the local area network 

2.7.2 Accessing ACER Maple Login window 

To access ACER Maple Login screen when the ACER Maple webpage is closed: 
1. Ensure that the ACERMapleVBox VM login window UBUNTU (Figure 25) is open on the host PC. 

2. Enter the IP address of the VM (from step 18 on page 29) in the address bar of a new Mozilla 
Firefox browser. The ACER Maple Login screen will appear (Figure 27). 
This can be done either on the host PC or any other PC within the same LAN as the host PC.  

 
Figure 27: The ACER Maple Login screen 

To access ACER Maple session when the ACER Maple webpage is greyed out indicating that session 
has been timed out: 
1. Ensure that the ACERMapleVBox VM login window UBUNTU (Figure 25) is open on the host PC. 
2. Refresh the browser (see section 2.9.4, page 48 for details). 

2.7.3 Information section on the left-hand side of the Login screen 

The information section on the left-hand side of the login screen (Figure 27) contains three important 
messages related to ACER Maple access from any PC on the same LAN as the host PC: 

IP address of host: <IP>.This is the IP address of the ACER Maple VM. Data managers must make it 
available to data administrators. 
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The numeric value in Figure 27 is an example. The value displayed on your machine can be 
different and can change over time if LAN configuration had been changed (e.g. more PCs 
are added) 

 

You are currently connected to ACER Maple over LAN. This message is displayed on all PCs accessing 
the ACER Maple VM, including the PC hosting the VM, even if the host PC is a stand-alone PC. 

To access this application… This message repeats the IP address of the host PC within the LAN with 
instructions on how to access ACER Maple from any PC within the LAN.  

2.7.4 Closing a connection to an active ACER Maple session and creating a back-
up 

To close a connection to an active ACER Maple session: 
1. Click the Quit button at the top right of the page. A message will appear asking if you are sure 

you want to quit. 
2. Click Confirm. A second message will appear asking if you want to create a database backup 

(Figure 28). 

 
Figure 28 Quit confirmation prompt 

3. Click Yes (Figure 31). The background of the page used to quit the session will become grey.  

 
Figure 29 Database backup prompt 

  

 
It is recommended that that backups are created from every PC at 
least twice a day. For example, when a user is leaving station for 
lunch and at the end of the working day. 

Please note that these backups are created within the VM 
infrastructure on the host PC and overwrite the previous updates.  

It is recommended as an important risk management procedure that, 
while ACER Maple is being actively used, database backups are 
exported from the ACER Maple VM to the local hard dive of the host 
PC at least twice a day (see section 2.7.7, page 37 for details). 
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2.7.5 Closing ACER Maple on a host PC 
  

 
The numeric value in Figure 27 is an example. The value displayed on your machine can be 
different and can change over time if LAN configuration had been changed (e.g. more PCs 
are added) 

 

To close ACER Maple on a host PC: 
1. Click the Quit button at the top right of the page. A message will appear asking if you are sure 

you want to quit. 
2. Click Confirm. A second message will appear asking if you want to create a database backup 

(Figure 30). 

 
Figure 30 Quit confirmation prompt 

3. Click Yes (Figure 31). The background of the page used to quit the session will become grey.  

 
Figure 31 Database backup prompt 

4. Export current database backup as explained in section 2.7.7 on page 37.  
  

 
It is recommended as an important risk management procedure that, 
while ACER Maple is being actively used, database backups are 
exported from the ACER Maple VM to the local hard dive of the host 
PC at least twice a day (see section 2.7.7, page 37 for details). 

 

5. DO NOT shut down ACER Maple VM (UBUNTU) UNLESS ALL USERS connected to the acer maple 
interface HAVE LOGGED OUT. 
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2.7.6 Closing ACERMapleVM on a host PC 

The ACERMapleVM can be shut down ONLY IF ALL USERS CONNECTED TO THE ACER MAPLE DATABASE 
HAVE LOGGED OUT. 
  

 
Before powering off the ACER Maple VM, make sure that all users connected to the ACER 
Maple interface have logged out. Powering down the VM without logging out all users can 
corrupt the ACER Maple database which may result in significant data loss. 

 

After you made sure that all users connected to the ACER Maple interface have logged out, the ACER 
Maple VM can be shut down as follows: 
1.  Close the ACER MapleVBox VM login window (Figure 25, page 33), then 
2.  Select Power off the machine on the Close Virtual Machine window (Figure 32).  

 
Figure 32: Close Virtual Machine window 

2.7.7 Exporting ACER Maple database backup for archiving/storage 
  

 
The following procedure is recommended to be performed at least twice a day as an 
important part of risk management. The exact timing of when the database backups 
should be exported will depend on your working environment and personal preferences 
and/or organisational practices 

 

To export ACER Maple database backup to the host computer for archiving/storage: 
1. Generate a backup from within the ACER Maple software interface by following the instructions 

in section 2.7.5 on page 36. 
2. Navigate to the C:\MapleFiles directory that was created when the VM was installed ( section 

2.6.3 step 1 on page 24) and manually create a new folder called ‘backup’ (Figure 33). 

 
Figure 33: User-created “backup” folder in C:\MapleFiles directory 
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3. Within 5 minutes the directory will be automatically renamed to “backup_<date>_<time>” 
(Figure 34).  

 
Figure 34: System-created “backup_<date>_<time>” folder in C:\MapleFiles directory 

If the folder doesn’t automatically rename within 10 minutes please contact ACER Helpdesk at 
maplehelpdesk@acer.org. 

4. Open the renamed folder.  
• If the database had been backed up the day it is exported, then inside the renamed folder there 

should be a password-protected zip file named db_backup_<date>.zip (Figure 35).  

 
Figure 35: Password-protected zip file containing database backup 

• If there is no database backup in the ACER Maple VM for the current day, the zip file 
exported to the “backup_<date>_<time>” folder will be called NoTodaysBackupFound.zip 
(Figure 36).

 
Figure 36: NoTodaysBackupFound.zip file 

• If this is the case repeat steps 1 - 4 of this instruction. 
5. Open the db_backup_<date>.zip file:  
• If it contains a folder named ‘shiny’ (Figure 37), go to the next step.  

mailto:maplehelpdesk@acer.org
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Figure 37: Contents of db_backup zip file 

• If the ‘shiny’ folder is not in the zip file, repeat steps 1 - 5 of this instruction 
6. Once the db_backup_<date>.zip file has been successfully created, the “backup_<date>_<time>” 

folder can be moved or copied to an alternative location (e.g. USB or HD that is physically 
secured against unauthorised access). 

  

 
Please note that if an error does occur with the ACER Maple software, any data that has 
not been backed up may be permanently lost. 

2.8 User Settings 

2.8.1 First login 

Due to the secure nature of the AMPL data, ACER Maple is login protected. In order to login to ACER 
Maple, you need to know your domain (see section 1.2.1), username and login code. 

If you are a data manager, your domain consists of: 
• Survey ID: 033; 
• Entity ID: this 6-digit string is specified in the ‘Country 6-digit code’ column of Table 1 (page 12); 

and 
• Admin ID: 00. 

The data managers’ secure usernames and temporary login codes will be emailed to your NC by ACER 
together with a notification that your customised national version of ACER Maple is ready to be 
downloaded from a designated website. 

Each NC can have one or more data managers depending on how many grade levels they are assessing 
in how many languages. For example, if two year levels are assessed in English NC can have two 
datamanagers. 
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If you are a data administrator, your domain consists of: 
• Survey ID: 033; 
• Entity ID (see Table 1, page 12); and 
• Admin ID: this 2-digit number is assigned to you by your data manager. 

The data administrator’s secure username and login code will be provided by the data manager after 
he/she has created data administrator login details as described in section 2.8.3. 

To login for the first time: 
1. Open ACER Maple by pasting the IP address of the host PC into the address bar of an internet 

browser (only Mozilla Firefox or Google Chrome). The Login screen will appear (Figure 38). 

 
Figure 38: First time login function on the ACER Maple Login screen 

2. On the left-hand side of the Login screen under ‘Help’, click First time login. The Password 
Creation screen will appear (Figure 39). 
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Figure 39: Password Creation screen 

3. Enter your Survey ID (033), Entity ID (6 digits) and Admin ID (2 digits). 
4. Enter your secure username and the login code. 
5. Create your password. The password must be at least 11 characters long and contain: 
 at least one upper-case letter; 
 at least one lower-case letter; 

 at least one number; and  
 at least one punctuation character (e.g., !, @, #, $, %). 

6. Enter the password again. 
7. Click Create Password. 

8. Click Back to return to the Login screen (Figure 38). 
9. On the top right-hand side of the Login screen, Enter your Survey ID (033), Entity ID (6 digits) and 

Admin ID (2 digits). 
10. Enter your username and your new password.  
11. Click Login. The ACER Maple main screen will appear (Figure 40). 
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Figure 40: ACER Maple Main screen-[update when the training version is ready]- 

2.8.2 Changing your password (all users) 

To change your own password: 
1. On the main screen select User settings > Change your password and then click Activate. The 

Change your password screen will appear (Figure 41). 

 
Figure 41: Change your password screen 

2. Enter your current password. 
3. Enter your new password. The password must be at least 11 characters long and contain: 
 at least upper-case letter; 

 at least one lower-case letter; 
 at least one number; and  
 at least one punctuation character (e.g., !, @, #, $, %). 

4. Enter your new password again. 
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5. Click Confirm (in the bottom right corner of the screen). A message confirming the update will 
appear.  

6. Click Dismiss. 

2.8.3 Creating and deleting data administrator logins 
  

 

The data manager must create exactly as many data administrator logins as there are 
Admin ID values in the LSS. 

Creating new data administrator logins 

To create new data administrator logins: 
1. On the Login screen enter your domain: Survey ID (033), Entity ID (6 digits) and Admin ID (00). 
2. On the main screen select User settings > Manage administrators and then click Activate. The 

Manage data administrators screen will appear (Figure 42). 

 
Figure 42: Manage data administrators’ screen-[update when the training version is ready]- 

3. Ensure that ‘Create’ is selected on the left-hand side of the screen. 
4. In the ‘Number of new users’ field, select the number of new administrator logins you wish to 

create. The ‘New administrators’ table on the right is automatically updated with the required 
number of rows (Figure 43). 

 
Figure 43: Number of new users selected 

5. In the ‘New administrators’ table, enter the User name and User affiliation for each new 
administrator login (Figure 44). 
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Figure 44: New administrators’ table [update when the training version is ready; include grade]- 

  

 
Each Admin ID must be assigned a unique ‘User name’. 

6. Click Save in the right bottom corner of the screen. A message confirming the creation of the 
new data administrators will appear. 

7. Click Confirm. Another confirmation message will appear. 

8. Click Dismiss. In the Existing administrators table, a row will appear for each new data 
administrator that has been created (Figure 45). The ‘First time login code (internal)’ column 
contains automatically generated first time login codes that each administrator will need the first 
time they log in to ACER Maple (section 2.8.1). 

 
Figure 45: Newly-created data administrator logins in the Existing administrators table 

9. Save a copy the content of the table in Excel. You will need to provide each data administrator 
with their usernames and first time login codes at the time of data administrator training (see 
more details about training in Chapter 4). 

Deleting data administrator logins 

To delete data administrator logins: 
1. On the Login screen enter your domain: Survey ID (033), Entity ID (6 digits) and Admin ID (00). 
2. On the main screen select User settings > Manage administrators and then click Activate. The 

Manage data administrators screen will appear. 
3. Ensure that ‘Delete’ is selected on the left-hand side of the screen (Figure 46). 

4. In the Existing administrators table a new ‘Delete’ column will appear. Check the box beside any 
data administrator to be deleted. 
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Figure 46: Deleting data administrator logins in the Manage data administrators’ screen 

5. Click Save. A message confirming the deletion of the selected data administrator logins will 
appear. 

6. Click Confirm. A confirmation message will appear. 
7. Click Dismiss. 

2.9 Navigation and functions of ACER Maple 

2.9.1 The ACER Maple Main screen 

At the top of the main screen of ACER Maple (Figure 47), next to the ACER Maple logo, is the ACER 
Maple version number. 
  

 
The version number on the Main screen must be the same as in the despatch email or 
higher.  
If the version number on the Main screen is lower than in the despatch email: 
• Make sure that you have downloaded the latest despatch from the MyCloud folder 

designated to your country.  
• If the latest despatch contains a version lower than indicated in the despatch email, 

contact ACER Helpdesk at maplehelpdesk@acer.org, specifying your 3-letter country 
code and subject (Despatch version) in the subject line of the e-mail. 

 

Also at the top of the main screen, on the right-hand side, there are two buttons: Logout and Quit. 

• The Logout button allows a user to log out from ACER Maple without shutting down the 
application. 

• The Quit button shuts down the application. 

Listed directly beneath the ACER logo is the domain to which the currently logged-in user has access. 
Each AMPL user has access to the following domains depending on their affiliation (e.g. entity) and 
status: 
 Survey: AMPL: 2023: MS 
 Entity: your country 3-letter code, country code and grade level-[check on training data if the 

same 3-letter code is OK for more than 1 entity]-; and 
 Admin: 00 for data managers and 01, 02 etc. for data administrators. 

The middle section of the main screen contains a list of main functions and the section on the right 
lists any options that are available for each of the main functions. Section 2.9.2 lists all of the functions 

mailto:maplehelpdesk@acer.org
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and associated options, and whether a data manager or data administrator login must be used to 
access them.  

After a main function and an option are selected, the Activate button must be clicked to initiate the 
function. 

 
Figure 47: ACER Maple main screen-[update when the training version is ready]- 

2.9.2 Main functions of ACER Maple 

All of the ACER Maple main functions are accessed from the list of main functions on the main screen 
(Figure 47). These functions and all related options are listed in Table 3. The last column in this table 
indicates whether a data manager or a data administrator must be logged in to ACER Maple to be able 
to use the listed function. Data administrators can only access a limited selection of main functions 
compared to data managers, and data entry operators can only key in data.  

Any options that are shaded green in Table 3 must be performed using a data administrator login, 
even though these options also appear in the list of main functions available to data managers. 
Similarly, a data entry operator login must be used for keying in responses (yellow shading in Table 
3). 

Table 3: ACER Maple functionality in relation to different users 

Main function Options User 

User settings Change your password All users 

Manage administrators Data manager 

Manage data entry operators Data administrator 

Export Initial data Data manager 

Template documentation Data manager 

Field data Data administrator 

List of candidates Data manager 

Institution list Data manager 

Remaining warnings Data manager 

Import Field data Data administrator 

Sample and allocate 
instruments 

Sample and allocate Data administrator 

Update tracking data Field operation forms Data administrator 

Institution participation form Data manager 

Response data Export data entry documentation Data manager 
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Main function Options User 

Key in responses Data entry operator 

Validate respondent list Data administrator and data manager 

Export response data Data manager 

Final tasks Explain warnings Data manager 

Submit data Data manager 

2.9.3 Returning to the ACER Maple main screen (Back button) 

After a main function and an option are selected and Activate is clicked, you will be transferred to the 
corresponding function screen. In the top right corner of any function screen there is a Back button 
which allows you to return to the main screen (Figure 48), beside the Logout and Quit buttons. 

 
Figure 48: ACER Maple Back, Logout and Quit buttons 

Any time you click Back you will be asked to confirm that you wish to go back to the main screen and 
warned that any unsaved changes will be lost (Figure 49). 

 
Figure 49: Back confirmation message 

 

Take this warning seriously: 
• if all changes have been saved, click Go to main screen; or 
• if all changes have not been saved, click Cancel and save your changes before returning to the 

main screen. 
  

 

For navigation between ACER Maple screens only use the buttons within ACER Maple. 
The Go Forward (→) and Go back (←) browser buttons will trigger going to the 
next/previous browser page that was open before you logged in to ACER Maple and 
therefore your connection with ACER Maple will be lost. If there was any unsaved work this 
will also be lost. There will be no message warning about unsaved changes if the browser 
buttons are used. 
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2.9.4 Session timeout 

If you are logged in to ACER Maple but have been inactive for 2 hours or more you will automatically 
be logged out. The browser page will appear greyed out and a message will appear explaining that the 
session has timed out (Figure 50). 

 
Figure 50: Session timeout message 

In this case: 

1. Click the refresh button in your browser ( ) to refresh the page and re-activate ACER Maple; 
and then 

2. Login to ACER Maple. 
  

 
Use the refresh button in the browser only if the session has timed out. The browser refresh 
button initiates a new session in ACER Maple. If your session was active at the time it will 
not be ended properly, and any unsaved or unfinished work will be lost. 

When you try to login again after refreshing the page, you may see a message warning that 
the user is already logged in. In this case click the ACER Maple Quit button, refresh the page 
and login again. 
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3 NECESSARY DOCUMENTATION 
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3.1.1 Exporting initial data ........................................................................................................... 50 
3.1.2 Understanding the LSS and checking it against School Tracking Form ............................... 50 
3.1.3 Comparing the QSA to the agreed national versions of the questionnaires. ...................... 53 

3.2 Field operation forms and ACER Maple functions .............................................................. 56 
3.3 Codebook and format files for field operation forms ......................................................... 58 

3.3.1 Exporting template codebook and format files ................................................................... 58 
3.3.2 Interpreting codebooks ....................................................................................................... 59 

3.4 Keeping track of school participation .................................................................................. 63 

 

3.1 Initial Data 

During the school sampling process sampling tasks containing country-specific sampling information are 
agreed between your NC and ACER and uploaded onto ACER Teams. This process is finalised by agreement 
of the School Tracking Form. Excerpt from the School Tracking Form is imported into ACER Maple as a 
List of Sampled Schools (LSS).  

At the same time, your Questionnaire Adaptation Spreadsheet (QAS) must be agreed with ACER. Excerpt 
from the QAS is imported into ACER Maple as a Questionnaire Structural Adaptations (QSA).  

Before using ACER Maple, you need to: 
1.  Export initial data (section 3.1.1) 
2. Compare the LSS data to the data in the agreed School Tracking Form (section 3.1.2). 
  

 

If the LSS data does NOT match corresponding data in the School Tracking Form, let Alla 
Routitsky know immediatly (Alla.Routitsky@acer.org cc to Maple Helpdesk 
maplehelpdesk@acer.org) 

• check these files carefully; 

• make sure that you understand the data in the LSS; and 
• keep the LSS and the agreed School Tracking Form handy during within-school 

sampling. 

 

3. Compare the QSA data matches the adaptations made to the corresponding questions in the 
agreed Questionnaire Adaptation Spreadsheet (section 3.1.3). 

  

 

If the he QSA data does NOT match the adaptations made to the corresponding questions 
in the agreed Questionnaire Adaptation Spreadsheet, let Alla Routitsky  know immediatly  
(Alla.Routitsky@acer.org cc to Maple Helpdesk maplehelpdesk@acer.org and Jennifer 
Hong@acer.org.). 

• check these files carefully; 

• make sure that you understand the data in the QSA; and 
• keep the QSA handy for data entry. 

 

mailto:Alla.Routitsky@acer.org
mailto:maplehelpdesk@acer.org
mailto:Alla.Routitsky@acer.org
mailto:maplehelpdesk@acer.org
mailto:Jennifer%20Hong@acer.org
mailto:Jennifer%20Hong@acer.org
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3.1.1 Exporting initial data 
  

 

The data manager login must be used for the following function.  

To export all initial data from ACER Maple in Excel format: 
4. On the Main screen select Export > Initial data and then click Activate. The Export Initial Data 

screen will appear (Figure 51). 

 
Figure 51: Export Initial Data screen 

5. Click Export. All initial data files will be combined into one zip file which will be available for 
download (Figure 52).  

 
Figure 52: Initial data download pop-up 

6. Select ‘Save File’ and save the zip file in an appropriate location and then unzip it. 
  

 
Keep the initial data files handy. You will need to be familiar with this data throughout the 
data management operations. 

3.1.2 Understanding the LSS and checking it against School Tracking Form 

Survey ID is a within-school sampling variable that distinguish the AMPL survey from other surveys 
using ACER Maple. It does not appear in the School Tracking Form.  

Survey ID=033 for the AMPL. 

CNT is your NC 3-letter code. Check that it corresponds to your country as indicated in Table 4. 
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Entity 6-digit code and Combined option. Different NCs selected different combinations of test design, 
grade level to be assessed, number of students to be sampled (TCS) from each class sampled for 
assessment, and number of languages of assessment (see Table 4):  
• Each NC must export and check as many LSS files as the number of grade levels and languages they 

selected to assess in their country. Each LSS file will have different Entity ID (see Table 4). 
• Each Entity ID is a 6-digit number based on the countries 3-digit ISO code, grade level assessed and 

language (if assessment is conducted in more than one language). 
• Each Combined option is based on test design selected and TCS. If intact classes are assessed, 

combined option ends on 99. 

Check that Entity IDs and corresponding Combined options match the national options you selected. 

Class option is ‘1’ for all NC indicating that class is sampled in each school. 

Table 4: LSS codes with respect to national options 

Country LSS variables National options 

 CNT Entity 6-
digit code Class option Combined 

option Grade Language Test design TCS 

India QIN 

035631 1 399 3 ENG a 

ALL 035651 1 599 5 ENG b 

035652 1 599 5 HIN b 

Kenya KEN 040460 1 625 6 ENG ab 25 

Lesotho LSO 
042640 1 320 4 ENG a 20 

042670 1 620 7 ENG ab 20 

Zambia ZMB 
089440 1 320 4 ENG a 20 

089470 1 620 7 ENG ab 20 

Fictitious 
country ZZA 

098140 1 320 4 ENG a 20 

098160 1 620 6 ENG ab 20 
 

Number of schools in the LSS, their identification, and their distribution: 
1. Each LSS must contain ALL schools selected for you by ACER for each target grade and only these 

schools.  
2. Check that School names and their National IDs correspond to Stratum ID, and School within 

stratum assigned by ACER sampling team exactly the same way as had been agreed in the School 
Tracking Form for each target grade. 

3. Check that the AMPL School No. values are different for different target grades even if the actual 
school is the same. Ensure that you and data administrators know which AMPL School No. values 
assigned to the schools they are responsible for. 

4. Check that Admin ID is assigned to the schools the way you agreed with ACER sampling team and 
that you have as many values as the number of data administrators you intend to use. 

Replacement ID Original Stratum Selection Number 

Table 5 and Table 6 contains examples of excerpts from two LSS files for ZZA (a fictitious country). Note 
that in this example NC is planning to have four data administrators, each one responsible for schools 
in each entity and stratum combination. Other arrangements are also possible. Any arrangements 
must be agreed with the ACER sampling team. 
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Table 5: LSS example for ZZA grade 4 

1 

Survey 
ID 

CNT Entity 6-
digit code 

Admin 
ID 

Stratum 
ID 

School 
within 
stratum  

School 
Name 

National 
ID 

AMPL 
School No. 

Class 
option 

Combined 
Option 

2 033 ZZA 098140 01 01 0001 School 123 ZZA123 1 1 320 

3 033 ZZA 098140 01 01 0002 School 124 ZZA124 2 1 320 

4 033 ZZA 098140 01 01 0003 School 125 ZZA125 3 1 320 

5 033 ZZA 098140 01 01 0004 School 126 ZZA126 4 1 320 

6 033 ZZA 098140 01 01 0005 School 127 ZZA127 5 1 320 

7 033 ZZA 098140 02 02 0001 School 128 ZZA128 6 1 320 

8 033 ZZA 098140 02 02 0002 School 129 ZZA129 7 1 320 

9 033 ZZA 098140 02 02 0003 School 130 ZZA130 8 1 320 

10 033 ZZA 098140 02 02 0004 School 131 ZZA131 9 1 320 

11 033 ZZA 098140 02 02 0005 School 132 ZZA132 10 1 320 

Table 6: LSS example for ZZA grade 6 

1 

Survey 
ID 

CNT Entity 6-
digit code 

Admin 
ID 

Stratum 
ID 

School 
within 
stratum  

School 
Name 

National 
ID 

AMPL 
School No. 

Class 
option 

Combined 
Option 

2 033 ZZA 098160 03 01 0001 School 123 ZZA123 451 1 620 

3 033 ZZA 098160 03 01 0002 School 124 ZZA124 452 1 620 

4 033 ZZA 098160 03 01 0003 School 125 ZZA125 453 1 620 

5 033 ZZA 098160 03 01 0004 School 126 ZZA126 454 1 620 

6 033 ZZA 098160 03 01 0005 School 127 ZZA127 455 1 620 

7 033 ZZA 098160 04 02 0001 School 128 ZZA128 456 1 620 

8 033 ZZA 098160 04 02 0002 School 129 ZZA129 457 1 620 

9 033 ZZA 098160 04 02 0003 School 130 ZZA130 458 1 620 

10 033 ZZA 098160 04 02 0004 School 131 ZZA131 459 1 620 

11 033 ZZA 098160 04 02 0005 School 132 ZZA132 460 1 620 
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3.1.3 Comparing the QSA to the agreed national versions of the questionnaires. 

All questionnaires require cultural and linguistic adaptations. However, some questions may require 
structural adaptations, meaning that the number of response categories and the meaning of these 
categories may change. These adaptations will be extracted by ACER questionnaire team into the 
Questionnaire Structural Adaptation (QSA) form and imported into ACER Maple to enable data entry 
as specified in the adaptations. 

The questions that may require structural adaptations in the Student Questionnaire are: 

ST03: What is the main language that you speak at home? 

ST06: What is the highest level of formal education completed by your mother or female guardian?  

ST08: What is the highest level of formal education completed by your father or male guardian? ST03 

The questions that may require structural adaptations in the School Questionnaire are: 

SC04: What is the highest level of education you have completed? 

SC08: What is the primary language of instruction at your school? 

Check in the QSA that: 
• the response categories listed in the National category label column correspond to the categories 

in your agreed national versions of the questionnaires as indicated in Table 7; and 
• in addition to questionnaire response categories check that QSA data contain auxiliary values for 

each question type. Auxiliary values foe QSA items are listed and their usage is explained in Table 8. 

Table 7: QSA Question type ID for questionnaire items 

Question type ID Questionnaire items 

1 ST03 

2 ST06 and ST08 

3 SC04 

4 SC08 
 

Table 8: Auxiliary values added to the questionnaire items in the QSA 

QSA Question type ID Questionnaire items Usage 

97 N/A Item has not been printed properly 

98 Invalid 
More than one response is provided where only 
one is required 

99 Missing Response is not provided 
 

Example of QSA for ZZA grade 6 (fictitious country) is provided in Table 9. The columns that require 
checking are highlighted in blue.  

For example, ZZA data manager need to check that in their Student Questionnaire, question about 
language spoken at home (Question type ID=1), has response categories as follows: 01-English; 02- 
Kiswahili, 03-Other languages. In addition, he/she needs to check, that Auxiliary codes 97,98,99 are 
present in QSA for this question type. Similarly every question listed above must be checked. 

The only difference for grade 4 QSA would be an entity ID. 
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Table 9: QSA Example (ZZA, grade 6) 

1 
Survey 
ID 

Entity 6-
digit code 

Question 
type ID 

Question type 
label 

International 
category label 

Data entry 
code National category label National category label (eng) 

International 
code 

2 033 098160 1 
Language spoken 
at home 

Language of 
assessment 01 English English eng 

3 033 098160 1 -//- Language 2 02 Kiswahili Swahili swh 

4 033 098160 1 -//- Other languages 03 Other languages Other languages qot 

5 033 098160 1 -//- N/A 97   qna 

6 033 098160 1 -//- Invalid 98   qin 

7 033 098160 1 -//- Missing 99   qms 

8 
033 098160 2 Parent education 

ISCED level 6 or 
higher 01 

Completed undergraduate or 
higher 

Completed undergraduate or 
higher 600 

9 

033 098160 2 -//- ISCED level 4 or 5 02 

Completed middle level college 
(e.g. technical course, diploma 
course, certificate course) 

Completed middle level college 
(e.g. technical course, diploma 
course, certificate course) 400 

10 033 098160 2 -//- ISCED level 3 03 Completed secondary school Completed secondary school 398 

11 033 098160 2 -//- ISCED level 1 04 Completed primary school Completed primary school 100 

12 
033 098160 2 -//- 

Did not complete 
ISCED level 1 05 Did not complete primary school Did not complete primary school 099 

13 033 098160 2 -//- N/A 97   997 

14 033 098160 2 -//- Invalid 98   998 

15 033 098160 2 -//- Missing 99   999 

16 

033 098160 3 
Principal 
education ISCED level 7 or 8 01 

Completed higher degree (e.g. 
Master’s degree, Post graduate 
degree) 

Completed higher degree (e.g. 
Master’s degree, Post graduate 
degree) 700 

17 
033 098160 3 -//- ISCED level 6 02 

Completed university level (e.g. 
Bachelor's degree) 

Completed university level (e.g. 
Bachelor's degree) 600 

18 

033 098160 3 -//- ISCED level 4 or 5 03 

Completed middle level college 
(e.g. technical course, diploma 
course, certificate course) 

Completed middle level college 
(e.g. technical course, diploma 
course, certificate course) 400 

19 033 098160 3 -//- ISCED level 3 04 Completed secondary school  Completed secondary school  398 
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1 
Survey 
ID 

Entity 6-
digit code 

Question 
type ID 

Question type 
label 

International 
category label 

Data entry 
code National category label National category label (eng) 

International 
code 

20 
033 098160 3 -//- 

ISCED level 2 or 
below 05 

Did not complete secondary 
school 

Did not complete secondary 
school 200 

21 033 098160 3 -//- N/A 97   997 

22 033 098160 3 -//- Invalid 98   998 

23 033 098160 3 -//- Missing 99   999 

24 
033 098160 4 

Language of 
instruction 

Language of 
assessment 01 English English eng 

25 033 098160 4 -//- Language 2 02 Kiswahili Swahili swh 

26 033 098160 4 -//- Other languages 03 Other languages Other languages qot 

27 033 098160 4 -//- N/A 97   qna 

28 033 098160 4 -//- Invalid 98   qin 

29 033 098160 4 -//- Missing 99   qms 
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3.2 Field operation forms and ACER Maple functions 

The AMPL_DMR folder that was despatched together with ACER Maple contains the following Excel 
files: 
• List of Classes (LCL) 
• Sampled Class form (SCL) 
• List of Students (LST) 
• Student Tracking Form (STF) 
• School Questionnaire Tracking Form (SQTF) 
• Student Assessment Labelling Form (SALF) 
• School Participation Form (SPF) 

Locate these forms and familiarise yourself with them prior to the data administrator training. 

The LCL, SCL, LST, STF, and the SQTF templates are used by data administrators. 

The SALF is filled with data by either data managers or data administrators and then used to label 
assessment materials. 

The SPF is used by data managers to record school participation after the assessment.  

Table 10 contains an overview of the data source(s) for each field operation form. It also explains how 
these forms relate to ACER Maple functions. 
  

 
The LCL and the LST Information worksheet will require linguistic adaptations which are 
explained in the Note to NC. Talk to your NPM if adaptations had not been done. 

 
  

 
Note to the countries, where the word ’class’ is used for grouping of students in the same 
grade level, taught by the same teacher. Make sure that in the Information worksheet of 
the LCL and the LST the adaptations in row 6 are made and the Note to NC below row 6 is 
deleted (see examples in Table 15 and Table 17). Talk to your NPM if the changes had not 
been done. 

 
  

 
Note to the countries, where the word ’class’ is NOT used for grouping of students in the 
same grade level, taught by the same teacher. Make sure that in the Information 
worksheet of the LCL and the LST the word ’class’ is explained in row 6 and the Note to NC 
below row 6 is deleted. Talk to your NPM if the changes had not been done. 
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Table 10: Overview of field operation forms and ACER Maple functions 

Field operation 
form to be used Data source ACER Maple function 

List of Classes 
(LCL) 

Completed List of Students provided by 
schools. 

Use Import > Field data to import List of 
Classes data either school-by-school or for 
multiple schools simultaneously. 

Sampled Class 
(SCL) 

After class sampling, ACER Maple 
generates a forms populated with 
sampled class data. 

After class sampling, use Export > Field data 
to export sampled class data into the 
sampled class template. 

List of Students  
(LST) 

Completed List of Students provided by 
schools. 

Use Import > Field data to import List of 
Students data either school-by-school or for 
multiple schools simultaneously. 

Student 
Tracking Form 
(STF) 

Before the assessment: 
After student sampling, ACER Maple 
generates student tracking forms 
populated with sampled students’ data. 

Before the assessment: 
After student sampling, use Export > Field 
data to export sampled students’ data into 
the student tracking form template. 

During the assessment: 
TA adds student participation and 
updates student demographic data with 
help from SC. 

After the assessment: 
Use Update tracking data > Field Operation 
Forms to update student participation and 
demographic data. 

School 
Questionnaire 
Tracking Form 
(SQTF) 

Before the assessment: 
ACER Maple populates this form with the 
list of school principals for schools in 
each domain. Completed by the data 
administrator for each domain on 
receipt of materials. 

Use Export> Candidate List to populate the 
template with the data from ACER Maple. 

After the assessment: 
Completed by the data administrator for 
each domain on receipt of materials. 

Use Update tracking data > Field Operation 
Forms to update school questionnaire 
receipt after the assessment. 

Student 
Assessment 
Labelling Form 
(SALF) 

After student sampling and before the 
assessment, ACER Maple generates 
student SALF populated with sampled 
students’ data 

Use Export> Candidate List to populate the 
template with the data from ACER Maple. 

School 
Participation 
Form (SPF) 

Before the assessment: 
Exported from ACER Maple by the data 
manager.  

Use Export > Institution list to export list of 
schools eligible to participate. 

After the assessment: 
Completed by the data manager on 
receipt of materials. 

Use Update tracking data > Institution 
participation form to import school 
participation data. 

  

 
The processes of collecting class and student lists from schools and using tracking forms by 
TA and SC are explained in the relevant field operation manuals. Please ask your NPM for 
an adaptad version of the manual required. 
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3.3 Codebook and format files for field operation forms 

3.3.1 Exporting template codebook and format files 

Codebook files describe the internal structure of ACER Maple templates and give information about 
the variables in them. Codebook files are exported in Excel format. 

Format files contain only column headings. They are useful to check that column headings in the 
corresponding worksheet of the Excel template match the column headings in ACER Maple. Format 
files are exported in Excel format. 
  

 

The data manager login must be used for the following function.  

 

To export template codebook and format files: 
1. On the main screen select Export > Template documentation and then click Activate. The Export 

template documentation screen will appear (Figure 53). 

 
Figure 53: Export template documentation screen-[update when the training version is ready]- 

2. From the Select templates drop-down list select following templates: LCL, SCL, LST, STF, and 
SQTF. 

3. In the Export options list de-select any export options that are not required. By default, both 
template codebook and template format options are selected. 

4. Click Export. All codebook and/or format files will be combined into a single zip file which you 
will be prompted to download (Figure 54).  
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Figure 54: Template documentation zip file 

5. Select Save File and click OK to save the zip file. Manually enter or navigate to an appropriate 
location to save the file.  

6. Once the file has downloaded, open it and extract the files to an appropriate location. 
7. Prepare sufficient number of copies for data administrators to use during training. 

8. Proceed to section 3.3.2 to learn how to interpret codebooks. 

3.3.2 Interpreting codebooks 

Each Excel codebook file contains two worksheets:  
1. a list of all variables in the template and information about them (e.g. formats); 
2. value labels for selected variables.  

The worksheet containing variables has 10 columns of data. The data in each column is explained in 
Table 11 (page 60). The provided examples are excerpts from the codebook of the standard List of 
Students (LST) template presented in Table 12. 

Value labels are not required for every value of every variable, but only for those values whose 
meaning could not be provided by the variable labels or column headings. Table 13 shows value labels 
for some variables in the standard List of Students (LST) template. 
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Table 11: Codebook columns in the worksheet containing variables 

Column Column heading Description 

A Column/Row headings The column heading as it appears in the Excel template. 

B Variable type There are four variable types: fixed-width string (e.g. Line No.), long string (e.g. Student Name), integer (e.g. Study programme), and numeric (e.g. 
AMPL School No.). The variable type determines how the validation rule is defined in the next five columns. 

C Variable min These two columns define the range of values for any variables that can be defined with a range of values (e.g. for Month of Birth the possible range 
of values is from 01 to 12). If the validation rule is not defined with a range of values, such as for a long string variable, Min=Max=0. 

D Variable max 

E Out-of-range values Any valid values not included in the range are listed (if required). E.g. Gender has an additional value of 9 –‘Missing' added to the range of 1-3. This 
column in the codebook is left blank if there is no out-of-range values. 

F Variable width For fixed-width string variables this is the exact number of characters that the variable can have (e.g. Gender must have exactly one character). For all 
other variables this is the maximum number of characters that the variable can have (e.g. Student Name can have up to 60 characters, but does not 
need to use all of them). 

G Decimal places For numeric variables this column lists the number of decimal places that are saved in the data. For all other variables It is 0. 

H Variable label A short description of the variable. 

I Variable name A short alphanumeric string. The variable name must be unique. It is used in a number of different places, particularly in SPSS and SAS control files 
when data is downloaded. 

J Table acronym The acronym of the ACER Maple table (internal) which contains the data for this variable. 
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Table 12: LST template codebook – variables worksheet-[update after configured]- 

 A B C D E F G H I J 

1 Column/Row headings Variable type Variable min Variable max Out-of-range values Variable width Decimal places Variable label Variable name Table acronym 

2 AMPL School No. numeric 0 99999999  8 0 Institution tracking srtrack MPT2 

3 Line No. fixed-width string 00000 99998  5 0 Input line number idinp MPT2 

4 Student Name long string 0 0  180 0 Record name in TCD tcname TCD2 

5 Gender fixed-width string 1 3 9 1 0 Gender mpin01 MPT2 

6 Month of Birth fixed-width string 01 12 [97;98;99] 2 0 Date of birth-month mpin04 MPT2 

7 Year of Birth fixed-width string 1920 2599 [9997;9998;9999] 4 0 Date of birth-year mpin05 MPT2 

8 SEN integer 0 6  1 0 SEN mpin14 MPT2 

9 Grade Level      0 Grade  MPT2 

 Class Name long string 0 0  100 0 Option 21 mpin21 TCD2 

 Class ID      0    

Table 13: LST template codebook – value labels worksheet-[update after configured]- 

 A B C D E 

1 Column/Row headings Variable name Variable label Value Value label 

2 Gender  Gender mpin01 1 Female 
3 Gender Gender mpin01 2 Male 

4 Gender  Gender mpin01 3 Other 

5 Gender  Gender mpin01 9 Missing 

7 Month of Birth mpin04 Date of birth-month 98 Invalid 

8 Month of Birth mpin04 Date of birth-month 99 Missing 

10 Year of Birth mpin05 Date of birth-year 9998 Invalid 

11 Year of Birth mpin05 Date of birth-year 9999 Missing 

12 SEN mpin14 SEN 0 Default, no SEN 

13 SEN mpin14 SEN 1 Functional disability 

14 SEN mpin14 SEN 2 Cogn., behav. or emot. disability 

15 SEN mpin14 SEN 3 Limited language proficiency 
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3.4 Keeping track of school participation 

During the field operations stage of the AMPL, the data manager should ensure that school 
participation status is tracked. A code for each school should be recorded either:  
• in the School Participation Form exported from ACER Maple;  

OR 
• in a file where all other information about AMPL schools is recorded. 

School participation should then be updated in ACER Maple after all STF data from all participating 
schools) have been updated, and before the data is submitted to ACER (see details in section 9.6). The 
advantage of recording participation codes in the School Participation Form is that this form can be 
imported later into ACER Maple without any additional work. If school participation information is 
recorded elsewhere, the data needs to be manually transferred into the School Participation Form 
before it can be imported into ACER Maple. 
  

 

The data manager login must be used for the following function.  

To export the School Participation Form (SPF) listing all AMPL schools for your NC: 
1. On the main screen select Export > Institution list and then click Activate. The Export institution 

list screen will appear (Figure 55). 

 
Figure 55: Export institution list screen 

2. Click Export. You will be prompted to save a zip file containing the School Participation Form. 
3. Manually enter or navigate to an appropriate location to save the file and click Save. 
4. Once the file has downloaded, open it and extract the School Participation Form to an 

appropriate location. 
  

 
Keep the the School Participation Form handy. You will need to provide a code for each 
school, including all replacements, as soon as you know the school’s participation status. 
School participation codes can be found in section 9.6.1. 
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4 DATA ADMINISTRATOR TRAINING 
4.1 Data administrator training agenda .................................................................................... 64 
4.2 Preparation for data administrator training ....................................................................... 65 
4.3 Training setup ...................................................................................................................... 66 
4.4 Prepare training List of Classes data ................................................................................... 66 

4.5 Prepare training List of Students data ................................................................................. 67 
4.6 Prepare updated STF ........................................................................................................... 71 

 

4.1 Data administrator training agenda 

Data managers are required to train data administrators before the assessment in how to use ACER 
Maple. For the purposes of training data administrators, data managers are advised to adapt materials 
in the Data Management Training Package (DMTP) zip file containing the Data Management Training 
Presentation and other training materials provided by ACER. However, not all topics included in this 
presentation will be required for data administrator training. 

The topics that must be covered in data administrator training are outlined in Figure 56 and explained 
in detail in corresponding chapters of this manual, as well as in the Data Management Training 
Presentation. The following section explains how the data manager should prepare for data 
administrator training. 

 
Figure 56: Data administrators’ tasks for the AMPL 
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4.2 Preparation for data administrator training 

Preparing the materials for data administrator training gives data managers an opportunity to better 
familiarise themselves with AMPL data management procedures and ACER Maple.  
  

 
Note to National Centres assessing two grade levels 
Data administrators reponsible for lower grade level data should be trained separately from 
the data administrators reponsible for the upper grade level data because corresponding 
materials for these sessions are different. 

 

Table 14 lists the data manager’s tasks in relation to data administrator training and provides 
references to relevant sections and/or chapters of this document.  

For the purposes of data administrator training, a number of fictitious ‘schools’ have been included in 
the LSS and can be used to test some of the ACER Maple procedures before any real data is available. 
These ‘schools’ are found in stratum 99 of the LSS, for every value of Admin ID.  
  

 
Each data administrator must be trained to work within their allocated domain (see section 
1.2.1 for the definition of domain). 

 

Table 14: Data manager tasks in relation to data administrator training 

Preparation task Reference 

Ensure that training setup corresponds to the real working conditions of 
data administrators. 

Section 4.3, Introduction, 
Chapters 1 and 2 

Prepare necessary documentation Chapter 3 

Download DMTP provided by ACER. DMTP 

Prepare training field operation forms for schools from stratum 99. Sections 4.4-4.6 and DMTP 

Adapt DMTP exercise on checking and importing LST. Chapter 5 and DMTP 

Adapt DMTP exercise on student sampling from schools in stratum 99 Chapter 6 and DMTP 

Adapt DMTP exercise on populating STF templates with sampling data. Chapter 7 and DMTP 

Adapt DMTP exercise on checking and updating STF ‘after the 
assessment’. 

Section 4.6, Chapter 9 and 
DMTP 

 
  

 
Note to National Centres assessing grade levels different from 6 and using design a or 
design b 
Sections 4.4-4.6 provide examples for grade 6 and design a+b. These examples must be 
modified if your NC assessing different grade levels with different designs. 
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4.3 Training setup 

Data administrator training should be set up to correspond to the real working conditions of data 
administrators as much as possible. To achieve this, you should make sure that: 
1. All data administrators attend the training 
2. The required computing equipment is ready:  

 ACER Maple is installed in a LAN environment as described in Chapter 2 with one of PCs for 
each data administrator plus one host PC.  

 each PC meets the system requirements and PC setup (sections 2.2 and 2.3); and 
 administrator logins are created for each data administrator as explained in section 2.8.3 

3. LCL, SCL, LST, STF, SALF and SQTF templates are copied over to every data administrator PC. 
4. Audio-visual equipment is ready to use. Some examples of this equipment might include: 

 a projector for viewing the Data Management Training Presentation, ensuring that the screen 
is visible from every data administrator workstation; or  

 a second monitor for each data administrator, so that they can watch the Data Management 
Training Presentation on one monitor and complete the training exercises using another 
monitor. 

4.4 Prepare training List of Classes data 

The List of Classes (LCL) template is despatched together with ACER Maple. It is designed as an Excel 
file with two worksheets: 
• the Information worksheet, containing school information and instructions for School 

Coordinators; and 
• the List of Classes worksheet, containing class data. 

Both worksheets should be copied and populated with fictitious information by the data manager in 
preparation for data administrator training. 

Table 15 shows an example of the Information worksheet prepared for training. This example can be 
used as a basis for creating your own Information worksheet of the LCL template used for training. 
Please note that: 
• For training purposes, the AMPL School No value in row 5 must correspond to a ‘school’ in stratum 

99 of the List of Sampled Schools (LSS) agreed between your NC and ACER. 
• The total number of classes listed in row 4 should correspond to the number of classes listed in 

the List of Classes worksheet (‘3’ in this example). 
• The DIRECTIONS in row 6 should be:  
 As they are shown in Table 15 with the exception of grade level IF the word ‘class’ is used in 

your country for grouping of students in the same grade level, taught by the same teacher. 
 IF the word ’class’ is NOT used for grouping of students in the same grade level, taught by the 

same teacher, make sure that the word ’class’ is explained in row 6 and the Note to NC below 
row 6 is deleted. Talk to your NPM if the changes had not been implemented. 

• The grade level in the DIRECTIONS in row 6 should correspond to the grade level assessed in your 
country. 

Table 15: Example of LCL School information to be used training (as if ‘returned from school’) 

1 School information 

2 
School 
name: Central school Telephone: 4584563 List prepared by: Mr SC ABC 
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3 National 
School ID.: XT3Q5 Fax: 4584565 Date list prepared:  20/05/2023 

4 Address: Central avenue, 46 Email: sc@schoolcentral Total number of 
classes listed: 3 

5 AMPL School 
No.: 1001     

6 
DIRECTIONS FOR the List of Classes worksheet: Please list alphabetically by Class name ALL grade 6 classes 
in your school and the number of students in each class 

 

Table 16 shows an example of error-free class data in Excel format prepared for training. The data in 
this table can be used as the basis for creating your own LCL training data. You will need to create at 
least two lists of class data for training. One containing errors that data administrators should correct 
during the training and one that is error-free, like the example in Table 16. 

When creating error-free LCL data for training, adhere to the following rules: 
• AMPL School No. ‘returned from school’ should be empty. It will be populated with the AMPL 

School No value from the Information worksheet by the data administrator during training. 
• Line No. ‘returned from school’ should be empty. It will be populated with sequential 5-digit string 

(00001, 00002,…) by the data administrator during training. 
• Grade Level ‘returned from school’ should be empty. It will be populated with the grade level value 

from the Information worksheet by the data administrator during training. 
• Class name should be listed in alphabetical order and if the class name contains the grade level 

like in example in Table 16, it should correspond to the grade level value from the Information 
worksheet.  

• No. of Students should be close to the expected number of students in the class in your country. 
• Comments can be left empty. 

Table 16: Example of LCL data in Excel format to be used training (as if ‘returned from school’) 

1 AMPL School No Line No. Grade Level Class Name No. of Students Comments 

2     6A 30  

3     6B 25  

4     6C 32  
 
  

 
Note to countries assessing more than one grade level. Each grade level will need a 
separate LCL file for import. 

 

4.5 Prepare training List of Students data 

After an error-free LCL for the fictitious school has been prepared and populated with ‘AMPL School 
No’ and ‘Line No’ (see sections 5.2), data administrators can proceed to import it into ACER Maple 
(section 5.4). After the LCL has been successfully imported a class for assessment can be drawn 
(Chapter 6). After sampling the SCL template for the fictitious school can be populated with sampling 
data (Chapter 7). In real-life situation, the School Coordinator is informed about which class will be 
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participated in the assessment and asked to send the list of students enrolled in the sampled class. For 
training, pretend that this had been done and the list of students is received. 

The List of Students (LST) template is despatched together with ACER Maple. It is designed as an Excel 
file with two worksheets: 
• the Information worksheet, containing school information and instructions for School 

Coordinators; and 
• the List of Students worksheet, containing student data. 

Both worksheets should be copied and populated with fictitious information by the data manager in 
preparation for data administrator training. 

Table 17 shows an example of the Information worksheet prepared for training. This example can be 
used as a basis for creating your own Information worksheet of the LST template used for training. 
When filling the Information worksheet in the LST please adhere to the following rules: 
• For training purposes, the AMPL School No value in row 5 must correspond to a ‘school’ in stratum 

99 of the List of Sampled Schools (LSS) agreed between your NC and ACER. 
• The DIRECTIONS in row 6 should be: 
 As they are shown in Table 17 with the exception of grade level IF the word ‘class’ is used in 

your country for grouping of students in the same grade level, taught by the same teacher. 
 IF the word ‘class’ is NOT used in your country for grouping of students in the same grade 

level, taught by the same teacher, make sure that the word ’class’ is explained in row 6 and 
the Note to NC below row 6 is deleted. Talk to your NPM if the changes had not been 
implemented. 

• Grade Level under Sampled class information should be populated with the grade level assessed 
in your country. 

• Class Name and Class ID under Sampled class information should be populated with the 
corresponding values exported after class sampling into the SCL template. 

• Do not change instructions under Special Educational Needs (SEN) Codes in the Information 
worksheet. 

Table 17: Example of LST School information to be used training (as if ‘returned from school’) 

1 School information 

2 
School 
name: Central school Telephone: 4584563 List prepared by: Mr SC ABC 

3 National 
School No.: XT3Q5 Fax: 4584565 Date list prepared:  20/05/2023 

4 Address: Central avenue, 46 Email: sc@schoolcentral Total number of 
students listed: 30 

5 AMPL 
School No.: 1001     

6 

DIRECTIONS FOR the List of Students worksheet: Please list ALL students in your school in sampled class 
(see Sampled class information below) and provide their demographic data.  
Use the list of codes in the Special Educational Needs (SEN) to fill the corresponding column in the List of 
Students worksheet.  
After the List of Students worksheet is filled with student data, fill out the three boxes above (i.e. 'List 
provided by', 'Date list prepared', and 'Total number of students listed').  

7       

8 Sampled class information  Special Educational Needs (SEN) Codes: 

9 Grade Level Class Name Class ID  Code Description  

11 6 <> <>  0 No special 
educational needs 
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Table 18 shows an example of error-free student data in Excel format prepared for training. The data 
in this table can be used as the basis for creating your own LST training data. You will need to create 
at least two lists of student data for training. One containing errors that data administrators should 
correct during the training and one that is error-free, like the example in Table 18. 

When creating error-free LST data for training, adhere to the following rules: 
• AMPL School No. ‘returned from school’ should be empty. It will be populated with the AMPL 

School No value from the Information worksheet by the data administrator during training. 
• Line No. ‘returned from school’ should be empty. It will be populated with sequential 5-digit string 

(00001, 00002,…) by the data administrator during training. 
• Student name is usually listed in alphabetical order. Provide the names used in your country 
• Gender: if the names in your language differ by gender, make sure that 1 is assigned to girls and 2 

is assigned to boys. 
• Month of Birth should be a random 2-digit string (between 01 and 12) as in the example in Table 

18. 
• Year of Birth: an appropriate value should be selected from the range of years within which the 

students from the grade level being assessed in your country were born. 
• SEN: most of the students should have ‘0’ (no SEN), and a small number of students should have 

‘1’ (Functional disability), ’2’ (Cognitive, behavioural or emotional disability), or ‘3’ (Limited 
language experience). 

• Grade Level: replace 7 with the grade level being assessed in your country. 
• Class name ‘returned from school’ should be empty. It will be populated with the class name from 

the Information worksheet by the data administrator during training. 
• Class ID ‘returned from school’ should be empty. It will be populated with the class name from the 

Information worksheet by the data administrator during training. 

For some ‘schools’ please create an LST containing errors and ensure that data administrators are 
trained to check LST data when it is received from schools. For example, include a Month of Birth value 
between ‘1’ and ‘9’ (i.e. without a leading zero), or/and Gender value of ‘0’. Read more about LST 
checks and correct formatting of LST variables in Chapter 5.  
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Table 18: Example of LST data in Excel format to be used in training (as if ‘returned from school’) 

1   xxxxx <Name> <Surname> F=1; M=2 MM YYYY  Class 

2 AMPL School No. Line No. Student Name Gender  Month of Birth  Year of Birth SEN Grade Level Class Name Class ID 

3 1001 00001 Xab Yac 1 01 2010 0 6 6C 3 

4 1001 00002 Xac Yad 1 11 2011 0 6 6C 3 

5 1001 00003 Xaf Yag 2 09 2010 0 6 6C 3 

6 1001 00004 Xad Yag 1 08 2010 0 6 6C 3 

7 1001 00005 Xaj Yak 2 05 2010 1 6 6C 3 

8 1001 00006 Xab Yac 1 03 2010 0 6 6C 3 

10 1001 00007 Xb Yacd 2 12 2010 0 6 6C 3 

11 1001 00008 Xab Yah 2 11 2010 0 6 6C 3 

12 1001 00009 Xak Yalk 1 03 2010 1 6 6C 3 

13 1001 00010 Xkl Yvb 2 05 2010 0 6 6C 3 

14 1001 00011 Xab Yfg 1 06 2010 0 6 6C 3 

15 1001 00012 Xab Ykm 2 02 2010 0 6 6C 3 

16 1001 00013 Xed Ygbn 2 04 2009 0 6 6C 3 

17 1001 00014 Xsd Ymnv 1 10 2010 0 6 6C 3 

18 1001 00015 Xcv Ywdj 2 07 2010 0 6 6C 3 

19 1001 00016 Xth Ysdf 1 04 2010 2 6 6C 3 

20 1001 00017 Xwe Ywsc 1 08 2010 0 6 6C 3 

21 1001 00018 Xab Yuhj 2 03 2010 0 6 6C 3 

22 1001 00019 Xerb Yjkl 1 01 2010 3 6 6C 3 
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4.6 Prepare updated STF 

After an error-free LST for the fictitious school has been prepared and populated with additional 
information by data administrators (section 5.3), data administrators can proceed to import it into 
ACER Maple (section 5.4). After the LST has been successfully imported the student sample can be 
drawn (Chapter 6). After sampling the STF template for the fictitious school can be populated with 
sampling data (Chapter 7). The STF populated with sampling data will then need to have the SEN, Test 
Booklet No., Participation, and two Attendance (T and Q) columns completed manually as if by a Test 
Administrator. Refer to the Test Administrator Manual, if required. 

Table 19 shows an example Student Tracking Form in Excel format containing training data ready to be 
updated in ACER Maple. The data in this table can be used as a basis for creating your own STF training 
data. Any STF training data should contain a AMPL School No value that corresponds to a ‘school’ in 
stratum 99.  

For some fictitious schools please create an STF with errors and ensure that data administrators are 
trained to check STF data when it is returned by Test Administrators. 
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Table 19: Example of STF data in Excel format ready to be updated in ACER Maple during training 

1 School Name AMPL School No.  School Co-ordinator  Test Administrator Session Date 1 (DD/MM) Session date 2 (DD/MM) 

2 Central school 1001  Mr SC ABC Ms TA XYZ 30/05 31/05 

3  LST 
 

 
F=1; 
M=2 MM YYYY  Attendance  Class  

4 Student Name Line No. AMPL 
Participant ID 

Test 
Form Gender Month of 

Birth 
Year of 

Birth SEN Test  StQ Participation Grade Level Class Name Comments 

5 Xab Yac 00001 96100106 5 1 01 2010 0 1 1 1 6 6C  

6 Xac Yad 00002 96100104 6 1 11 2011 0 0 1 0 6 6C  

7 Xaf Yag 00003 96100105 7 2 09 2010 0 1 0 0 6 6C  

8 Xad Yaf 00004 96100101 8 1 08 2010 0 0 0 1 6 6C  

9 Xaj Yak 00005 96100103 3 2 05 2010 1 1 1 0 6 6C  

10 Xab Yac 00006 96100108 4 1 03 2010 0 0 1 1 6 6C  

11 Xb Yacd 00007 96100102 5 2 12 2010 0 1 0 1 6 6C  

12 Xab Yah 00008 96100109 6 2 11 2010 0 1 1 1 6 6C  

13 Xak Yalk 00009 96100107 7 1 03 2010 1 0 0 0 6 6C  

14 Xkl Yvb 00010 96100110 8 2 05 2010 0 0 0 0 6 6C  

15 Xab Yfg 00011 96100115 3 1 06 2010 0 0 0 0 6 6C  

16 Xab Ykm 00012 96100120 4 2 02 2010 0 0 0 0 6 6C  

16 Xed Ygbn 00013 96100111 5 2 04 2009 0 0 0 0 6 6C  

18 Xsd Ymnv 00014 96100116 6 1 10 2010 0 0 0 0 6 6C  

19 Xcv Ywdj 00015 96100112 7 2 07 2010 0 0 0 0 6 6C  

20 Xth Ysdf 00016 96100117 8 1 04 2010 2 0 0 0 6 6C  

21 Xwe Ywsc 00017 96100113 3 1 08 2010 0 0 0 0 6 6C  

22 Xab Yuhj 00018 96100114 4 2 03 2010 0 0 0 0 6 6C  
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5.1 Class and student sampling logistics 

The logistics of sampling are illustrated in Figure 57, outlined below and explained in detail in relevant 
sections of this manual: 
1. After data administrators have been trained, they will start checking class lists received from 

schools and formatting them into LCL files (sections 5.2), then importing the LCL data into ACER 
Maple (section 5.4).  

2. After data from the LCL have been successfully imported into the ACER Maple database, class 
sampling is undertaken, which results in the one class being sampled (chapter 6) and SCL form 
populated with the sampled class data (chapter 7).  
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3. After that the SC must be contacted and asked for the student lists from the sampled class. After 
List of Students is received from schools, data administrators check and format the student lists 
received from schools into the LST files, then import the LST data into ACER Maple (sections 5.3 
and 5.4). 

4. Each time the data is imported into ACER Maple, the software will check the imported data for 
inconsistencies. Detected inconsistencies will be listed in the Import Field Data Validity Report. 
Some of these inconsistencies may be errors that must be corrected before student sampling can 
proceed, while others may be warnings of missing data that can be completed later by Test 
Administrators on the tracking forms (section 5.5). 

  

 
Data will only be transferred into the ACER Maple database when all errors have been 
corrected. 

 

 
Figure 57: Sampling logistics 



Chapter 5: Preparing and importing data AMPL DMM 

ACER © 2023 Commercial in Confidence Page 75 of 197 

5.2 Preparing LCL data for import 

The List of Classes (LCL) is crucial for sampling in the AMPL project because only students in sampled 
class(es) are eligible for assessment. The data stored in these lists are used in student tracking forms 
and to validate sampling data. 
  

 
To make sampling efficient, the data for all LCLs must be checked and corrected before 
being imported into ACER Maple. 

 
  

 
It is important for the data manager to export the LCL codebook (see section 3.3) and make 
it available to all data administrators, before the data administrators begin preparing the 
LCL data for import. 

It is preferable for the LCL data to be prepared and imported one school at a time, as soon as it is 
received. The process for preparing a file for importing starts with establishing a file naming 
convention, as described in section 5.2.2. The remaining steps for preparing the file are outlined in 
section 5.3.2, and explained in detail in sections 5.2.3 - 5.2.11. 

5.2.1 File naming conventions 

Before any LCLs start arriving from schools, the data manager must establish a file naming convention 
and ensure that all data administrators adhere to it.  
  

 
All data administrators within your NC must use the same file naming convention. 

 

• Each LCL file should be saved in Excel format in a designated location. 
• Each LCL file must have in the file name ‘LCL’, a AMPL school number, any other information that 

identifies the school (e.g. the school name), and the date that list was prepared (e.g. 
LCL_121_Central school_AsReceived210502).  
 If an LCL has been received electronically, it should be saved according to the established file 

naming convention before any further preparation of the file begins. 
 If an LCL has been received in hard copy, it must be: 

1. checked, in hard copy, as explained in sections 5.2.3 - 5.2.5; 

2. corrected (if required), in hard copy, as explained in section 5.2.6; and then 

3. keyed into an LCL Excel template, then saved according to the established file naming 
convention before any further preparation continues (5.2.7-5.2.11). 

5.2.2 List of Classes data preparation outline 

The following 9 steps outlines how to prepare the List of Classes data: 
1. Check grade level(s) and class names (section 5.2.3). 
2. Check the number of classes in the List of Classes worksheet against the Information worksheet 

(section 5.2.4). 
3. Check the number of students in the List of Classes worksheet (section 5.2.5). 
4. Contact school if required (section 5.2.6). 
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5. Sort the LCL data (section 5.2.7). 
6. Add the appropriate value in the ‘AMPL School No.’ (section 5.2.8). 

7. Add appropriate values in the ‘Line No.’ column (section 5.2.9). 
8. Ensure that the data adheres to the validation rules for each column (section 5.2.10). 
9. Save the file (section 5.2.11). 

5.2.3 Check grade level and class names 

Check that the number in the Grade Level column matches the grade level assessed in your country 
(refer to Table 20). 
  

 
If in your NC two grade levels are assessed, make sure that each list contains only one 
grade level. E.g., grade 4 classes must be listed separately from grade 6 classes. 

 

Table 20: Grade levels assessed by AMPL countries 

Country Grade level assessed 

Bhutan 6 

India 3 and 5 

Kenya 6 

Lesotho 4 and 6 

Zambia 3 and 7 
 

In the Class Name column 
• If grade level is not included in the class name, or class name is not provided10, go to section 5.3.4. 
• If grade level is included in the class name (e.g. 6a), highlight any class names with grade level that 

does not match the number in the Grade Level column or the grade level assessed in your country. 

5.2.4 Check the number of classes 

The number of classes in the List of Classes worksheet must be the same as the number provided in 
the Information worksheet. 

Make a note if this is not the case. 

5.2.5 Check the number of students 

The number of students in the List of Classes worksheet for each class must be a reasonable number 
for your country. If it is too small or too large from your point of view, make a note 

5.2.6 Contact school if required 

After completing checks described in sections 5.2.3 - 5.2.5: 
• if there are no highlighted cases or additional notes that were made during checking, go to section 

5.2.7. 
 

 
 
10 Class names and students name are optional. They are provided for convenience of administration. 
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OTHERWISE 
• contact the school to verify the data for any highlighted cases or additional notes that were made 

during checking.  

Possible queries for the school and the actions required to correct the data are listed in Table 21. 

Table 21: Possible queries regarding LCL checks, and actions required 

Possible query Actions required 

Query any class names 
with incorrect grade levels 

• If any classes are in the correct grade level, but there was an error in 
the class name, correct the class name in the LCL. 

OR 
• If any classes listed are in the wrong grade level, ask the School 

Coordinator to send a corrected list and destroy the incorrect one. 

Query any suspicious or 
missing student numbers 

• If the School Coordinator provides updated data, update the records 
in the LCL. 

OR 
• If the data is not available, enter missing values as indicated in the 

codebook and ask the School Coordinator to provide the data later 
for sampled class(es) 

Query any instance where 
the number of classes in 
the List of Classes 
worksheet is not the same 
as the number provided in 
the Information worksheet 

• If the number provided in the Information worksheet is incorrect, 
correct the number in the worksheet. 

OR 
• If the number of classes in the List of Classes worksheet is incorrect, 

ask the School Coordinator to send a corrected list and destroy the 
incorrect one. 

 

After enquiries are made: 
• If all corrections have been made in the existing LCL, save a new version of the LCL with “_Updated” 

added to the end of the file name. Ensure that the new file is saved in a suitable location. 
• If the School Coordinator is required to send an updated List of Classes, delete the existing one. 

When the updated LCL has been received, it will need to be checked again. 

5.2.7 Sort LCL data 

If an “_Updated” LCL has been saved, it will need to be checked to ensure that the listed records are 
ordered correctly before ACER Maple can import it. Open the updated LCL in Microsoft® Excel to check: 
• If the records on the LCL are ordered alphabetically according to class name (e.g. 6a is listed first, 

then 6b,…). 
OTHERWISE 

• Sort the LCL data alphabetically by Class Name as follows: 

1. If the file has opened in Microsoft® Excel in Protected View, click the Enable Editing button at 
the top of the screen. 

2. Highlight row 1 and ALL class records in the List of Classes worksheet. 

3. Click DATA. The DATA ribbon will be displayed at the top of the Excel screen. 

4. Click Sort. The Sort window will appear (Figure 60). 

5. Click ‘My data has headers’ in the top right-hand corner of the Sort window (see Figure 60). 



Chapter 5: Preparing and importing data AMPL DMM 

ACER © 2023 Commercial in Confidence Page 78 of 197 

6. In the Sort by drop-down list, click Class Name. 

7. Click OK. Microsoft® Excel will sort the data. 

 
Figure 58: Sorting LCL –[add a screenshot]- 

8. Check that the LCL has been sorted as specified: 
 If yes, save a copy of the file with extension “_Sorted” 
 Otherwise, close the file without saving, reopen it, and repeat steps 1 to 7 to sort again. 

5.2.8 Add the value in the ‘AMPL School No.’ column 

In the ‘AMPL School No.’ column, copy over the value from the ‘AMPL School No’ cell in the Information 
worksheet. Make sure that the number is the same for all records in the school. 

5.2.9 Add values in the ‘Line No.’ column 

To add ‘Line No.’ values in the ‘Line No.’ column: 
• In the first row, enter ‘00001. Remember to use a single quotation mark to include leading zeroes. 
• In the second row, enter ‘00002. 
• Select the two cells, then position the cursor at the bottom right of the selection, and then click to 

expand the black square down to the row of the last student in the list (Figure 61). This will 
populate the line numbers “00001, 00002, 00003, …” for the school. 

  
Figure 59: Populating LCL ‘Line No.’ column 

5.2.10 Ensure the data matches the validation rules in each column 

Compare the prepared LCL data against the exported codebook and format files for the LCL and verify 
that the data matches the validation rules in each column, and the structure of the data. See section 
3.3 for instructions on exporting codebook and format files and how to interpret codebooks. 

As an example of a validation check consider the following: The ‘Month of Birth’ column requires a 2-
digit number (as specified in the validation rule for this column in the codebook). This means that if 
March is entered as ‘3’ or ‘March’, it must be changed to ‘03’ to avoid an error when importing the 
data into ACER Maple. To include a leading 0, key in a single quotation mark (‘) in front of ‘03’. 
  

 
Note that a single quotation mark (‘) is necessary to include leading zeros in columns ‘Line 
No.’ and ‘Month of Birth’. 

To ensure correct structure 
• Open LCL format 
• Make sure that all columns are in the right order 
• Copy the first row from the format and paste it in row 2 of the LCL data worksheet. 

Table 22 shows LCL data ready to be imported into ACER Maple. 
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Table 22: Example LCL data in Excel format ready to be imported into ACER Maple  

1 AMPLSchool No. Line No. Grade Level Class name No. of Students Comments 

2 1001 00001 6  6A 30  

3 1001 00002 6  6B 25  

4 1001 00003 6  6C 32  

5       
 
  

 
Note to countries assessing more than one grade level. Each grade level will need a 
separate LCL file for import. 

 

5.2.11 Save the file 

Save a new version of the LCL with “_For_Import” added to the end of the file name. Ensure that the 
new file is saved in a suitable location. 

5.3 Preparing LST data for import 

The List of Students (LST) is crucial for student sampling. The data stored in these lists are used in 
student tracking forms and to validate sampling data. 
  

 
To make sampling efficient, the data for all LSTs must be checked and corrected before 
being imported into ACER Maple. 

 
  

 
It is important for the data manager to export the LST codebook (see section 3.3) and make 
it available to all data administrators, before the data administrators need to begin 
preparing the LST data for import. 

It is preferable for the LST data to be prepared and imported one school at a time, as soon as it is 
received. The process for preparing a file for importing starts with establishing a file naming 
convention, as described in section 5.3.1. The remaining steps for preparing the file are outlined in 
section 5.3.2, and explained in detail in sections 5.3.3 - 5.3.11. 

5.3.1 File naming conventions 

Before any LSTs start arriving from schools, the data manager must establish a file naming convention 
and ensure that all data administrators adhere to it.  
• Each LST file should be saved in Excel format in a designated location. 
• Each LST file must have in the file name ‘LST’, a AMPL school number, any other information that 

identifies the school (e.g. the school name), and the date that list was prepared (e.g. 
LST_121_Central school_AsReceived210502).  

  

 
All data administrators within your NC must use the same file naming convention. 

 

• If an LST has been received electronically, it should be saved according to the established file 
naming convention before any further preparation of the file begins (section 5.3.2). 
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• If an LST has been received in hard copy, it must be: 

1. checked, in hard copy, as explained in sections 5.3.3- 5.3.5; 

2. corrected (if required), in hard copy, as explained in section 5.3.6; and then 

3. keyed into an LST Excel template, then saved according to the established file naming 
convention before any further preparation continues (5.3.7-5.3.11). 

5.3.2 List of Students data preparation outline 

To prepare the List of Students data: 
1. Check class names (section 5.3.3). 
2. Check gender and age distributions (section 5.3.4 ). 
3. Check the number of students in the List of Students worksheet against the Information 

worksheet (section 5.3.5). 
4. Contact school if required (section 5.3.6). 
5. Sort the LST data (section 5.3.7). 

6. Add the appropriate value in the ‘AMPL School No.’ (section 5.3.8). 
7. Add appropriate values in the ‘Line No.’ column (section 5.3.9). 
8. Ensure that the data adheres to the validation rules for each column (section 5.3.10). 
9. Save the file (section 5.3.11). 

5.3.3 Check class names 

• If grade level is not included in the class name, or class name is not provided11, go to section 5.3.4. 
• If grade level is included in the class name (e.g. 6a): 

1. check that the grade level indicated in the class name corresponds to the grade level assessed 
in your country (refer to Table 20 on page 76). 

2. highlight any class names with an incorrect grade level. 

5.3.4 Check the gender and age distributions 

The gender and age distributions must match the school’s demographic background (e.g. a single 
gender school cannot have students of both genders, or a student born in 2015 cannot be in grade 6). 

Highlight any records in the List of Students that have incorrect, suspicious or missing demographics 
data. Some examples of such records are:  
• a student who is the only female in the List of Students;  
• year of birth that is outside the usual range for students from the grade level being assessed 
• any student with missing gender or date of birth data. 

5.3.5 Check the number of students 

The number of students in the List of Students worksheet must be the same as the number provided 
in the Information worksheet. 

 
 
 
11 Class names and students name are optional. They are provided for convenience of administration. 
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Make a note if this is not the case. 

5.3.6 Contact school if required 

After completing checks described in sections 5.3.3- 5.3.5: 
• if there are no highlighted cases or additional notes that were made during checking, go to section 

5.3.7. 
OTHERWISE 

• contact the school to verify the data for any highlighted cases or additional notes that were made 
during checking.  

Possible queries for the school and the actions required to correct the data are listed in Table 23. 

Table 23: Possible queries regarding LST checks and actions required 

Possible query Actions required 

Query any class names with 
incorrect grade levels 

• If any students are in the correct grade level, but there was an error 
in the class name, correct the class name in the LST. 

OR 
• If any students listed are in the wrong grade level, ask the School 

Coordinator to send a corrected list and destroy the incorrect one. 

Query any suspicious or 
missing demographics data12 

• If the School Coordinator provides updated data, update the 
records in the LST. 

OR 
• If the data is not available, enter missing values as indicated in the 

codebook and ask the School Coordinator to provide the data later 
in the STF for sampled students 

Query any instance where the 
number of students in the List 
of Students worksheet is not 
the same  as the number 
provided in the Information 
worksheet 

• If the number provided in the Information worksheet is incorrect, 
correct the number in the worksheet. 

OR 
• If the number of students in the List of Students worksheet is 

incorrect, ask the School Coordinator to send a corrected list and 
destroy the incorrect one. 

 

After enquiries are made: 
• If all corrections have been made in the existing LST, save a new version of the LST with “_Updated” 

added to the end of the file name. Ensure that the new file is saved in a suitable location. 
• If the School Coordinator is required to send an updated List of Students, delete the existing one. 

When the updated LST has been received, it will need to be checked again. 

5.3.7 Sort LST data 

If an “_Updated” LST has been saved, it will need to be checked to ensure that the listed records are 
ordered correctly before ACER Maple can import it. Open the updated LST in Microsoft® Excel to check: 

 
 
 
12 Date of birth and gender must be entered into the Excel spreadsheet. In rare cases when actual date of birth or gender 
are not available at the time of sampling, missing values must be entered. See Appendix 3 if ‘blind’ sampling is required. 



Chapter 5: Preparing and importing data AMPL DMM 

ACER © 2023 Commercial in Confidence Page 82 of 197 

• If the records on the LST are ordered alphabetically according to class name (e.g. all students from 
6a are listed first, then all students from 6b,…) AND student name within each class, go to section 
5.3.8. 

OTHERWISE 
• Sort the LST data alphabetically by Class Name and Student name (within Class name) as follows: 

1. If the file has opened in Microsoft® Excel in Protected View, click the Enable Editing button at 
the top of the screen. 

2. Highlight row 2 and ALL student records in the List of Students worksheet. 

3. Click DATA. The DATA ribbon will be displayed at the top of the Excel screen. 

4. Click Sort. The Sort window will appear (Figure 60). 

5. Click ‘My data has headers’ in the top right-hand corner of the Sort window (see Figure 60). 

6. In the Sort by drop-down list, click Class Name. 

7. Click Add Level. A new ‘Then by’ drop-down list will appear. 

8. In the ‘Then by’ drop-down list, click Student Name. 

9. Click OK. Microsoft® Excel will sort the data. 

 
Figure 60: Sorting LST 

10. Check that the LST has been sorted as specified: 
 If yes, save a copy of the file with extension “_Sorted” 
 Otherwise, close the file without saving, reopen it, and repeat steps 1 to 10 to sort again. 

5.3.8 Add the value in the ‘AMPL School No.’ column 

In the ‘AMPL School No.’ column, copy over the value from the ‘AMPL School No’ cell in the Information 
worksheet. Make sure that the number is the same for all records in the school. 

5.3.9 Add values in the ‘Line No.’ column 

To add ‘Line No.’ values in the ‘Line No.’ column: 
• In the first row, enter ‘00001. Remember to use a single quotation mark to include leading zeroes. 
• In the second row, enter ‘00002. 
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• Select the two cells, then position the cursor at the bottom right of the selection, and then click to 
expand the black square down to the row of the last student in the list (Figure 61). This will 
populate the line numbers “00001, 00002, 00003, …” for the school. 

  
Figure 61: Populating LST ‘Line No.’ column 

5.3.10 Ensure the data matches the validation rules in each column 

Compare the prepared LST data against the exported codebook and format files for the LST and verify 
that the data matches the validation rules in each column, and the structure of the data. See section 
3.3 for instructions on exporting codebook and format files and how to interpret codebooks. 

As an example of a validation check consider the following: The ‘Month of Birth’ column requires a 2-
digit number (as specified in the validation rule for this column in the codebook). This means that if 
March is entered as ‘3’ or ‘March’, it must be changed to ‘03’ to avoid an error when importing the 
data into ACER Maple. To include a leading 0, key in a single quotation mark (‘) in front of ‘03’. 
  

 
Note that a single quotation mark (‘) is necessary to include leading zeros in columns ‘Line 
No.’ and ‘Month of Birth’. 

To ensure correct structure 
• Open LST format. 
• Make sure that all columns are in the right order. 
• Copy the first row from the format and paste it in row 2 of the LST data worksheet. 

Table 24 shows LST data ready to be imported into ACER Maple. 

 



Chapter 5: Preparing and importing data AMPL DMM 

ACER © 2023 Commercial in Confidence Page 84 of 197 

Table 24: Example LST data in Excel format ready to be imported into ACER Maple  

1   xxxxx <Name> <Surname>  F=1; M=2 MM YYYY  Class 

2 AMPL School No. Line No. Student Name Gender  Month of Birth  Year of Birth SEN Grade Level Class Name Class ID 

3 1001 00001 Xab Yac 1 01 2010 0 6 6C 3 

4 1001 00002 Xac Yad 1 11 2011 0 6 6C 3 

5 1001 00003 Xaf Yag 2 09 2010 0 6 6C 3 

6 1001 00004 Xad Yag 1 08 2010 0 6 6C 3 

7 1001 00005 Xaj Yak 2 05 2010 1 6 6C 3 

8 1001 00006 Xab Yac 1 03 2010 0 6 6C 3 

10 1001 00007 Xb Yacd 2 12 2010 0 6 6C 3 

11 1001 00008 Xab Yah 2 11 2010 0 6 6C 3 

12 1001 00009 Xak Yalk 1 03 2010 1 6 6C 3 

13 1001 00010 Xkl Yvb 2 05 2010 0 6 6C 3 

14 1001 00011 Xab Yfg 1 06 2010 0 6 6C 3 

15 1001 00012 Xab Ykm 2 02 2010 0 6 6C 3 

16 1001 00013 Xed Ygbn 2 04 2009 0 6 6C 3 

17 1001 00014 Xsd Ymnv 1 10 2010 0 6 6C 3 

18 1001 00015 Xcv Ywdj 2 07 2010 0 6 6C 3 

19 1001 00016 Xth Ysdf 1 04 2010 2 6 6C 3 

20 1001 00017 Xwe Ywsc 1 08 2010 0 6 6C 3 

21 1001 00018 Xab Yuhj 2 03 2010 0 6 6C 3 

22 1001 00019 Xerb Yjkl 1 01 2010 3 6 6C 3 
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5.3.11 Save the file 

Save a new version of the LST with “_For_Import” added to the end of the file name. Ensure that the 
new file is saved in a suitable location. 

5.4 Importing Data for Sampling 
  

 

A data administrator login must be used for the following function. 

To import LCL or LST data into ACER Maple:  
1. On the main screen select Import > Field data and then click Activate. The Import field data 

screen will appear (Figure 62). 
2. In the Available Templates drop-down list on the left-hand side of the screen select: 
 LCL if you are importing List of Classes;  
 LCL if you are importing List of Classes.  

3. In the Selected Template Preview use the horizontal scrollbar at the bottom of the previewed 
list to view all the columns in the template. 

4. In the Options list ensure that ‘Append to existing data’ is selected. 

 
Figure 62: Import field data screen-[Update the screen]- 

5. Click Browse… and manually enter or navigate to the location of the Excel file containing the LST 
data to be imported. 

 

The Excel file selected for import must match the template selected in the Available 
Templates drop-down list. 

The Excel file will be uploaded into ACER Maple and its file name will appear in a tab beside the 
Browse… button. 
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In the Uploaded File Preview a preview of the uploaded file will appear (Figure 63). Only the first 
15 rows of data will be displayed. The total number of rows and columns in the uploaded file will 
be displayed beneath the preview. 

 
Figure 63: Uploaded File Preview for a List of Students (LST) -[Update the screen]- 

6. Click Import. ACER Maple then performs a number of validity checks on the data in the selected 
Excel file.  

The possible outcomes and required actions are described in Table 25 for the LCL and Table 26 for the 
LST. 
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Table 25: Possible outcomes when importing List of Classes data  

Outcome  Next steps 

LCL data has been validated, with no 
discrepancies, and is ready to be imported 
into the ACER Maple database. 

Pop-up message appears saying the data 
has been validated with no errors or 
warnings. 

1. Click Continue. 
2. Another pop-up message will appear listing the number of 

records updated. Click Dismiss. 
3. Import LCL data from another Excel file. 

LCL data contains some discrepancies that 
should be checked before importing 
(warnings). 

Pop-up message appears warning that 
there are discrepancies, but the data can 
be imported, and prompts you to save or 
download the report. 

Import Field Data Validity Report is 
available for download. 

1. Click Download Validity Report, save the file in an 
appropriate location and open it. 

2. Refer to section 5.5 to check the records that appear in 
the report. 

3. If any corrections are required, click Cancel to dismiss the 
pop-up message, make the required corrections in the 
Excel file and attempt to import the LCL data again. 

4. If corrections are not required, click Continue to import 
the data. Another pop-up message will appear listing the 
number of records that have been imported. Click Dismiss. 

5. Explanations must be entered in ACER Maple before data 
can be submitted. 

LCL data contains some discrepancies that 
prevent the data from being importing 
(errors). 

Pop-up message appears warning that 
there are discrepancies, the data cannot be 
imported, and prompts you to save or 
download the report. 

Import Field Data Validity Report is 
available for download. 

1. Click Download Validity Report, save the file in an 
appropriate location. Click Cancel to close the pop-up 
message. 

2. Manually enter or navigate to the location of the saved 
report and open it. 

3. Refer to section 5.5 to check the records that appear in 
the report. 

4. Make the required corrections in the Excel file and 
attempt to import the LCL data again. 
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Table 26: Possible outcomes when importing List of Student data  

Outcome  Next steps 

LST data has been validated, with no 
discrepancies, and is ready to be imported 
into the ACER Maple database. 

Pop-up message appears saying the data 
has been validated with no errors or 
warnings. 

1. Click Continue. 
2. Another pop-up message will appear listing the number of 

records updated. Click Dismiss. 
3. Import LST data from another Excel file. 

OR 
Proceed to sample students for the imported/updated 
schools (Chapter 6). 

LST data contains some discrepancies that 
should be checked before importing 
(warnings). 

Pop-up message appears warning that 
there are discrepancies but the data can be 
imported, and prompts you to save or 
download the report. 

Import Field Data Validity Report is 
available for download. 

1. Click Download Validity Report, save the file in an 
appropriate location and open it. 

2. Refer to section 5.5 to check the records that appear in 
the report. 

3. If any corrections are required, click Cancel to dismiss the 
pop-up message, make the required corrections in the 
Excel file and attempt to import the LST data again. 

4. If corrections are not required, click Continue to import 
the data. Another pop-up message will appear listing the 
number of records that have been imported. Click Dismiss. 

5. Explanations must be entered in ACER Maple before data 
can be submitted. 

LST data contains some discrepancies that 
prevent the data from being importing 
(errors). 

Pop-up message appears warning that 
there are discrepancies, the data cannot be 
imported, and prompts you to save or 
download the report. 

Import Field Data Validity Report is 
available for download. 

1. Click Download Validity Report, save the file in an 
appropriate location. Click Cancel to close the pop-up 
message. 

2. Manually enter or navigate to the location of the saved 
report and open it. 

3. Refer to section 5.5 to check the records that appear in 
the report. 

4. Make the required corrections in the Excel file and 
attempt to import the LST data again. 

5.5 Import Field Data Validity Report 

If you attempt to import List of Student data that contains errors and/or missing data, ACER Maple will 
produce an Import Field Data Validity Report (in Excel format) that contains information about these 
issues. Before you try to resolve them, make sure you have your List of Sampled Schools (LSS) handy.  
  

 
The Import Field Data Validity Report can contain multiple worksheets. Make sure you have 
checked the records in all worksheets in the report. 

5.5.1 Errors in List of Classes data 

Table 27 (page 90) lists errors that may appear in particular Error worksheets of the Import Field Data 
Validity Report when an LCL is imported. Table 27 also explains how these errors can be resolved. Most 
of the actions require updating the List of Classes Excel file. 

A file import error may also occur if the file you are attempting to import is not an Excel spreadsheet, 
or if no file was selected to import. In either case, locate the correct file and then attempt to import 
the LCL data again. 
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After all corrections have been made in the LCL Excel file, attempt to import the List of Classes data 
again. As long as errors exist within the LCL file for a particular school, you will not be able to import 
the LCL data. Class sampling for this school cannot proceed until the LCL has been imported 
successfully.  

If the situation arises where a school is not responding to queries, and you need to proceed with 
sampling before all errors have been corrected, you can replace any incorrect data with the 
appropriate missing code(s) (refer to the LCL codebook to find the correct missing codes for each 
variable). You can then proceed with sampling, and the missing codes will appear in the populated SCL 
Excel files as blank cells. You must then ensure that the SC updates the blank cells with the correct 
information before you proceed with student sampling. The updated data should be entered into ACER 
Maple using Update tracking data > Field Operation Forms (see Chapter 9) after the assessment. 

5.5.2 Warnings in List of Classes data 

Table 28 (page 91) lists discrepancies that may appear in Warning worksheets of the Import Field Data 
Validity Report when an LCL is imported and explains how they can be resolved.  

All discrepancies in Warning worksheets are related to missing codes in the data. It is always preferable 
to have non-missing data for number of students in each class before LCL data is imported. However, 
as described above, a situation may arise where a school is not responding to queries, therefore the 
missing codes are allowed. Sampling can then proceed, and the missing codes will appear in the 
populated SCL Excel files as blank cells. The SC must update the blank cells with the correct information 
before you proceed with student sampling. 

 



Chapter 5: Preparing and importing data AMPL DMM 

ACER © 2023 Commercial in Confidence Page 90 of 197 

Table 27: Import Field Data Validity Report for class lists: Errors worksheets – Possible warnings and their resolutions 

Description Error message in report How to resolve Action required  

Incorrect columns worksheet 

Excel file corresponds to a different 
template. 
OR 
Excel file is missing one or more columns. 
OR 
Excel file has one or more extra columns. 
OR 
Excel file has one or more columns with 
incorrect names. 

Incorrect columns:  
Missing – <Column Name>, 
Extra – <Column Name> 

• Check that you are selecting the correct 
List of Students Excel file to import and 
the correct template in ACER Maple. 

• Select the correct LCL Excel file to 
import or select the correct template 
in ACER Maple. 

OR 
• Add all missing columns 

OR 
• Delete all extra columns  

OR 
• Correct column names. 

Import duplication worksheet 

Data has already been imported for the 
same AMPL School No. 

Data for [AMPL School No.] 
‘X’ already imported 

• Check the AMPL School Numbers in the 
LCL Excel file. 

• Correct AMPL School No. in the LCL 
Excel file. 

OR 
• If the current AMPL School No. is 

correct, contact Clare Ozolins at 
Clare.Ozolins@acer.org to discuss 
your options. 

One or more rows contain a AMPL School 
No. and Line No. combination that has 
already been imported. 

Data for [AMPL School No.] 
and [Line No.] already exists 

• Check both AMPL School No. and Line 
No. in the LCL Excel file. 

• Correct AMPL School No. and/or Line 
No. in the LCL Excel file. 

Record duplication worksheet 

One or more rows contain a AMPL School 
No. and Line No. combination that has 
already been imported. 

Confidential data for [AMPL 
School No.] and [Line No.] 
already exists 

• Check both AMPL School No. and Line 
No. in the LCL Excel file. 

• Correct AMPL School No. and/or Line 
No. in the LCL Excel file. 

mailto:Clare.Ozolins@acer.org


Chapter 5: Preparing and importing data AMPL DMM 

ACER © 2023 Commercial in Confidence Page 91 of 197 

Description Error message in report How to resolve Action required  

Key violations worksheet 

There are one or more illegitimate AMPL 
School Numbers. 

[AMPL School No.] is 
illegitimate 

• Check the LSS– only the AMPL School 
Numbers provided there are legitimate. 

• Correct all AMPL School No. in the LCL 
Excel file. 

There are one or more missing values or 
empty cells for AMPL School Numbers. 

[AMPL School No.] is missing • Check AMPL School No. for the specified 
rows in the LCL Excel file. 

• Add correct AMPL School No. from the 
LSS to the LCL Excel file. 

Input line numbers are not sequential 
within a school. 
OR 
There are duplicate input line numbers 
within a school. 

[Line No.] is not sequential  • Check Line No. for the specified rows in 
the LCL Excel file. 

• Correct all Line No. in the LCL Excel 
file. 

Input line numbers do not begin at 00001 
for a school. 

[Line No.] does not begin at 
00001 

• Check Line No. for the specified rows in 
the LCL Excel file. 

• Correct all Line No. in the LCL Excel 
file. 

Validation rules worksheet 

One or more records contain one or more 
values that violate variable validation rules. 

Description of validation rule 
violation(s) 

• Check the specified values against the List 
of Classes codebook for the specified 
rows in the LCL Excel file. 

• Correct all invalid values in the LCL 
Excel file. 

 

Table 28: Import Field Data Validity Report for class lists: Warning worksheets – Possible warnings and their resolutions 

Description Warning message in report How to resolve Action required 

LCL missing value(s) worksheet 

There are one or more missing values 
in a specific column. 

Missing value(s) in <Column 
Name> 

• Check the values in that column 
in the LCL Excel file. 

• Contact the school to get the 
information. 

• Update the LCL Excel file if it has not been 
imported yet. 

OTHERWISE 
• Make updates in the SCL form after sampling. 
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5.5.3 Errors in List of Students data 

Table 29 (page 93) lists errors that may appear in particular Error worksheets of the Import Field Data 
Validity Report when an LST is imported. Table 29 also explains how these errors can be resolved. Most 
of the actions require updating the List of Students Excel file. 

A file import error may also occur if the file you are attempting to import is not an Excel spreadsheet, 
or if no file was selected to import. In either case, locate the correct file and then attempt to import 
the LST data again. 

After all corrections have been made in the LST Excel file, attempt to import the List of Students data 
again. As long as errors exist within the LST for a particular school, you will not be able to import the 
LST data. Student sampling for this school cannot proceed until the LST has been imported successfully.  

If the situation arises where a school is not responding to queries, and you need to proceed with 
sampling before all errors have been corrected, you can replace any incorrect data with the 
appropriate missing code(s) (refer to the LST codebook to find the correct missing codes for each 
variable). You can then proceed with sampling, and the missing codes will appear in the populated STF 
Excel files as blank cells. You must then ensure that the SC/TA updates the blank cells with the correct 
information on or before the day of assessment. The updated data should be entered into ACER Maple 
using Update tracking data > Field Operation Forms (see Chapter 9) after the assessment. 

5.5.4 Warnings in List of Students data 

Table 30 (page 94) lists discrepancies that may appear in Warning worksheets of the Import Field Data 
Validity Report when an LST is imported, and explains how they can be resolved.  

All discrepancies in Warning worksheets are related to missing codes in the data. It is always preferable 
to have non-missing data for gender or date of birth before LST data is imported. However, as 
described above, a situation may arise where a school is not responding to queries, therefore the 
missing codes are allowed. Sampling can then proceed, and the missing codes will appear in the 
populated STF Excel files as blank cells. The SC/TA must update the blank cells with the correct 
information on or before the day of assessment. 
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Table 29: Import Field Data Validity Report for List of Students: Error worksheets – Possible errors and their resolutions (all sampling options) 

Description Error message in report How to resolve Action required  

Incorrect columns worksheet 

Excel file corresponds to a different 
template. 
OR 
Excel file is missing one or more columns. 
OR 
Excel file has one or more extra columns. 
OR 
Excel file has one or more columns with 
incorrect names. 

Incorrect columns:  
Missing – <Column Name>, 
Extra – <Column Name> 

• Check that you are selecting the 
correct List of Students Excel file to 
import and the correct template in 
ACER Maple. 

• Select the correct LST Excel file to 
import or select the correct 
template in ACER Maple. 

OR 
• Add all missing columns 

OR 
• Delete all extra columns  

OR 
• Correct column names. 

Import duplication worksheet 

Data has already been imported for the 
same AMPL School No. 

Data for [AMPL School No.] 
‘X’ already imported 

• Check the AMPL School Numbers in 
the LST Excel file. 

• Correct AMPL School No. in the LST 
Excel file. 

OR 
• If the current AMPL School No. is 

correct, contact Clare Ozolins at 
Clare.Ozolins@acer.org to discuss 
your options. 

One or more rows contain a AMPL School 
No. and Line No. combination that has 
already been imported. 

Data for [AMPL School No.] 
and [Line No.] already exists 

• Check both AMPL School No. and Line 
No. in the LST Excel file. 

• Correct AMPL School No. and/or 
Line No. in the LST Excel file. 

Record duplication worksheet 

One or more rows contain a AMPL School 
No. and Line No. combination that has 
already been imported. 

Confidential data for [AMPL 
School No.] and [Line No.] 
already exists 

• Check both AMPL School No. and Line 
No. in the LST Excel file. 

• Correct AMPL School No. and/or 
Line No. in the LST Excel file. 

mailto:Clare.Ozolins@acer.org
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Description Error message in report How to resolve Action required  

Key violations worksheet 

There are one or more illegitimate AMPL 
School Numbers. 

[AMPL School No.] is 
illegitimate 

• Check the LSS– only the AMPL School 
Numbers provided there are legitimate. 

• Correct all AMPL School No. in the 
LST Excel file. 

There are one or more missing values or 
empty cells for AMPL School Numbers. 

[AMPL School No.] is missing • Check AMPL School No. for the 
specified rows in the LST Excel file. 

• Add correct AMPL School No. from 
the LSS to the LST Excel file. 

Input line numbers are not sequential 
within a school. 
OR 
There are duplicate input line numbers 
within a school. 

[Line No.] is not sequential  • Check Line No. for the specified rows in 
the LST Excel file. 

• Correct all Line No. in the LST Excel 
file. 

Input line numbers do not begin at 00001 
for a school. 

[Line No.] does not begin at 
00001 

• Check Line No. for the specified rows in 
the LST Excel file. 

• Correct all Line No. in the LST Excel 
file. 

Validation rules worksheet 

One or more records contain one or more 
values that violate variable validation 
rules. 

Description of validation rule 
violation(s) 

• Check the specified values against the 
List of Students codebook for the 
specified rows in the LST Excel file. 

• Correct all invalid values in the LST 
Excel file. 

 

Table 30: Import Field Data Validity Report for student lists: Warning worksheets – Possible warnings and their resolutions 

Description Warning message in report How to resolve Action required 

<LST> missing value(s) worksheet 

There are one or more missing values in a 
specific column. 

Missing value(s) in <Column 
Name> 

• Check the values in that column in the 
LST Excel file. 

• Contact the school to get the 
information. 

• Update the LST Excel file if it 
has not been imported yet. 

OTHERWISE 
• Make updates in the tracking 

form after sampling. 
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5.6 Caution against Re-Importing List of Student Data 

If students have not yet been sampled in a school, you can re-import the LST data using Import > Field 
data (as described in this section). 

If students have already been sampled in a school and you need to update demographic data for any 
students, you should not re-import the LST data into ACER Maple using Import > Field data. Updates 
to demographic data for students that have already been sampled should be made using Update 
tracking data > Field Operation Forms (see Chapter 9) after the assessment. 

If students have already been sampled in a school, the LST data should only be re-imported if the initial 
list was seriously compromised. For example: 
• data for one school was uploaded for another school by accident; or 
• a school sent an incomplete list of students (e.g. only students from one campus). 
  

 
Do not re-import LST data for a school which has already sampled students unless there is 
time to: 

1. re-sample students; and  
2. send the updated tracking forms to the school; and 
3. you have agreed with ACER that you are permitted to do this. 

If the above three conditions are met, ensure that you delete all tracking forms produced 
from the incorrect List of Students before re-importing the list. You must also make sure 
that the School Coordinator has deleted the previously received tracking forms. 

If you found that students have been sampled from a seriously compromised List of Student 
but do not have time to re-sample and to send correct tracking forms to the school, contact 
Clare Ozolins at Clare.Ozolins@acer.org. Explain what was wrong with the initial List of 
Student and include the correct List of Students with your e-mail. 

To re-import any LST data for a school which has already been imported into ACER Maple: 
1. On the main screen select Import and then click Activate. The Import field data screen will 

appear (Figure 64). 

mailto:Clare.Ozolins@acer.org
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Figure 64: Import field data screen 

2. In the Available Templates drop-down list select the relevant template. 
3. Click Browse… and manually enter or navigate to the location of the Excel file containing the LST 

data to be imported. 
  

 

The Excel file selected for re-importing must match the template selected in the Available 
Templates drop-down list. 

4. In the Options list select ‘Replace specific records’. 

5. Click Import. ACER Maple will attempt to import the LST data from the selected Excel file, 
replacing the previously imported LST data for this school. 

6. ACER Maple then performs a number of validity checks on the data in the selected Excel file. The 
possible outcomes and required actions are described in Table 31 on the following page. 

Some warnings may not require any corrections in the data. It is also possible that after corrections 
have been made, some errors still remain. In this case, when you try to re-import the List of Student 
data, the validity report will be produced again. 
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Table 31: Scenarios when re-importing List of Student data for a school 

Scenario Message Next steps 

Students have not been 
sampled for this school, no 
errors or warnings. 

Data have been validated. No errors. 
No warnings. 
Please click Continue. 

• Click Continue. 

Students have not been 
sampled for this school, 
errors or warnings. 

Data contains errors and cannot be 
imported into the ACER Maple 
database. 
Please download the validity report. 

1. Click Download Validity Report. 
2. Follow the instructions in the 

relevant sub-sections of section 5.5 
to address the errors and/or 
warnings in the Import Field Data 
Validity Report. 

Students have been 
sampled for this school. 

AMPL School No. ‘X’ has been 
already sampled. 
Have you discussed the issue with 
sampling contractor? 
If Yes: 
All data for AMPL School No. ‘X’ will 
be replaced. 
Have you backed up your data? 

• Only click OK if: 

 you are sure there is enough 
time to re-sample students and 
send the updated tracking forms 
to the school; 

 the old tracking forms are 
deleted by you and by the 
School Coordinator before you 
produce new tracking forms; 
and 

 you have permission from ACER 
to do so. 

To obtain permission from ACER 
contact Clare Ozolins at 
Clare.Ozolins@acer.org, explaining 
what was wrong with the initial LST 
and attaching the correct LST to the 
message. 

OTHERWISE 
• If you do not have time to re-

sample and to send the correct 
tracking forms to the school, or 
do not have permission from 
ACER, click Cancel. 
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6 SAMPLING 
 

 

A data administrator login must be used for the following function. 

After an LST has been successfully imported into ACER Maple, the students for that school can be sampled. 

To sample the students for a school, and allocate each student the appropriate instruments: 
1. On the main screen select Sample and allocate instruments > Sample and allocate and then click 

Activate. The Sample and allocate instruments screen will appear (Figure 65). 

 
Figure 65: Sample and allocate instruments screen-[replace]- 

2. In the Select Population Type box select: ‘ 

1. classes’.  

2. students’.  

3. In the Select Combined Option box select the available option. The option will be: 

1’- if you are sampling classes; or 

<xxx>- a three-digit number designated to each entity on the LSS in the Student combined option 
column, if you are sampling students. 
You have to select the option even if there is only one. 

4. In the Select School Type list keep ‘Main’ selected (unless you need to sample a replacement school). 
  

 
Do not select ‘Already sampled’ unless this has been agreed with ACER sampling team. 
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5. Click List Available Institutions to Sample. In the Available for Sampling box the AMPL School Number 
of all schools which are available for sampling will be listed (Figure 66). 

 
Figure 66: Schools available for sampling listed in the Available for Sampling box 

6. In the Available for Sampling box select the AMPL School Numbers of all schools to be sampled. Use 
Shift and/or Ctrl to select multiple schools as required (Figure 67). 

 
Figure 67: Selecting multiple schools in the Available for Sampling box 

7. Click  to move these schools into the Selected for Sampling box (Figure 68)13, the Sample button 
will appear. 

 
Figure 68: Multiple schools moved to the Selected for Sampling box 

8. Click Sample. ACER Maple will draw the sample and allocate instruments to the sampled students for 
the selected combined option in the selected schools. 

During the sampling and instrument allocation process ACER Maple will perform some validity checks of the 
data. The possible outcomes and required actions are described in Table 32. 

 
 
 
13 To remove schools from the Selected for Sampling field select the MILO School Numbers in this field and then click . 
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Table 32: Scenarios when using the Sample and allocate function 

Outcome  Next steps 

• Sampling and allocation successful, no 
discrepancies found. 

• Messages: ‘The selected Institutions have been 
sampled’ AND ‘Instruments have been allocated to 
the selected population in all selected institutions’ 

1. Click OK for each message. 
2. Proceed to populate tracking forms with data 

for these schools (Chapter 7). 
OR 
Complete sampling and allocation of 
instruments for another set of schools. 

• Sampling successful but the data contains some 
discrepancies that should be checked (warnings). 

• Message: ‘No allocation in background/initial data 
for this case’ 

The Sampling Validity Report is available for download. 

1. Download the Sampling Validity Report. 
2. Contact ACER Helpdesk at 

maplehelpdesk@acer.org; include your 3-
letter NC code, a short description of the 
problem in the subject line. Attach report. 
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7 POPULATING SCL AND STF TEMPLATES WITH 
SAMPLING DATA 
7.1 Populating SCL and STF templates with data from ACER Maple....................................... 101 
7.2 Export Field Data Checks ................................................................................................... 106 

 

7.1 Populating SCL and STF templates with data from ACER 
Maple 

 

A data administrator login must be used for the following function. 

After sampling the STF Excel templates need to be populated with sampled students’ data. 

To populate the STF templates with data: 
1. On the main screen select Export > Field data and then click Activate. The Export field data 

screen will appear (Figure 69). 

 
Figure 69: Export field data screen 

2. In the Select Population Type box select: 

 ‘1. classes’, if populating SCL; or 

‘2. students’, if populating STF 

3. In the Select Combined Option the select: 

1, if populating SCL; or 

<xxx>- a three-digit number designated to each entity on the LSS in the Student combined option 
column, if populating STF. 
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You have to select the option even if there is only one. 

4. In the Select Sampling Level box select ‘Main Sample’. 

5. Click List Available Institutions to Export.  
6. In the Available for Export box the AMPL School Numbers of all schools whose STF is available to 

populate with data will be listed (Figure 70). 

 
Figure 70: Schools available to populate tracking forms with data are listed in the Available for Export box-

[update screenshot]- 

7. In the Available for Export box select the AMPL School Numbers of all schools whose populated 
STF you wish to generate. Use Shift and/or Ctrl to select multiple schools as required (Figure 71). 

 
Figure 71: Selecting multiple schools in the Available for Export box-[update screenshot] 

8. Click  to move these schools into the Selected for Export box (Figure 72). To remove schools 
from the Selected for Export box select their AMPL School Numbers and then click  

Once schools have been added to the Selected for Export box the Select excel template(s) button 
will appear. 

 
Figure 72: Multiple schools moved to the Selected for Export box[update screenshot] 

9. In the Select Template(s) box select the template displayed on your screen. 
  

 

A template must be selected in the Select Template(s) box although only one template is 
listed in this box for the AMPL NCs 

10. Click Select excel template(s). A pop-up window will appear asking you to select the 
corresponding Excel file template (Figure 73). 
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Figure 73: Pop-up to select the Excel file template [update when the training version is ready]- 

11. Click Browse and manually enter or navigate to the location of the STF Excel template which 
matches the template selected in the Select Template(s) box. 

  

 

The Excel template selected in the folder must match the template selected in the Select 
Template(s) box. If this is not the case, it will cause an error and the export will be 
terminated. See section 7.2 for details 

The STF Excel template will be uploaded into ACER Maple and its file name will appear in a tab 
beside the Browse button (Figure 74). 

 
Figure 74: Tracking form Excel template uploaded into ACER Maple[update when the training version is 

ready]- 

12. Click Submit selection. The Export button will appear at the bottom of the screen.  
13. Click Export. ACER Maple will generate STFs populated with data for the selected sampled 

population, combined option, sampling level, schools and tracking form template. These 
populated tracking forms will be combined into one zip file which will be available for download 
(Figure 75).  

 
Figure 75: Downloaded zip file containing populated tracking forms 

14. Select ‘Save File’(Figure 75). 
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15. Click OK and save the zip file in an appropriate location. 
16.  After the file has downloaded, unzip it.  

 
Each of the tracking forms will have the following file name: STF_<AMPL School 
No.>_<Date>. 
For example, the STF for school 1001 produced on the 30 May 2023 will have the file name 
STF_1001_2023_05_30. Keep these names for all tracking forms that have been produced 
by following steps 1- 16 in this section. 

 

17. Populate row 2 of each of the tracking forms as follows:  
 Copy the AMPL School No from the file name (1001 in the example). 
 Open the file. 

 Paste the AMPL School No in row 2 column D of the Student Tracking Form worksheet of the 
STF workbook. 

 Copy the school name from the School Tracking Form provided to you by ACER and paste it 
under School Name in row 2 of the Student Tracking Form worksheet in the STF Excel file. 

 Use your records to complete the School Coordinator and Test Administrator names. 
 Provide dates for Day 1 and Day 2 of the assessment if they have already been agreed with 

the school. 
An example of an STF form ready for assessment administration is provided in Table 33, page 
105. 

18. Save the form using the following file name:  
STF_<LNG>_<AMPL School No.>_<Date>_<SchoolName>_TAReady. For example, the form 
provided in Table 33 can be saved as STF_ENG_1001_2023_05_30_CentralSchool_TAReady. 

19. Send this form electronically to School Coordinator to check, or print it and send it by post. 
  

 
It is recommended that all tracking forms are sent in electronic format to the School 
Coordinator. If possible the Test Administrator can then use the electronic version during 
the assessment, as well as for updating data on the tracking forms. The forms, once they 
have been updated after the assessment, can then be returned in electronic format and no 
additional manual data entry will be required. 

 

20. Print another copy of the form to include in the package for Test Administrator. 
21. You are ready now to produce labels and package the field operation materials for the School 

Coordinator and Test Administrator (see Chapter 8) 
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Table 33: Example STF ready to be sent to Test Administrator and School coordinator for field operations. 

1 School Name AMPL School No.  School Co-ordinator  Test Administrator Session Date 1 (DD/MM) Session date 2 (DD/MM) 

2 Central school 1001  Mr SC ABC Ms TA XYZ 30/05 31/05 

3  LST 
 

 
F=1; 
M=2 MM YYYY  Attendance  Class  

4 Student Name Line No. AMPL 
Participant ID 

Test 
Form Gender Month of 

Birth 
Year of 

Birth SEN Test  StQ Participation Grade Level Class Name Comments 

5 Xab Yac 00001 96100106 5 1 01 2010 0 1 1 1 6 6C  

6 Xac Yad 00002 96100104 6 1 11 2011 0 0 1 0 6 6C  

7 Xaf Yag 00003 96100105 7 2 09 2010 0 1 0 0 6 6C  

8 Xad Yaf 00004 96100101 8 1 08 2010 0 0 0 1 6 6C  

9 Xaj Yak 00005 96100103 3 2 05 2010 1 1 1 0 6 6C  

10 Xab Yac 00006 96100108 4 1 03 2010 0 0 1 1 6 6C  

11 Xb Yacd 00007 96100102 5 2 12 2010 0 1 0 1 6 6C  

12 Xab Yah 00008 96100109 6 2 11 2010 0 1 1 1 6 6C  

13 Xak Yalk 00009 96100107 7 1 03 2010 1 0 0 0 6 6C  

14 Xkl Yvb 00010 96100110 8 2 05 2010 0 0 0 0 6 6C  

15 Xab Yfg 00011 96100115 3 1 06 2010 0 0 0 0 6 6C  

16 Xab Ykm 00012 96100120 4 2 02 2010 0 0 0 0 6 6C  

16 Xed Ygbn 00013 96100111 5 2 04 2009 0 0 0 0 6 6C  

18 Xsd Ymnv 00014 96100116 6 1 10 2010 0 0 0 0 6 6C  

19 Xcv Ywdj 00015 96100112 7 2 07 2010 0 0 0 0 6 6C  

20 Xth Ysdf 00016 96100117 8 1 04 2010 2 0 0 0 6 6C  

21 Xwe Ywsc 00017 96100113 3 1 08 2010 0 0 0 0 6 6C  

22 Xab Yuhj 00018 96100114 4 2 03 2010 0 0 0 0 6 6C  
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7.2 Export Field Data Checks 

When the Export > Field data function is used, ACER Maple checks that the tracking form template 
selected in ACER Maple matches the selected tracking form Excel template. Table 34 on the following 
page gives detailed information about the types of inconsistencies that may appear.  

<Template selected on screen> in Table 34 refers to the template selected on the Export field data 
screen. Error messages appear in pop-up windows with the title: ‘Problem with excel template for 
exporting <Template selected on screen>’. For example, if the STF_ENG template was selected the title 
will be: ‘Problem with excel template for exporting STF_ENG’. 

‘Row X’ in Table 34 refers to the row in the original unmodified template containing the heading titles 
(before any national adaptations were made). For example, in the STF_ENG template this is row 4. 
Therefore the message will display: ‘Make sure that the column headers are in row number 4’. 

After all corrections have been made, attempt to generate the populated STF again. 
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Table 34: Messages when generating tracking forms populated with data 

Description Pop-up error message  How to resolve Action required 

Excel file is missing one or more columns. 
OR 
Excel file has one or more extra columns. 
OR 
Excel file has one or more columns with 
incorrect names. 
OR 
Excel file corresponds to a different 
template. 

Column headings in Excel file must 
correspond to the column names 
in <Template selected on screen> 
Make sure that the column 
headers are in the row number X 

• Check that you are selecting 
the correct Excel file to 
export and the correct 
template in ACER Maple. 

OTHERWISE 
• Carefully check all 

adaptations you made in the 
template of the Excel file and 
in ACER Maple when you 
modified the corresponding 
ACER Maple template. 

• Select the correct Excel file to import 
or select the correct template in 
ACER Maple. 

OR 
• Add the missing columns or modify 

the template in ACER Maple as 
required. 

OR 
• Delete any extra columns or modify 

the template in ACER Maple as 
required. 

OR 
• Correct the column names or modify 

the template in ACER Maple as 
required.  

• Make sure that the column headings 
are in the correct row. 

Excel file does not have any column 
headings in the row where the column 
headings are expected by ACER Maple. 

Column headings in the selected 
file are expected to be in row X 
This row in the selected excel file 
does not hold any data (empty 
cells) 

• Check that you are selecting 
the correct Excel file to 
export and the correct 
template in ACER Maple. 

OTHERWISE 
• Correct the template. 

• Select the correct Excel file to import 
or select the correct template in 
ACER Maple. 

OR 
• Make sure that the column headings 

are in the correct row. 

Some other file (not an Excel file) was 
selected by mistake to be populated with 
data. 

Please select an excel file (.xls, 
.xlsx) to upload 

• Select the correct file. • Select the correct file. 
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8.1 Using Mail Merge Function in Microsoft Word 

The Mail Merge function in Microsoft® Word allows users to create documents or labels by populating them 
with data from a Microsoft® Excel worksheet.  

The Mail Merge procedure for the AMPL is designed to produce the labels that will be attached to the cover 
of each of the assessment instruments.  
• Two labels must be printed for each student: 
 One label for each test form assigned to students on the STF; and 

 One label for the Student Questionnaire. 
• One label should be printed for each School Questionnaire. It is convenient to create a separate folder 

for labels, called Labels in the rest of this chapter. 

To create labels, you will need to use the following functions: 
1. The Export List of Candidates function in ACER Maple exports excel worksheets containing student and 

principal data required for labels. This function exports the list of all candidates that were sampled in 
the relevant administrative domain, i.e. in all schools associated with a given Admin ID account (section 
8.2). 

2. The Mail Merge function to create labels in a Microsoft® Word document (section 8.3).  

The Word document can then be printed on the adhesive labels which will be attached to the printed 
assessment instruments. 

8.2 Exporting labelling forms 

After student tracking forms have been populated with sampled students’ data, lists of student candidates 
can be exported and used to produce the required labels for each survey instrument. 
 

 

A data manager or data administrator login must be used for the following function. Data 
manager can export data for all sampled candidates in the entity and data administrator 
can export data for all sampled candidates in their administrative domain 

 

To export the required excel files from ACER Maple: 
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1. On the main screen select Export > List of Candidates and then click Activate. The Export list of 
candidates screen will appear (Figure 76). 

 
Figure 76: Export list of candidates screen 

2. Click the Select Templates field at the top of the screen. A drop-down list will appear. 
3. Select the following templates:  

• AMPL Student Labelling Form (AMPL_SALF) 

• AMPL School Questionnaire Tracking Form (AMPL_SQTF) 
4. Once template(s) have been selected, the Export button will appear at the right bottom corner of the 

Export list of candidates screen (Figure 77). 

 
Figure 77: The Export button at the bottom of the screen 

5. Click Export. All selected files will be combined into one zip file which will be available for download 
(Figure 78).  

 
Figure 78: Save list of candidates 

6. Select ‘Save File’ and click OK to save the zip file. Manually enter or navigate to an appropriate location 
to save the file.  

7. After the zip file has been downloaded, unzip the Excel files into your Labels folder. 

8. Open the exported AMPL_SALF data file saved in your Labels folder (see example in Table 35). Columns 
A-G contain information that will be mail-merged into labels.  
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Column G specifies to which test form the label must be assigned. 
For example:  
• the label with the student ID=286100103 should be assigned to Form 5 (highlighted in 

red in Table 35); while 
• the label with the student ID=286100108 should be assigned to Booklet 6 (highlighted in 

green in Table 35), 

Table 35: Example of SALF data in Excel format to be used for labelling student test booklets and questionnaires 

 A B C D E F G 

2 School Name AMPL School No. Grade Level Class Name Student Name AMPL Participant ID Test Form 

3 Central school 1001 6 6C Xab Yac 286100103 5 

4 Central school 1001 6 6C Xac Yad 286100108 6 

5 Central school 1001 6 6C Xaf Yag 286100101 7 

6 Central school 1001 6 6C Xad Yag 286100102 8 

7 Central school 1001 6 6C Xaj Yak 286100112 3 

8 Central school 1001 6 6C Xab Yac 286100104 4 

10 Central school 1001 6 6C Xb Yacd 286100113 5 

11 Central school 1001 6 6C Xab Yah 286100107 6 

12 Central school 1001 6 6C Xak Yalk 286100115 7 

13 Central school 1001 6 6C Xkl Yvb 286100109 8 

14 Central school 1001 6 6C Xab Yfg 286100108 3 

15 Central school 1001 6 6C Xab Ykm 286100116 4 

16 Central school 1001 6 6C Xed Ygbn 286100117 5 

17 Central school 1001 6 6C Xsd Ymnv 286100110 6 

18 Central school 1001 6 6C Xcv Ywdj 286100119 7 

19 Central school 1001 6 6C Xth Ysdf 286100120 8 

20 Central school 1001 6 6C Xwe Ywsc 286100111 3 

21 Central school 1001 6 6C Xab Yuhj 286100106 4 

22 Central school 1001 6 6C Xerb Yjkl 286100118 5 
 

9. Open the exported AMPL_SQTF data file saved in your Labels folder (see example in Table 35): 
 Columns A-C contain information that will be mail-merged into labels.  
 Columns D and E will be filled after School Questionnaires are returned to the NC.  

Table 36: Example of SQTF data in Excel format to be used for labelling School Questionnaires 

 A B C D E 

2 School Name AMPL School No. AMPL Participant ID Participation Code Comment 

3 Central school 1001 386100101   

4 Central school 1002 286100201   

5 Central school 1004 286100104   
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8.3 Creating Labels 

When the Student Data Labels (i.e. SDL) Excel file(s) is ready, you need to prepare your adhesive labels for 
printing. You will need to know the supplier and product number of your labels. Once you have this 
information you will be able to: 
1. Specify your label types and field titles in Word documents as explained in section 8.3.1. 

2. Populate this Word document with data and print your labels as explained in section 8.3.2 

8.3.1 Specifying label type 

To specify label types: 
1. Open a new Word document. 
2. In the menu bar, click Mailings > Start Mail Merge > Labels. The “Label Options” dialog box will appear 

(Figure 79) 

 
Figure 79: Mail Merge Label Options dialog box 

3. Select your label supplier from the ‘Label vendors’ drop-down list.  
4. Select the product number from the “Product number” list14.  
5. The document should now display a table with an outline of the labels. If you don’t see the outline of 

the labels, go to Table Tools > Layout >View Gridlines. 
6. In the first label provide the following field titles: 

School Name  
AMPL School No.  
Grade Level 
Class Name 
Student Name 
AMPL Participant ID 
Booklet No. 

7. Save your document in the Labels folder with the file name TFLB_type. 
8. Repeat steps 1-5 to create labels for Student Questionnaires. 

 
 
 
14 If none of the options match your label package, choose “New Label”, enter your label’s information, and give it a name. Choose 
“OK” to add the new label to the “Product number” list. 
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9. In the first label provide the following field titles: 

School Name  
AMPL School No.  
Grade Level 
Class Name 
Student Name 
AMPL Participant ID 

10. Save your document in the Labels folder with the file name STQLB_type. 
11. Repeat steps 1-5 to create labels for School Questionnaires. 

12. In the first label for School Questionnaires provide the following field titles: 

School Name  
AMPL School No.  
AMPL Principal ID  

13. Save your document in the Labels folder with the file name SCQLB_type. 

8.3.2 Populating the STLB_type document with data and printing labels –[update for 
multiple schools]- 

To populate the STLB_type document with data and to print labels: 
1. Open the STLB_type document you created in section 8.3.1. 

2. Choose a school for which you need to create labels. Save a copy of the STLB_type document with the 
school name, AMPL School No. and date in the file name (e.g. STLB_<AMPL School No>_<School 
Name>_<Date>).-[scenarios for one/multiple/all schools]-  

3. In the menu bar, click Mailings > Select recipients > Use an existing list. 
4. Locate and open the Excel file containing the data for the school(s) for which you are creating labels 

(created in section 8.2).  
5. In the first label in the STLB_<AMPL School No>_<School Name>_<Date> document, insert the 

following fields: 
 Click Mailings > Insert Merge Field > School_Name next to the School Name title 
 Click Mailings > Insert Merge Field > AMPL_School_No. next to the AMPL School No. title 

 Click Mailings > Insert Merge Field > Student_ID next to the Student ID title. 

6. Click Mailings > Update Labels. The result should be similar to what is shown in Figure 80 (depending 
on your label size) 
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Figure 80: Mail Merge document with fields inserted –[update when ready]- 

7. Click Mailings > Finish & Merge > Print Documents to populate document with data and print labels. 
An example of labels to be printed is shown in Figure 81. 

 
Figure 81: Labels ready to be printed 

8. Repeat steps 2 to 7 for each school participating in the survey. 
9. To prepare labels for School Questionnaires Repeat steps 2 to 7 using the SQLB_type document you 

created in section 8.3.1 with the pre-populated SQTF that was despatched with ACER Maple. 

8.4 Labelling and Packaging Materials for Test Administrators 

For each student in an STF label file (created in section 8.3), print three copies of their ID label. Attach a label 
to each of the following instruments: 
• AMPL Test Booklet 1 according to the allocation in the STF; and 
• AMPL Student Questionnaire 

Bundle these materials, along with a School questionnaire (labelled with School Name, AMPL School no., and 
Principal ID) and all other materials listed in the Test Administrator Manual, Appendix 1. 
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Test Administrators must return ALL assessment materials and resources to the NC, using a secure 
service. These materials must be carefully checked and sorted in preparation for data entry as outlined 
below and explained in detail in the corresponding sections of this chapter. 

To prepare materials for data entry, all data administrators will need to: 
1. Check student assessment instruments against the STF and prepare them for data entry (section 

9.1). 
2. Conduct internal STF data checks (section 9.2). 
3. Check the school questionnaire and record its receipt in the SQTF (section 9.3)  

4. Update STF and SQTF data in ACER Maple (sections 9.4-9.5). 

After all materials from all schools have been returned, the data manager will need to update school 
participation in ACER Maple (sections 9.6-9.7). 
 

 
If STFs have been sent in electronic format to the School Coordinator and the Test 
Administrator, and the Test Administrator used the electronic version of the STF during the 
assessment to update data, then the STFs can also be returned in electronic format once 
they have been updated after the assessment. This will mean that no additional manual 
data entry will be required in the STF Excel files. 

  

 

If the STF has been returned in paper format, you will need to manually update the 
corresponding electronic Excel versions of the tracking forms that were initially populated 
with sampled students’ data (see chapter 7) before they can be updated in ACER Maple. 
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9.1 Preparing Assessment Instruments for Data Entry  

When materials have been received from the Test Administrators after the assessment, data 
administrators must check four types of assessment instruments against STF Attendance codes (i.e. 
the attendance code recorded by the TA on the STF), and then prepare them for data entry in ACER 
Maple. These instruments are:  
• AMPL Test Booklets; and 
• AMPL Student Questionnaires. 

Most of the returned student assessment instruments will have responses, but some of them will 
remain empty. These are either spares or instruments that were intended for students that did not get 
completed. Each data administrator will therefore need five boxes to sort the instruments from the 
schools that belong in their domain:  
• one box for empty student assessment instruments; and  
• a number of boxes for completed (or partially completed) student assessment instruments: 
 one box for each of the AMPL Test Booklets; and 
 one box for the AMPL Student Questionnaires. 

Each of these boxes should be sorted by AMPL school ID and by AMPL student ID within each school.  
  

 
All instruments must be kept secure and in order. 

 

9.1.1 Sorting student assessment instruments that have correct corresponding 
STF Attendance codes 

Table 37 shows correct STF Attendance codes for empty instruments, and for instruments with at least 
one response. It also shows how to sort the instruments in the corresponding boxes depending on 
whether they are empty or not.  

<X> in Table 37 is the booklet number (e.g. 1,2,…). The box labels are provided as an example for the 
purpose of explaining the sorting procedure. You can label them in another way if you prefer 

Table 37: STF Attendance codes for empty instruments and for instruments with at least one response 

Correct STF 
Attendance code Student assessment instruments Box labelled 

Test=1 AMPL Test Booklet <X> with at least one response. DE<X> 

Test=0 Empty AMPL Test Booklet X. EMPTY 

Q=1 AMPL Student Questionnaire with at least one response. DEQ 

Q=0 Empty AMPL Student Questionnaire. EMPTY 
 

9.1.2 Preparing student assessment instruments that have incorrect 
corresponding STF Attendance codes for enquiries 

If there is a discrepancy between the STF Attendance code and the content of an instrument, then the 
instrument will need to be put aside, and the record in the STF should be flagged as requiring 
investigation. 
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Examples 

1. If Test=1 and the AMPL Test Booklet  with the same student ID is empty, then the 
record in the STF must be flagged for investigation and the test booklet placed in 
the EMPTY box. 

2. If Test=0 and the AMPL Test Booklet with the same student ID has at least one 
response, then the record in the STF must be flagged for investigation and the 
booklet will need to be placed aside in case it requires a different label. 

 

After all booklets are checked, the data administrator needs to check the STF for internal discrepancies 
(see section 9.2). Once the STF has been checked, the data administrator or the data manager must 
contact the Test Administrator and/or School Coordinator to resolve discrepancies, correct the STF if 
required, and sort any instruments with discrepancies (see 9.2.4). 

9.2 Conducting Internal STF Data Checks 

The first thing you need to do when you receive a completed STF back from a school, is check the data 
that has been updated by the School Coordinator and Test Administrator. 

The data you need to check includes: 
• student demographic data (grade, gender, date of birth);  
• SEN codes against participation codes; and 
• participation codes against attendance codes. 

These checks are all explained in the following subsections. 

9.2.1 Checking student demographic data 

The following checks are required for student demographic data:  
• If the class name includes grade level, check that it is the correct grade for your country: 
 

Cameroon  

Djibouti  

India  

Kenya 7 

Rwanda  

The Gambia  

Sierra Leone  

Zambia 5 
 

• check that each students’ date of birth is within a reasonable range for the year level assessed in 
your country; 

• check that each students’ gender corresponds to the student names (wherever possible). 

Highlight any suspicious records in the STF. 
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9.2.2 Checking SEN codes 

The box below lists all valid SEN codes for Student Tracking Forms in the  AMPL. 
  

 
SEN codes for student tracking forms for the  AMPL: 
0 – No SEN condition 
1 – Functional disability 
2 – Cognitive, behavioural, or emotional disability 
3 – Limited assessment language experience 

Check that  
• ALL SEN codes are valid (i.e. ALL SEN codes are less than or equal to 3); and 
• Participation code ‘3’ (excluded on SEN basis) is only assigned to students with SEN > ‘0’.  

Highlight any discrepant records in the STF. 

9.2.3 Checking Participation codes against Attendance codes 

Valid STF Participation codes: 

1 – Participant 

2 – Parent refusal 

3 – Excluded on SEN basis 

4 – Now enrolled at another school 

5 – Not enrolled in this school, enrolment unknown 

0 – Non-participant for any other reason 

Valid STF Attendance codes (columns MT, Q, and NRA): 

1 – Participant 

0 – Non-participant 
  

 
At this stage, a student is considered to be a ‘participant’ (code ‘1’) if he or she attended a 
session for at least one of the instruments (i.e. provided at least one response in one of the 
instruments which has been marked with Attendance code ‘1’). 

 

For each record in the STF check the following:  
• if the STF Participation code is ‘1’, then at least one of the Attendance codes is ‘1’; and 
• if all three Attendance codes are ‘0’, the STF Participation code is NOT ‘1’. 

Highlight any discrepant records in the STF. 

9.2.4 Enquiring about discrepancies 

If any records have been highlighted in the STF, contact the Test Administrator and/or School 
Coordinator to find which data is correct and to update the STF as required.  
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In cases where a student completed the wrong instrument (i.e. Student A completed student B’s 
instrument(s)), you will need to replace the label on student B’s instrument with the label for student 
A. 

Also make enquiries about missing data. 
  

 

Make every attempt to recover any missing data. It is extremely important for data analysis 
that demographic data for every student is available. 

 

After all discrepancies have been resolved sort the instruments into appropriate boxes as indicated in 
Table 37 (page 115) 

9.3 Receiving AMPL School Questionnaires 

The School Questionnaire Tracking Forms (SQTF) are provided for each domain pre-populated by ACER 
with the list of all principals in each domain. 

On receipt of materials from the Test Administrators, the data administrator must check the AMPL  
School Questionnaire and record the following in their SQTF: 
• Any AMPL School Questionnaires that have at least one response must be recorded as ‘1’-

‘Returned’ in the SQTF, sorted by AMPL School Number, and securely stored for data entry. 
• Any empty AMPL School Questionnaires should be separated, sorted by AMPL School Number, and 

securely stored in the EMPTY box. The code that should be entered in the SQTF depends on the 
reason the questionnaire was returned empty (see Table 38). 

Table 38: School Questionnaire Codes to be entered into SQTF 

Code Code meaning 

1 Returned 

2 School refused to participate 

3 Non-participation for other reasons  

4 No eligible students  

5 School closed (permanently)  

7 Replacement school not contacted  

8 School ineligible for other reasons 

9 School exclusion (specify type and number of eligible students)  

0 School questionnaire has not been returned for another reason (not specified) 

Once all school questionnaires that have been received back from schools have been recorded in the 
SQTF, update the SQTF for any remaining schools as indicated in Table 38. 
  

 
A school questionnaire code is required for each school. 

  

 
Add an explanation in the ‘Comment’ column if required. You must provide an explanation 
in the ‘Comment’ column for codes ‘3’ and ‘9’. All other codes do not require comments 
unless you feel that it is necessary. 
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The length of a comment is restricted to 500 characters. If more space is required please 
include the AMPL School Number and your comment in the Sampling Data Submission 
Checklist. 

 

Save a copy of the completed SQTF Excel file with “_For_Import” added to the end of the file name.  

Ensure that the new file is saved in a suitable location, so that it can be uploaded into ACER Maple 
(instructions are provided in section 9.4). 

9.4 Updating Data from Tracking Forms in ACER Maple 

Once the updated data in a tracking form has been checked and corrected, the data needs to be 
updated in ACER Maple. 
  

 

A data administrator login must be used for the following function. 

To update data from tracking forms after the assessment: 
1. On the main screen select Update tracking data > Field operation forms and then click Activate. 

The Update field operation forms screen will appear (Figure 82). 

 
Figure 82: Update field operation forms screen 

2. In the Available Templates drop-down list select the relevant tracking form template.  
If you are updating the STF data: 
 Kenya and Zambia NC select STF_ENG; 
 All other countries select STF_FRE. 
If you are updating the SQTF data, the SQTF template is selected by default. 
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The SQTF data can only be updated when the status of ALL schools in your domain is known 

 

3. In the Selected Template Preview a preview of the selected template will appear. Make sure this 
is the required template. 

4. Click Browse… and manually enter or navigate to the location of the completed STF or SQTF Excel 
file to be imported. The Excel file will be uploaded into ACER Maple and its file name will appear 
in a tab beside the Browse… button (Figure 83). 

 
Figure 83: Updated tracking form Excel file uploaded into ACER Maple 

5. In the Uploaded File Preview a preview of the uploaded file will appear (Figure 84). Only the first 
15 rows of data will be displayed. The total number of rows and columns in the uploaded file will 
be displayed beneath the preview. 

 
Figure 84: Uploaded File Preview for a student tracking form 

6. Click Import if the preview looks as expected. ACER Maple then performs a number of validity 
checks on the data in the selected Excel file.  
The possible outcomes and required actions are described in Table 39. 
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Table 39: Scenarios when updating field data 

Outcome  Next steps 

• Tracking data has been validated and is ready 
to be updated in the ACER Maple database. 

• Message: ‘Data have been validated. No 
errors. No warnings. Please click Continue.’ 

1. Click Continue. 
2. Another pop-up message will appear which 

shows the number of records updated. Click 
Dismiss. 

3. Update data in ACER Maple from another 
tracking form. 
OR 
Click Back to return to the main screen. 

• Tracking data contains some discrepancies 
that prevent the data from being imported 
(errors). 

• Pop-up message appears warning that there 
are discrepancies, the data cannot be 
imported, and prompts you to save or 
download the report 

• The Update Field Data Validity Report is 
available for download. 

1. Click Download Validity Report, save the file in 
an appropriate location. Click Cancel to dismiss 
the pop-up message. 

2. Manually enter or navigate to the location of 
the saved report and open it.  

3. Refer to section 9.5 to check the records that 
appear in the report. 

4. Make the required corrections in the Excel file 
and attempt to update the tracking form data 
again. 

• Tracking data contains some discrepancies 
that should be checked before importing it. 

• Pop-up message appears warning that there 
are discrepancies but the data can be 
imported, and prompts you to download the 
report. 

• The Update Field Data Validity Report is 
available for download. 

1. Click Download Validity Report, save the file in 
an appropriate location and open it.  

2. Refer to section 9.5 to check the records that 
appear in the report. 

3. If any corrections are required, make them in 
the tracking form and attempt to update the 
tracking form data again. 

4. If corrections are not required, click Continue to 
import the data. Another pop-up message will 
appear listing the number of records that have 
been imported. Click Dismiss. 

5. Remaining warnings must be explained in the 
validity report Excel file and included in the 
data submission package, as described in 
chapter 11. 
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9.5 Update Field Data Validity Report 

If you attempt to update tracking data that contains discrepancies, ACER Maple will produce an Update 
Field Data Validity Report (in Excel format) that contains information about these issues.  
  

 
The Update Field Data Validity Report can contain multiple worksheets. Make sure you 
have checked the records in all worksheets in the report. 

9.5.1 Discrepancies that can be detected in the STF data 

Table 40 (page 123) and Table 41 (page 125) give detailed information about the types of discrepancies 
that may be listed in the Update Field Data Validity Report for STF data, as well as steps to resolve 
them:  
• error worksheets list incorrect records that need to be corrected before the data can be 

successfully updated in ACER Maple;  
• warning worksheets list suspicious records that need to be verified and either corrected or 

explained. Note that <STF> in the worksheet name will be replaced with the acronym of the 
template that you are using (STF_ENG or STF_FRE). 

After all corrections have been made, save the file and attempt to update STF data in ACER Maple 
again. 
  

 

There may be multiple versions of the Update Field Data Validity Report. 
It is possible that after corrections have been made, some errors or warnings still remain. 
In this case, when you try to update the student tracking form data in ACER Maple, the 
validity report will be produced again. 
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Table 40: Update Field Data Validity Report for student tracking forms: Error worksheets – possible errors and their resolutions   

Description Error message in report How to resolve Action required in student tracking form Excel file 

<STF> key violations worksheet 

Duplicate Student ID(s). [Student ID] is found in rows <Row1>, 
<Row 2> 

• Check against tracking 
form populated by ACER 
Maple before the 
assessment. 

• Correct the incorrect Student ID. 

Empty Student ID(s). [Student ID]cannot be empty • Fill empty cell  

First digit in Student ID is incorrect. First digit in [Student ID] is incorrect N/A • Change first digit to ‘1’. 

Digit 2 in Student ID are incorrect. [Student ID] contains wrong entity 
identification  

• Change digit 2 to your country AMPL  
code15. 

Non-existent Student ID. Data for [Student ID] does not exist in 
the software 

• Check against tracking 
form populated from 
ACER Maple before the 
assessment. 

• Correct Student ID. 

Digits 3-6 in Student ID are incorrect. Data for AMPL school number does not 
exist 

Combination of Student ID and Line No. 
does not exist in the data in ACER Maple. 

Data for combination of [Student ID] 
and Line No. has not been imported 

• Correct Student ID and/or Line No. as 
required 

Record with combination of Student ID 
and Line No. has not been sampled by 
ACER Maple. 

Data for combination of [Student ID] 
and Line No. has not been sampled 

<STF> missing records worksheet 

The record of a sampled student is 
missing from the <STF>. 

Record with [Student ID] and Line No. 
has been sampled but are not in the 
<STF> 

• Check against tracking 
form populated from 
ACER Maple before the 
assessment. 

1. Add missing record. 
2. Clarify student’s participation status with Test 

Administrator. 

 

 
 
 
15 The country codes in the student ID are: ‘1’ -; ‘2’-; ‘3’-; ‘4’-; ‘5’-l; ‘6’-. 
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Description Error message in report How to resolve 
Action required in student tracking form Excel 
file 

Incorrect columns worksheet 

Excel file is missing one or more columns. 
OR 
Excel file has one or more extra columns. 
OR 
Excel file has one or more columns with 
incorrect names. 
OR 
Excel file corresponds to a different 
template. 

Incorrect columns: Missing – <Column 
Name>, Extra – <Column Name> 

• Check that you are 
selecting the correct Excel 
file to import and the 
correct template in ACER 
Maple. 

OTHERWISE 
• Carefully check all 

adaptations you made in 
the template of the Excel 
file and in ACER Maple 
when you modified the 
corresponding ACER 
Maple template. 

• Add missing columns or modify 
template in ACER Maple as required. 

OR 
• Delete extra columns or modify 

template in ACER Maple as required. 
OR 

• Correct column names or modify 
template in ACER Maple as required. 

OR 
• Select correct Excel file to import or 

select correct template in ACER 
Maple. 

Validation rules worksheet 

One or more records contain one or more 
values that violate variable validation 
rules. 

Description of validation rule 
violation(s) 

• Check specified values 
against tracking form 
codebook for specified 
rows in Excel file. 

• Correct invalid values. 

SEN vs "Participation" 

Participation code is ‘3’ indicating that 
student was excluded on SEN basis, but 
SEN code is ‘0’ (no special education 
needs) 

[SEN] must be greater than 0 if 
[Participation] is 3 

• Contact School Coordinator 
and/or Test Administrators 
to enquire about student 
SEN and participation 
status 

• Correct either the SEN code or the 
Participation code whichever is 
incorrect 



Chapter 9: Receipt of Materials after the Assessment AMPL DMM 

ACER © 2023 Commercial in Confidence Page 125 of 197 

Description Error message in report How to resolve 
Action required in student tracking form Excel 
file 

Participation discrepancies 

Participation code is ‘1’ indicating that 
the student participated in assessment, 
but all attendance codes are ‘0’ indicating 
that the student has not attended any of 
the instruments 

Candidate must attend at least one 
instrument to be marked as 
participating (Sampling level:0). 

• Contact Test Administrators 
to enquire about student 
attendance and 
participation status. 

• Check paper instruments 
for attendance code 

• Correct either the participation or 
attendance code whichever is incorrect 

Participation code is not ‘1’ indicating 
that the student did not participate in 
assessment, but one or more of the 
attendance codes are ‘1’ indicating that 
the student has attended one or more of 
of the instruments 

Candidate must be participating to 
attend the [MT] or [Q] or [NRA] 
(Sampling level:0). 

• Contact Test Administrators 
to enquire about student 
attendance and 
participation status. 

• Check paper instruments 
for attendance code 

• Correct either the participation or 
attendance code whichever is incorrect 

 

Table 41: Update Field Data Validity Report for student tracking forms: Warning worksheets – possible warnings and their resolutions 

Description Warning message in report How to resolve Action required in student tracking form Excel file 

<STF> missing value(s) worksheet 

There are one or more missing values or 
empty cells for a specific column. 

Missing value(s) in <Column Name> 1. Check the values in that 
column in the Excel file. 

2. Contact the school to get 
the information. 

• Update the <STF>. 

SEN > 4. Is this SEN agreed? 1. Check the values in that 
column in the Excel file. 

2. If it is greater than 4, 
Contact School Coordinator 
to enquire about SEN of 
the student 

• Correct the SEN value if the value is not 
agreed with ACER. 
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9.5.2 Errors in updated School Questionnaire Tracking Form data 

Table 42 (page 127) gives detailed information about the types of discrepancies that may be listed in 
the Update Field Data Validity Report for SQTF data, as well as steps to resolve them. 

After all corrections have been made, save the file and attempt to update SQTF data in ACER Maple 
again. 
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Table 42: Update Field Data Validity Report for School Questionnaire Tracking Form: Error worksheets – possible errors and their resolutions 

Description Error message in report How to resolve 
Action required in School Questionnaire Tracking 
Form Excel file 

SQTF key violations worksheet 

Duplicate School Principal ID(s). [School Principal ID] is found in rows 
<Row1>, <Row 2> 

• Check against pre-
populated tracking 
form despatched with 
ACER Maple 

• Correct the incorrect School Principal ID. 

Empty School Principal ID(s). [School Principal ID] cannot be empty • Fill empty cell. 

First digit in School Principal ID is 
incorrect. 

First digit in [School Principal ID] is 
incorrect 

N/A • Change first digit to ‘2’. 

Digits 2-4 in School Principal ID are 
incorrect. 

[School Principal ID] contains wrong 
entity identification  

• Change digits 2-4 to your country 3-digit 
code. 

Non-existent School Principal ID. Data for [School Principal ID] does not 
exist in the software 

• Check against pre-
populated tracking 
form despatched with 
ACER Maple 

• Correct School Principal ID. 

Digits 5-8 in School Principal ID are 
incorrect. 

Data for AMPL school number does not 
exist 

Combination of School Principal ID and 
Line No. does not exist in the data in 
ACER Maple. 

Data for combination of [School 
Principal ID] and Line No. has not been 
imported 

• Correct School Principal ID and or Line No. 
as required. 

Record with combination of School 
Principal ID and Line No has not been 
sampled by ACER Maple. 

Data for combination of [School 
Principal ID] and Line No. has not been 
sampled 

Digits 9-11 in School Principal ID are 
incorrect. 

[School Principal ID] has incorrect part 
for the record 

• Correct School Principal ID. 

SQTF missing records worksheet 

The record of principal is missing from the 
SQTF. 

Record with [School Principal ID] and 
Line No. has been sampled but are not 
in the SQTF 

• Check against pre-
populated tracking 
form despatched with 
ACER Maple 

1. Add missing record. 
2. Clarify principal’s participation status with the 

Test Administrator. 
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Description Error message in report How to resolve 
Action required in School Questionnaire Tracking 
Form Excel file 

Incorrect columns worksheet 

Excel file is missing one or more columns. 
OR 
Excel file has one or more extra columns. 
OR 
Excel file has one or more columns with 
incorrect names. 
OR 
Excel file corresponds to a different 
template. 

Incorrect columns: Missing – <Column 
Name>, Extra – <Column Name> 

• Check that you are 
selecting the correct 
Excel file to import 
and the correct 
template in ACER 
Maple. 

OTHERWISE 
• Carefully check all 

adaptations you 
made in the template 
of the Excel file and in 
ACER Maple when 
you modified the 
corresponding ACER 
Maple template. 

• Add missing columns or modify the 
template in ACER Maple as required. 

OR 
• Delete extra columns or modify the 

template in ACER Maple as required. 
OR 

• Correct column names or modify the 
template in ACER Maple as required. 

OR 
• Select the correct Excel file to import or 

select the correct template in ACER 
Maple. 

Validation rules worksheet 

One or more records contain one or more 
values that violate variable validation 
rules. 

Description of validation rule 
violation(s) 

• Check the specified 
values against the 
tracking form 
codebook for the 
specified rows in the 
TTF Excel file. 

• Correct any invalid values. 
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9.6 Updating School Participation 

9.6.1 Preparing data in the School Participation Form 

School participation status should have been tracked by your NC using either the School Participation 
Form exported from ACER Maple (section 3.2) or in another school file, where all other information 
about selected schools is saved.  

Once the participation status of all sampled and replacement schools has been confirmed, the 
sampling process completed, students assessed, and all tracking forms have been updated after the 
assessment, you will need to check the file where school participation status has been tracked to 
ensure that: 
•  all schools from the LSS are listed; and 
• each school has the appropriate code according to its participation status (Table 43). 

If participation codes have been entered into another file, you will need to export the School 
Participation Form from ACER Maple (section 3.2), then transfer the codes and comments into the 
School Participation Form.  

The complete School Participation Form data must then be updated in ACER Maple (instructions in 
section 9.6.2). 

Table 43: School Participation Codes for the  AMPL  

Code Code meaning 

1 Participant  

2 Refusal  

3 Non-participation for other reasons (please specify, e.g. school fire or flood, teacher strike, conflict 
zone)  

4 No eligible students  

5 School closed (permanently)  

7 Replacement school not contacted  

9 School exclusion (specify type and number of eligible students)  

11 School ineligible for other reasons (please specify)  
  

 
A school participation code is required for each school. 

  

 
Add an explanation in the ‘Comment’ column if required. You must provide an explanation 
in the ‘Comment’ column for codes ‘3’, ‘9’ and ‘11’. All other codes do not require 
comments unless you feel that it is necessary. 

  

 
The length of a comment is restricted to 500 characters. If more space is required please 
include your comment in the Sampling Data Submission Checklist together with the AMPL 
School Number. 
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9.6.2 Updating school participation in ACER Maple 

 
Do not import the School Participation Form data until the participation status for all 
schools has been updated. 

  

 
The data manager login must be used for the following function. 

To update school participation in ACER Maple: 
1. On the main screen select Update tracking data > Institution participation form and then click 

Activate. The Update institution participation form screen will appear (Figure 85). 

 
Figure 85: Update institution participation form screen 

2. Click Browse… and manually enter or navigate to the location of the completed School 
Participation Form Excel file to be imported. The Excel file will be uploaded into ACER Maple and 
its file name will appear in a tab beside the Browse… button (Figure 86). 

 
Figure 86: Updated SPF Excel file uploaded into ACER Maple 
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3. In the Uploaded File Preview a preview of the uploaded file will appear (Figure 87). Only the first 
15 rows of data will be displayed. The total number of rows and columns in the uploaded file will 
be displayed beneath the preview  

 
Figure 87: Uploaded File Preview for a school participation form 

4. Click Import if the preview looks as expected. An alert will appear asking if you have backed up 
your data: 
 if the data has been backed up recently, click Yes;  

OTHERWISE 

 click No and back up the data (section Error! Reference source not found.). 
5. ACER Maple then performs a number of validity checks on the data in the School Participation 

Form Excel file. The possible outcomes and required actions are described in Table 44. 
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Table 44: Scenarios when updating school participation data 

Outcome  Next steps 

• School participation data has been 
validated and is ready to be updated in the 
ACER Maple database. 

• Message: ‘Data have been validated. No 
errors. No warnings. Please click Continue’ 

1. Click Continue. 
2. Another pop-up message will appear listing the 

number of records updated. Click Dismiss. 
3. Proceed to Chapter 11. 

• School participation data contains some 
discrepancies that prevent the data from 
being imported (errors). 

• Message: ‘Data contains errors and cannot 
be imported into the ACER Maple 
database.’ 

• Pop-up message prompts you to download 
the report. 

• The Update Institution Participation 
Validity Report is available for download. 

1. Click Download Validity Report, save the file in an 
appropriate location. Click Cancel to dismiss the 
pop-up message. 

2. Manually enter or navigate to the location of the 
saved report and open it.  

3. Refer to section 9.7 to check the records that 
appear in the report. 

4. Make the required corrections in the Excel file 
and attempt to update school participation form 
again. 

• School participation data contains some 
discrepancies that should be checked 
before importing (warnings). 

• Message: ‘Data contains discrepancies but 
can be imported if corrections are not 
required.’ 

• The Update Institution Participation 
Validity Report is available for download. 

1. Click Download Validity Report, save the file in an 
appropriate location and open it. 

2. Refer to section 9.7 to check the records that 
appear in the report. 

3. If any corrections are required, make them in the 
School Participation Form and attempt to update 
the school participation data again. 

4. If corrections are not required, click Continue to 
import the data. Another pop-up message will 
appear listing the number of records that have 
been imported. Click Dismiss. 

5. Remaining warnings must be explained in the 
validity report Excel file and included in the data 
submission package, as described in chapter 11. 

 

9.7 Update Institution Participation Validity Report 

The validity report produced by ACER Maple will be named 
Update_Institution_Participation_Validity_Report (<Date and Time>).xlsx, where <Date and Time> has 
<yyyy_mm_dd_hour_min> format. Save the file in an appropriate location and open it to review the 
error/warning messages. Each row in the report represents a discrepancy. Some of the discrepancies 
can be connected to other discrepancies listed in the excel file. 

Table 45 (page 134) and Table 46 (page 136) give detailed information about the types of discrepancies 
that may be listed in the Update Institution Participation Validity Report, as well as steps to resolve 
them. 
• Error worksheets list incorrect records that need to be corrected before the data can be 

successfully updated in ACER Maple. 
• Warning worksheets list suspicious records that need to be verified and either corrected or 

explained.  
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There may be multiple versions of the Update Institution Participation Validity Report . 
It is possible that after corrections have been made, some errors or warnings still remain. 
In this case, when you try to update the School Participation Form data in ACER Maple, the 
validity report will be produced again. 

Corrections may need to be made in participants’ tracking information, in the assessment data entered 
in ACER Maple, or in the School Participation Form (SPF). After all corrections have been made, attempt 
to import School Participation Form again.  

Please note that as long as errors exist in the Update Institution Participation Validity Report, you will 
not be able to update school participation. Successful completion of this task is one of the 
requirements for enabling the Submit data function, which is needed for the final task of submitting 
the database to ACER. 

If all errors have been resolved and the Update Institution Participation Validity Report contains only 
warnings (i.e. records that do not need to be corrected), school participation can be successfully 
updated (see Table 44). The validity report Excel file must be saved and all warnings listed in the file 
must be explained in the report as described in Table 44. This file will be required as part of the data 
submission to ACER (see section 11.4). 
  

 
It is possible that the Update Institution Participation Validity Report will not be produced 
by ACER Maple. This would happen if there were no discrepancies found in the data when 
updating the School Participation Form. In this case, there will be no warnings requiring 
explanation, and the report will not be required for data submission. 
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Table 45: Update Institution Participation Validity Report: Error worksheets – possible errors and their resolutions   

Description Error message in report How to resolve Action required 

Incorrect columns worksheet 

Excel file is missing one or more columns. 
OR 
Excel file has one or more extra columns. 
OR 
Excel file has one or more columns with 
incorrect names. 
OR 
Excel file corresponds to a different 
template. 

Incorrect columns:  
Missing – <Column Name>, 
Extra – <Column Name> 

• Check that you are selecting 
the correct SPF Excel file to 
import and the correct 
template in ACER Maple. 

OTHERWISE 
• Carefully check all 

adaptations you made in the 
template of the SPF Excel file 
and in ACER Maple when you 
modified the corresponding 
ACER Maple template. 

• Select the correct SPF Excel file to import 
or select the correct template in ACER 
Maple. 

OR 
• Add all missing columns or modify the 

template in ACER Maple as required. 
OR 

• Delete all extra columns or modify the 
template in ACER Maple as required. 

OR 
• Correct all column names or modify the 

template in ACER Maple as required. 

Key violations worksheet 

There are one or more illegitimate AMPL 
School Numbers. 

[AMPL School No.] is 
illegitimate 

• Check the LSS – only AMPL 
School Numbers provided in 
the LSS are legitimate. 

• Correct all AMPL School Numbers in the 
SPF Excel file. 

There are one or more empty cells for 
AMPL School Number. 

[AMPL School No.] is missing 1. Check the AMPL School 
Number(s) in the SPF Excel file. 

2. Check the LSS. 

• Add all correct AMPL School Numbers to 
the SPF Excel file. 

There are one or more duplicate AMPL 
School Numbers. 

[AMPL School No.] <#>is 
found in rows <row1, row2,..> 

• Correct all AMPL School Numbers in the 
SPF Excel file. 

Incomplete records worksheet 

Some AMPL School Numbers from the LSS 
are missing. 

All schools should be updated 
together 

1. Check the AMPL School 
Number(s) in the SPF Excel file. 

2. Check the LSS. 

• Add all correct AMPL School Numbers to 
the SPF Excel file. 
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Description Error message in report How to resolve Action required 

Validation rules worksheet 

One or more records contain one or more 
values that violate variable validation 
rules. 

Description of validation rule 
violation(s) 

• Check the specified values in 
the SPF Excel file against the 
School Participation Form 
codebook. 

• Correct all invalid values in the SPF Excel 
file. 

SPF worksheet 

School participation code was entered 
incorrectly. 
OR  
List of Students were not imported for all 
schools. 

AMPL School No participating 
but no records were imported 
for sampling 

1. Check the school participation 
code in the SPF Excel file. 

2. Find out why the List of Students 
has not been imported. 

• Correct the school participation code in the 
SPF Excel file. 

OR 
• Proceed with sampling and assessment in 

the school. 

School participation code is entered 
incorrectly. 
OR  
Students were not sampled in all schools. 

AMPL School No participating 
but no records were sampled 

1. Check the school participation 
code in the SPF Excel file. 

2. Find out why the students were 
not sampled. 

School participation code is entered 
incorrectly. 
OR  
Tracking forms were not updated for all 
schools. 

AMPL School No participating 
but no records were identified 
as participating on the field 
operation form 

1. Check the school participation 
code in the SPF Excel file. 

2. Check whether the tracking form 
was updated in ACER Maple. 

• Correct the school participation code in 
the SPF Excel file. 

OR 
• Update the tracking form for the school in 

ACER Maple. 

School participation code is ‘3’, ‘9’ or ‘11’, 
but the reason for the code has not been 
specified in the ‘Comments’ column. 

Codes 3, 9, and 11 require 
specifications in Comment 
column. 

Check the school participation code in 
the SPF Excel file. 

• Correct the school participation code in 
the SPF Excel file. 

OR 
• Specify the reason for the code. 
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Table 46: Update Institution Participation Validity Report: Warning worksheets – possible warnings and their resolutions 

Description Warning message in report How to resolve Action required in School Participation Form Excel file 

SPF vs field operation forms worksheet 

School participation code is 
entered incorrectly. 
OR  
Tracking form has incorrect test 
participation codes. 
OR 
There is a reason for this 
discrepancy. 

AMPL School No is not participating 
but some records were identified as 
participating on the field operation 
form 

1. Check the school participation 
code in the SPF Excel file. 

2. Check the tracking form Excel 
file for the school. 

• Correct the school participation code in the 
SPF Excel file. 

OR 
• Correct the tracking form Excel file for the 

school and update it again in ACER Maple.  

SPF replacement worksheet 

School participation code is 
entered incorrectly. 
OR 
There is a reason for this 
discrepancy. 

Main and first replacement school 
both participating 

• Check the school 
participation code in the SPF 
Excel file. 

• Correct the school participation code in the 
SPF Excel file. 

OR 
• Specify the reason for having main and 

corresponding replacement school 
participating at the same time in the 
assessment for each line in the report Excel 
file.  

THEN 
• Contact Clare Ozolins at 

Clare.Ozolins@acer.org, explaining what 
happened. 

Main and second replacement school 
both participating 

First replacement and second 
replacement school both participating 

 

mailto:Clare.Ozolins@acer.org
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10.1 Data Entry Organisation 

Before responses in the survey instruments can be entered into ACER Maple, the process of data entry needs 
to be carefully planned and organised. NCs need to formulate a data entry plan for each domain (i.e. each 
Admin ID) within their national context, to ensure they will have sufficient staff and equipment for their data 
entry requirements. NC planning depends on the test design(s) that had been implemented by it. 

Once the appropriate number of data entry operators (DEOs) for each administrative unit has been decided 
upon, and employed appropriately, they need to undergo training before they can begin entering the data 
received from schools. 

10.1.1 Data entry planning 

Of all the survey instruments, the Student Questionnaire involves the most data being entered, because 
every student is expected to complete it. The School Questionnaire involves the least data being entered, as 
there will only be one completed per school. See Table 47 for the expected number of records and responses 
that could be entered for each survey instrument. 
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Table 47: Expected records and responses in survey instruments 

Instrument Max. number of records 
per instrument 

Number of responses per 
person 

Data entry days per 
instrument per NC 

AMPLb Test Booklets (1-2) 2500 each 60 6-8 

AMPLa Test Booklets (3-4) 2500 each 75 9-10 

AMPLab Test Booklets (3-8) 840 each 75 4-5 

Student Questionnaire  5000 25  5-6 

School Questionnaire 150 20 1-2 hours 

Once they are well-practiced in data entry for their allocated instrument(s), a DEO with a good keystroke will 
take about one second per response. Allowing for an initial slower period at the beginning of data entry, and 
accounting for page turning and various other interruptions, responses from AMPL Test Booklets 1 and 2 will 
take 6-8 working days for one person to enter. The time required for other instruments is estimated in the 
same way. 

As stated in section 1.3: 
• One data manager is responsible for all data management operations in the NC. 
• Four to five data administrators assist the data manager with school-by-school operations. Each DA is 

responsible for a different domain (i.e. Admin ID). 

Therefore, 
• Two DEOs can work under the instruction of each data administrator if the test design a or b is selected 

by the NC 
• Up to four DEOs can work under the instruction of each data administrator if the test design a+b is 

selected by the NC.  

Therefore, each data administrator is responsible for managing the data entry for 1/4 or 1/5 of all 
respondents. So it will take about 2 days for a single DEO to enter the responses from AMPL Test Booklet 1 
(or AMPL Test Booklet 2) in each domain, but it will take about 4-5 days for a single DEO to enter the 
responses from AMPL Student Questionnaire (a or b).  

The data manager will need to figure out how many personnel will be required to enter the data from all 
assessment instruments, and what equipment is available for this purpose. To aid these decisions, and to 
better manage the data entry process overall, a data entry plan should be created. Two examples of how 
this can be done are provided below. 

In the NCs that opted for design b, the data manager might elect to have two data entry operators per domain 
and to divide data entry tasks between them, as shown in Table 48. This plan will require 8-10 DEOs in total, 
and data entry would be finished in 3-5 days, assuming the maximum number of records in each instrument. 

Table 48: Example of the data entry plan for design b with two data entry operators per domain 

Instrument Admin ID 

 01 02 …… 

AMPL Test Booklet 1 & 2  DEO1a DEO2a …… 

Questionnaires (STQ &SCQ)  DEO1b DEO2b …… 
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In the NCs that opted for design a+b, the data manager might elect to have four data entry operators per 
domain and to divide data entry tasks between them, as shown in Table 49. This plan will require 16-20 DEOs 
in total, and data entry would be finished in approximately the same time, assuming the maximum number 
of records in each instrument. 

Table 49: Example of the data entry plan for AMPLab with four data entry operators per domain 

Instrument Admin ID 

 01 02 …… 

AMPL Test Booklet 3 &4 DEO1a DEO2a …… 

AMPL Test Booklet 5&6 DEO1b DEO2b …… 

AMPL Test Booklet 7&8 + School Questionnaire DEO1c DEO2c …… 

Student Questionnaire DEO1d DEO2d …… 
 

The data manager and data administrator will also need to ensure that sufficient equipment is available for 
data entry. Each DEO will need a PC to enter data into ACER Maple, but the same PC can be used for more 
than one DEO if they are working in shifts. 
  

 
The data manager and the data administrator can perform data entry tasks if necessary, 
but they will need separate DEO logins in ACER Maple to do so. 

 

10.1.2 Training 

The data manager will need to train all data entry operators (DEOs) before data entry in how to use ACER 
Maple. For the purposes of training DEOs, data managers are advised to adapt the Data Management 
Training Presentation Part 2 and other training materials provided by ACER16. However, not all topics included 
in this presentation will be required for DEO training. 

The topics that must be covered in the DEO training are: 
• ACER Maple login and navigation (chapter 2) 
• ACER Maple response formats and data entry rules (section 10.2.1) 
• Entering data into ACER Maple from paper-based instruments (section 10.2) 

Table 50 lists the data manager’s tasks in relation to DEO training and provides references to relevant 
sections and/or chapters of this document. 

 
 
 
16 MS teams>AMPL Partner Collaboration > Data Management Resources. 
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Table 50: Data manager tasks in relation to data entry operator training 

Preparation task Reference 

Ensure that training setup corresponds to the real working 
conditions of data entry operators. Section 4.3, Introduction, Chapters 1 and 2 

Prepare ACER Maple with updated STF data for students in schools 
in stratum 99, as described in the data administrator training 

Chapters 4 and 9 

Download Data Management Training Presentation Part 2 provided 
by ACER. 

MS Teams>AMPL Partner 
Collaboration>Data Management Resources 

Prepare paper-based instruments for training with fake data for 
students in schools in stratum 99 

Prepare paper-based instruments for 
training section (page 141) 

 

For the purposes of DEO training, a number of fictitious ‘schools’ have been included in the LSS and can be 
used to test the ACER Maple data entry procedures before any real data is available. These ‘schools’ are 
found in stratum 99 of the LSS, for every value of Admin ID. As outlined in the data administrator training 
chapter (chapter 4): 
• Training List of Students (LST) data should be prepared for schools from stratum 99; 
• The training LST data should be imported; 
• Students from schools in stratum 99 should be sampled, and instruments allocated; 
• STF templates should be populated with sampling data from schools in stratum 99; 
• Populated STF templates should be “completed” with error-free participation data then used to update 

STF in ACER Maple. 

In addition to these data administrator training tasks, the data manager or data administrator will need to 
do the following in preparation for DEO training: 
• Prepare paper-based instruments for training with ‘fake’ responses for students/schools in stratum 99, 

according to the instrument allocated to them in the STF, and the participation data that was used to 
update the corresponding STFs in ACER Maple; 

• DEO logins are added by the data administrator in ACER Maple; 
• Data administrators need to ensure that the appropriate instrument(s) are allocated to each DEO for data 

entry training (according to the data entry plan); 
• Data from the training paper-based instruments should be entered by DEOs. 

Training Setup 

DEO training should be set up to correspond to the real working conditions of DEOs as much as possible. To 
achieve this you should make sure that: 
6. All DEOs attend the training. 

7. The required computing equipment is ready:  
 ACER Maple is installed in a LAN environment as described in Chapter 2 with one of PCs for each 

DEO plus one host PC; 
 each PC meets the system requirements and PC setup (sections 2.2 and 2.3); and 
 DEO logins are created for each DEO as explained in section 10.1.3. 

8. Paper-based instruments for training (containing ‘fake’ responses for students/schools in stratum 99) 
are provided to DEOs. 
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9. Audio-visual equipment is ready to use. Some examples of this equipment might include: 

 a projector for viewing the Data Management Training Presentation Part 2, ensuring that the screen 
is visible from every DEO workstation; or  

 a second monitor for each DEO, so that they can watch the Data Management Training Presentation 
Part 2 on one monitor and complete the training exercises using another monitor. 

Prepare paper-based instruments for training 

The data manager will need to provide enough copies of the following instruments to each DEO participating 
in the training: 
• AMPL Test Booklet 1 or AMPL Test Booklet 2; 
• AMPL Student Questionnaire; 
• National or Regional Assessment Booklet; and 
• AMPL School Questionnaire 

Each DEO should receive at least two copies of the instrument(s) for which they will be entering real data 
when it is received from schools, according to the data entry plan (section 10.1.1). Both copies will be filled 
with ‘fake’ responses that each DEO will use to practice entering data. One copy will be error-free, and 
another copy will contain errors (such as invalid responses) that the data entry operator will need to correct 
for during data entry. 

On the front cover of the student level instruments (AMPL Test Booklets 1 and 2, AMPL Student 
Questionnaire, and National or Regional Assessment Booklet), the following information should be provided: 

School Name 
AMPL School No. 

Student ID 

The data manager should refer to the STFs prepared for training to ensure that the information listed on the 
front of each instrument is consistent with the information listed in the STF: 
• Student IDs used for AMPL Test Booklets 1 & 2 should be consistent with what was allocated in the STF; 
• Students should be marked as attending the appropriate instrument session on the STF. 

On the front cover of the School Questionnaire(s) the following information should be provided: 
School Name 

AMPL School No. 
Principal ID 

The data manager/administrator should ensure that the participation status of each school in stratum 99 
being used for training purposes has been updated accordingly in the Institution Participation Form (section 
9.6.2). 

Once the paper-based instruments have been prepared for training, DEO logins should be created and the 
appropriate instruments allocated to them for data entry training (section 10.1.3). 
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10.1.3 Manage Data Entry Operators in ACER Maple 

After the data entry plan has been finalised, the data entry equipment has been prepared, and data entry 
operators (DEOs) have been employed, ACER Maple logins need to be created for each DEO. The Manage 
Data Entry Operators function allows data administrators to add, search, edit or delete DEO logins, or to 
reset a DEO’s first time login code (FTLC). All of these functions can be accessed from the Manage Data Entry 
Operators screen. 

Accessing the Manage Data Entry Operators screen 
  

 

A data administrator login must be used for the following function. 

To access the Manage Data Entry Operators screen: 
1. On the main screen select User settings > Manage data entry operators and then click Activate. The 

Manage data entry operators screen will appear (Figure 88). 
From this screen you can Add a new record, or Search, Edit, Reset FTLC or Delete existing records. The 
instructions for these actions are provided in the corresponding sections on pages 142 to 149 

 
Figure 88: Manage data entry operators screen 

Add new record 
  

 

A data administrator login must be used for the following function. 

To create ACER Maple logins for each data entry operator: 
1. Follow the instructions on page 142 to access the Manage Data Entry Operators screen. 
2. Ensure that the New tab is highlighted on the left-hand side of the screen.  
3. Click Add a new record. A pop-up window will appear (Figure 89). 
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Figure 89: Add new data entry operator details 

4. Enter the user name and affiliation for the DEO login being added (Figure 90). 

 
Figure 90: New DEO user name and affiliation 

  

 
Each data entry operator login must be assigned a unique ‘User name’. 

5. In the Instruments assigned box, allocate at least one instrument to the DEO login being added, by 
selecting the appropriate tick box(es) (Figure 91). If an instrument is already listed as “[used]” it cannot 
be allocated again to a different DEO in the same domain. 
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Figure 91: Allocate instrument(s) to DEO 

6. Click Save & Next. ACER Maple then performs a number of validity checks on the information that has 
been entered.  

The possible outcomes and required actions are described in Table 51. 
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Table 51: Possible outcomes when adding a new DEO login  

Outcome  Next steps 

• All fields are entered and ACER 
Maple found no discrepancies 

• A pop-up window appears listing 
the number of records created. It 
will automatically disappear after 
a few seconds 

• No further DEO logins are required 

1. Click Cancel. The Manage Data Entry Operators screen will 
return. The new DEO credentials entered in steps 4 to 6 
will be listed in the middle of the screen, along with their 
First time login code (FTLC). 

2. Click Back to return to the main screen.  

• All fields are entered and ACER 
Maple found no discrepancies 

• A pop-up window appears listing 
the number of records created. It 
will automatically disappear after 
a few seconds 

• Another DEO login is required 

1. Repeat steps 4 to 6 to add another DEO login. 
2. After the information is entered, click Save & Next and 

follow the steps that correspond to the appropriate 
outcome described in this table. 

• There is an error in the data 
entered for the DEO. 

• A pop-up window appears 
describing the error that is 
preventing the data from being 
saved. It will automatically 
disappear after 10 seconds. It can 
also be closed manually by clicking 
‘X’ in the top right corner. 

1. Make the required corrections to the data. 
2. After the data is corrected, click Save & Next and follow 

the steps that correspond to the appropriate outcome 
described in this table.  

Search 

ACER Maple also includes a search function with the Manage Data Entry Operators function. 
  

 

A data administrator login must be used for the following function. 

To search the list of DEOs by user name, affiliation, or instrument assignment: 
1. Follow the instructions on page 142 to access the Manage Data Entry Operators screen. 
2. Ensure that the Search tab is highlighted on the left-hand side of the screen. 

3. Enter the information you wish to use to search the list of DEOs (Figure 92). If all search terms are 
blank, all DEO logins will be listed. 

• Enter a user name to locate a specific DEO; 

• Enter a user affiliation to see all DEOs with the same affiliation; and/or 

• Select one or more instruments within the instruments assigned box to see which DEOs have 
been assigned those instruments. 
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Figure 92: Search data entry operators 

4. Click the Search button at the bottom of the screen. All records matching the search terms that have 
been entered will be listed in the middle of the Manage Data Entry Operators screen (Figure 93).  

 
Figure 93: DEO search results 

If no records match the entered search terms, the message “No data available in table” will display in 
the centre of the screen. 

Edit 

This option allows data administrators to make changes to the user name, user affiliation, and/or 
instruments assigned to any DEO in ACER Maple. 
  

 

A data administrator login must be used for the following function. 
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To edit user name, affiliation, or instrument assignment: 
1. Follow the instructions on page 142 to access the Manage Data Entry Operators screen. 
2. Locate the entry of the DEO login with data that needs to be changed in the list in the middle of the 

screen. Use the Search function if necessary. 
3. Underneath the Action column heading, click Edit. A pop-up window will appear (Figure 94). 

 
Figure 94: Edit DEO details 

4. Make the required corrections to the data: 

• User name and affiliation can be updated by directly editing the text in those fields; 

• Instrument assigned can be updated by deselecting any instrument currently assigned and 
selecting another. More than one instrument can be selected, as long as it is not listed as 
“[used]”. 

5. Click Save. You will be returned to the Manage Data Entry Operators screen and ACER Maple will 
perform some validity checks of the entered data. The possible outcomes and required actions are 
described in Table 52. 
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Table 52: Possible outcomes when editing a DEO login  

Outcome  Next steps 

• All fields are updated and ACER 
Maple found no discrepancies 

• A pop-up window appears listing 
the number of records updated. It 
will automatically disappear after 
a few seconds 

• No other DEO logins need to be 
edited 

1. Click Back to return to the main screen. 

• All fields are updated and ACER 
Maple found no discrepancies 

• A pop-up window appears listing 
the number of records updated. It 
will automatically disappear after 
a few seconds 

• Another DEO login needs to be 
edited 

1. Repeat steps 2 to 5 to edit another DEO login. 
2. After the information is updated, click Save and follow the 

steps that correspond to the appropriate outcome 
described in this table. 

• There is an error in the data 
entered for the DEO. 

• A pop-up window appears 
describing the error that is 
preventing the data from being 
saved. It will automatically 
disappear after 10 seconds. It can 
also be closed manually by clicking 
‘X’ in the top right corner. 

1. Make the required corrections to the data. 
2. After the data is corrected, click Save and follow the steps 

that correspond to the appropriate outcome described in 
this table.  

Delete 
  

 

A data administrator login must be used for the following function. 

To delete a DEO credentials from ACER Maple: 
1. Follow the instructions on page 142 to access the Manage Data Entry Operators screen. 
2. Locate the entry of the DEO login with data that needs to be deleted in the list in the middle of the 

screen. Use the Search function if necessary. 
3. Underneath the Action column heading, click Delete. A pop-up window will appear listing the login that 

will be deleted, and a message asking if you want to continue. 
4. Click OK. Another pop-up window will appear listing the record that has been deleted. It will 

automatically disappear after a few seconds. The Manage Data Entry Operators screen will return. 
5. Repeat steps 2 to 4 for any other DEO logins that need to be deleted. 

Reset first time login code (FTLC) 

The reset FTLC option is used when a DEO has forgotten their password and needs to have it reset by their 
data administrator. 
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A data administrator login must be used for the following functions. 

To reset a DEO’s first time login code: 
1. Follow the instructions in the previous subsection (page 142) to access the Manage Data Entry 

Operators screen. 
2. Locate the entry of the DEO login with data that needs to be deleted in the list in the middle of the 

screen. Use the Search function if necessary. 
3. Underneath the Action column heading, click Reset FTLC. A pop-up window will appear warning that 

the FTLC for the selected record will be reset, that the previously set user password will become invalid, 
and a message asking if you want to continue. 

4. Click OK. Another pop-up window will appear listing the record that has been updated. It will 
automatically disappear after a few seconds. The Manage Data Entry Operators screen will return, with 
a new FLTC listed in the First time login code (FTLC) column of the DEO’s record in the middle of the 
screen. 

5. The new FTLC will need to be provided to the DEO. The will need to follow the instructions in section 
2.8.1 to complete the first time log in process again, using the new FTLC as the login code. 

10.2 Entering Responses into ACER Maple 

Once ACER Maple logins have been created for each DEO, and instruments allocated to each DEO, data entry 
can begin.  

10.2.1 Data entry rules 

Each instrument that has been processed for data entry has information on the cover page that needs to be 
entered in the corresponding record in ACER Maple: 
 School Name; 
 AMPL School Number; and 
 Participant ID 

There also must be at least one response provided by the participant inside the instrument. ALL responses 
must be entered. 

On the first few pages of each instrument, there are also instructions and examples that have been provided 
to help participants understand how to record their responses. These example responses should NOT be 
entered into ACER Maple. 

Units and items in AMPL questionnaires 

Each question in the paper-based questionnaire instruments correspond to a unit of one or more item(s). 
Items are questions or statements to which participants have to respond. Several items can be combined 
into one unit, or a unit may only contain one item. Within the AMPL questionnaires, units are numbered 
sequentially, and items within units are marked by letters. An example, unit 3, is provided in Figure 95. 



Chapter 10  Data EntryError! Reference source not found. AMPL DMM 

ACER © 2023 Commercial in Confidence Page 150 of 197 

 
Figure 95: Question 3 from AMPL Student Questionnaire 

Unit 3 consists of four items. The corresponding ACER Maple variable names (ST03a, ST03b, ST03c, and 
ST03d) are listed in light grey text on the side of the page. The items in Figure 95 are multiple choice (MC): 
they have several response options from which the participant selects one. Each response option has a 
corresponding response code next to it (i.e. 0, 1, 2, or 3 in Figure 95), which is what should be entered by the 
DEO into ACER Maple. 

Other items in the questionnaires have space provided for an open-ended response (i.e. no predefined 
codes). These items are called open-ended items (OE), such as items 5a and 5b in Figure 96. The responses 
provided by participants are entered directly by the DEO into ACER Maple. 

 
Figure 96: Question 5 from AMPL School Questionnaire 

Units and items in test booklets 

In AMPLb test booklets, each item is numbered sequentially throughout each booklet, and units are not 
numbered (see Figure 97). The corresponding ACER Maple variable names appear in grey text above the 
question number (i.e. PF487 and PF489 in Figure 97) or on the side. 

However, at the beginning of AMPLa and AMPLab booklets there is a number of item that are numbered 1-
5 within each section. These items will have an <x.y> numbering, where x is a section number and y is an item 
number within the section. For example, the second number in the first section will have a greyed out code 
1.2 (see [provide example from the test booklet]). 1.2 will be the screen label for this item. 
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Figure 97: Question 2 and 3 from AMPL Test Booklet 1 

Most of the items in the test booklets are multiple choice (MC). Each letter corresponds to a numeric code 
which is entered into ACER Maple, as follows: 
 A=1 

 B=2 
 C=3 
 D=4 
 E=5 

Some items in the test booklets are complex multiple choice (CMC) (Figure 98). In these cases several 
participant choices are treated together as one response. 

 
Figure 98: Example question 2 AMPL Test Booklet 1 

In the example in Figure 98, four responses are treated together as one response: 
 Each ‘Yes’ must be coded as ‘1’; 
 Each ‘No’ must be coded as ‘2’; 
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 Four numbers are entered into ACER Maple for the participant’s response e.g. 1212, or 1221, etc. 

Response options are usually coded in the order they appear on the page, when reading left to right, top to 
bottom. The first option is coded as 1, the second as 2 etc. For example, in another CMC item: 
 Each ‘Left’ must be coded as ‘1’; 
 Each ‘Right’ must be coded as ‘2’; 

 Four numbers are entered into ACER Maple for the participant’s response e.g. 121. 

Data entry screens 

An ACER Maple data entry screen is shown in Figure 99. 

 
Figure 99: ACER Maple data entry screen for School Questionnaire 

The large yellow field at the top of the screen displays information about the field currently selected for data 
entry, with the variable name, and variable type and validation rules (in brackets) listed on the left above the 
box. This information cannot be edited directly. 

The next three fields, listed under “Cover Page” and before “Questions”, are for entering required 
information from the cover page: 
 Booklet number; 
 School Name; 

 AMPL School Number; and  
 Principal (or Student) ID. 

The remaining fields, listed under “Questions” are for entering participant responses the test questions. 
Labels appear above each field and display either: 
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 A combination of the relevant unit number and item letter, if there is more than one item in the unit 
(e.g. 5a, 5b from the School Questionnaire, see Figure 96 and Figure 99); or 

 The unit number, if the unit only contains one item; or 
 The item number, if items are numbered sequentially (e.g. in test booklets) 

Variables in ACER Maple 

Each item in a paper-based instrument corresponds to a variable in ACER Maple.  

There are five main types of variables in ACER Maple that are used to enter responses from the  AMPL survey 
instruments. Every response field in ACER Maple must contain either a response code (if a valid response has 
been provided), or an auxiliary code (if a valid response has not been provided). 

There are three auxiliary codes which can be used when a valid response has not been provided: 
• Not administered (N/A): This code is used when the respondent was unable to provide a response to a 

question due to problems with the survey instruments, such as printing errors or omissions, faulty 
cutting, folding or stapling, or missing booklet pages, etc. Note that if there were problems with the 
survey instruments, they should be reported in the Item Information for Cleaning document (section 0) 
when you submit your data. 

• Invalid: This code is used when the respondent has provided an invalid response, such as circling or 
ticking two answers when they should only choose one, or including extraneous text that invalidates their 
response. 

• Missing: This code is used when the respondent has not provided a response at all. 

Table 53 lists the main ACER Maple variable types and their auxiliary codes. 

Table 53: ACER Maple variable types used for the AMPL 

Variable type Auxiliary codes 

 N/A Invalid Missing 

Open-ended (not coded) 9997 9998 9999 

Multiple Choice (with ≤6 choices) 7 8 9 

Multiple Choice (with >6 choices) 97 98 99 

Complex multiple choice (3 choices treated as one response) 997 998 999 

Complex multiple choice (4 choices treated as one response) 9997 9998 9999 
 

10.2.2 Accessing the Key in responses screen 
  

 

A data entry operator login must be used for the following function. 

To enter a new response data record, or to search for and edit an existing record, data entry operators need 
to access the Key in responses screen as follows: 
1. On the main screen select Response data> Key in responses and then click Activate. The Key in 

responses screen will appear (Figure 100). 



Chapter 10  Data EntryError! Reference source not found. AMPL DMM 

ACER © 2023 Commercial in Confidence Page 154 of 197 

From this screen you can: 

 Add a new record, under the New tab; or  
 Search, Edit, Reset or Delete existing records under the Existing tab.  
The instructions for these actions are provided in the corresponding sections 10.2.3-10.2.7. 

 
Figure 100: Key in responses screen 

10.2.3 Add a new record 
  

 

A data entry operator login must be used for the following function. 

To key in response data for a new record: 
1. Follow the instructions on page 153 to access the Key in responses screen. 
2. Ensure that the New tab is highlighted on the left-hand side of the screen. 
3. The following fields must be filled for each new record being added: 

• Pop Type: select students if entering data for AMPL test booklets or Student Questionnaire; or 
school principals if entering data for the School Questionnaire. 
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• Instrument: select the survey instrument for which you will be entering data from the drop-down 
list. 

• Data Entry Template: select the data entry template that corresponds to your selected survey 
instrument from the drop-down list. 

4. Click Add a new record. The data entry template for the selected instrument will appear in a pop-up 
window (Figure 101). 

• The large yellow field at the top of the screen displays information about the variable currently 
selected for data entry, with the variable name, and variable type and validation rules (in 
brackets) listed on the left above the box. Information about the first variable in the template is 
displayed by default. It cannot be edited directly. 

• On the right above the large yellow field, the data entry operator can choose whether pressing 
the arrow keys on a keyboard can be used to move between response data fields. This option is 
selected by default. ‘Tab’ and ‘Enter’ keys can always be used to move to the next response data 
field. 

• Cover page variables (e.g. School Name, AMPL School Number, Student/Principal ID) are listed 
under the large yellow field at the top of the screen.  
 Data entry operators can choose any combination of the listed cover page variables to be copied 

over to the next response data record, by checking the box next to the corresponding variable(s), 
listed in the Keep values for next drop-down list. This will save on time spent keying in this 
information for each record. 

 Any cover page variable that will be copied over to the next response data record will have a   
symbol appearing after the variable name. 

 
Figure 101: New data entry template 

5. Key in the required data into each field. 
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• Any fields containing data that violate validation rules will be highlighted in red. The record 
cannot be saved if any fields are red. 

6. When all data has been entered and there are no red fields, click Save & Next. 
7. A pop-up window will appear saying the data will be saved and asking if you want to continue. Click OK. 

ACER Maple then performs a number of validity checks on the data entered in the template. 

The possible outcomes and required actions are described in Table 54. 

Table 54: Possible outcomes when adding a new response data record in ACER Maple 

Outcome  Next steps 

• All fields are entered and ACER 
Maple found no discrepancies. 

• A pop-up window appears saying 
the record has been saved. It will 
automatically disappear after a 
few seconds. 

• All data fields are cleared for the 
next record to be keyed in. 

• The DEO does not intend to add 
any more records at this time. 

1. Click Cancel. A pop-up message will appear warning that 
the data will not be saved. 

2. Click OK. The Key in responses screen will return. 
3. Click Back to return to the main screen. 

• All fields are entered and ACER 
Maple found no discrepancies. 

• A pop-up window appears saying 
the record has been saved. It will 
automatically disappear after a 
few seconds. 

• All data fields are cleared for the 
next record to be keyed in. 

• The DEO needs to add another 
record. 

1. Repeat steps 5 to 7 to add another record. 
2. Follow the steps that correspond to the appropriate 

outcome described in this table. 

• There is an error in the data 
entered. 

• A pop-up window appears 
describing the error that is 
preventing the data from being 
saved. It will automatically 
disappear after 10 seconds. It can 
also be closed manually by clicking 
‘X’ in the top right corner. 

1. Make any required corrections before clicking Save & Next 
again. 

2. Follow the steps that correspond to the appropriate 
outcome described in this table.  

10.2.4 Search 

ACER Maple also includes a search function with the Key in responses function. 
  

 

A data entry operator login must be used for the following function. 
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To search the list of keyed in response data records by instrument, identifier (from cover page), the date the 
record was added to ACER Maple (Added date) or by DEO who added the record (Added by): 
1. Follow the instructions on page 153 to access the Key in responses screen. 
2. Ensure that the Existing tab is highlighted on the left-hand side of the screen. 
3. Enter the information you wish to use to search the list of keyed in response data records (Figure 102). 

If all search terms are left blank, all keyed in records will be listed. 

• Select from the drop-down Instrument list to see all records entered for that instrument. The total 
number of records entered for each instrument appears in brackets next to the instrument name. 

• Enter a value for one of the identifier variables from the instrument cover page (eg AMPL school 
number, student/principal ID) to see all records matching that value. 

• Enter an appropriate “from-to” date range to show all records entered with that date range. 

• Enter the DEOID of a data entry operator to show all records entered by that operator. 

 
Figure 102: Search keyed in data records 

4. Click Search. All records matching the search terms that have been entered will be listed in the middle 
of the Key in responses screen (Figure 103). If no records match the entered search terms, the message 
“No data available in table” will display in the centre of the screen. 
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Figure 103: Keyed in data record search results 

10.2.5 Edit 

This option allows data entry operators to make changes to an existing data record. 
  

 

A data entry operator login must be used for the following function. 

To edit keyed in response data for an existing record: 
1. Follow the instructions on page 153 to access the Key in responses screen. 
2. Use the Search function (page 156) to locate the data record that needs to be changed. It will be listed 

in the centre of the screen. 
3. Underneath the Action column heading, click Edit. The corresponding data entry template containing 

keyed in data will appear in a pop-up window (Figure 104). 
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Figure 104: Edit response data record 

4. Make the required corrections to the data by directly editing the text in any field in the Cover Page or 
Questions section of the template. 

• The large yellow field at the top of the screen displays information about the variable currently 
selected for data entry, with the variable name, and variable type and validation rules (in 
brackets) listed on the left above the box. Information about the first variable in the template is 
displayed by default. It cannot be edited directly. 

• Any fields containing data that violate validation rules will be highlighted in red. The record 
cannot be saved if any fields are red. 

5. When all data has been entered and there are no red fields, click Save. 

6. A pop-up window will appear saying the data will saved and asking if you want to continue. Click OK. 
ACER Maple then performs a number of validity checks on the data entered in the template.  

The possible outcomes and required actions are described in Table 55. 
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Table 55: Possible outcomes when editing a response data record in ACER Maple 

Outcome  Next steps 

• All fields are entered and ACER 
Maple found no discrepancies. 

• A pop-up window appears saying 
the record has been saved. It will 
automatically disappear after a 
few seconds. 

• The DEO does not need to edit any 
more records. 

1. Click Back to return to the main screen. 

• All fields are entered and ACER 
Maple found no discrepancies. 

• A pop-up window appears saying 
the record has been saved. It will 
automatically disappear after a 
few seconds. 

• The DEO needs to edit another 
record. 

1. Repeat steps 2 to 6 to edit another record. 
2. Follow the steps that correspond to the appropriate 

outcome described in this table. 

• There is an error in the data 
entered. 

• A pop-up window appears 
describing the error that is 
preventing the data from being 
saved. It will automatically 
disappear after 10 seconds. It can 
also be closed manually by clicking 
‘X’ in the top right corner. 

1. Make any required corrections before clicking Save again. 
2. Follow the steps that correspond to the appropriate 

outcome described in this table.  

10.2.6 Reset 

The reset function deletes all keyed in response data for a record, without deleting their cover page 
identifiers, so that an “empty” record is retain in the database. 
  

 

A data entry operator login must be used for the following function. 

To reset the keyed in data for an existing record: 
1. Follow the instructions on page 153 to access the Key in responses screen. 
2. Use the Search function (page 156) to locate the data record that needs to be changed. It will be listed 

in the centre of the screen. 
3. Underneath the Action column heading, click Reset. A pop-up message will appear warning that the 

response data for the specified record will be reset to empty (Figure 105). 
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Figure 105: Reset response data warning 

4. Click OK. Another pop-up message will appear saying the record has been updated. It will automatically 
disappear after a few seconds. 

5. To re-enter data for the reset record, click Edit (underneath the Action column heading), and follow the 
instructions on page 158 to edit the empty record (Figure 106) 

 
Figure 106: Response data record after being reset 

10.2.7 Delete 
  

 

A data entry operator login must be used for the following function. 

To delete an existing response data record from ACER Maple: 
1. Follow the instructions on page 153 to access the Key in responses screen. 
2. Use the Search function (page 156) to locate the data record that needs to be deleted. It will be listed 

in the centre of the screen. 
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3. Underneath the Action column heading, click Delete. A pop-up message will appear warning that the 
selected record will be deleted (Figure 107). 

 
Figure 107: Delete response data record warning 

4. Click OK. Another pop-up message will appear saying the record has been deleted. It will automatically 
disappear after a few seconds. 

10.3 Validating Respondent List 

After all response data has been successfully entered into ACER Maple, it needs to be checked against the 
student and school questionnaire tracking data updated in ACER Maple. 
  

 
Every data administrator must validate respondent list for their domain AFTER:  

• ALL tracking data in the domain has been updated; and 
• ALL response data in the domain has been keyed in. 

Each data manager must validate respondent list for the entire entity AFTER ALL data 
administrators validated data in their domains, but BEFORE data is submitted. 

 
  

 

The data administrator or the data manager login can be used for the following function.  
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To validate response data against student and school questionnaire tracking data: 
1. On the main screen select Response data > Validate respondent list and then click Activate. The 

Validate respondent list screen will appear (Figure 108). 

 
Figure 108: Validate respondent list screen 

2. A summary of the keyed in data is provided in the middle of the screen. The following information is 
listed for each instrument: 

• The number of students/schools listed as participating (for the listed instrument) in the 
appropriate tracking form; 

• The number of students/schools that have had data entered into the listed instrument; and 

• The number of records in both. If all data for the listed instrument has been entered correctly, the 
three numbers will be the same. 

3. On the left-hand side of the screen you can select or deselect the instruments that you want to 
validate.  

• The first time you validate response data, ensure that all instruments are selected. 

• On subsequent occasions, you may choose to only validate response data for instruments that 
contained errors that you have tried to correct. 

• You should validate response data for all instruments one final time before submitting your data 
to ACER. 
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4. Click Validate data for selected instrument(s). Two pop-up messages will appear, the first asking if you 
have entered all response data, the second all tracking data. Click Yes for both. ACER Maple then 
performs the validity checks. 
The possible outcomes are required actions are described in Table 56. 

Table 56: Possible outcomes when validating respondent list data 

Outcome  Next steps 

• The data has been validated with 
no discrepancies 

• A pop-up message appears saying 
the validation has been successful 

1. Click Dismiss.  
2. Click Back to return to the main screen. 

• The data contains some 
discrepancies that need to be 
checked or corrected 

• A pop-up message appears saying 
the data contains errors and/or 
warnings 

• Respondent List Validity Report is 
available for download 

1. Click Download Validity Report, save the file in an 
appropriate location. Click Cancel to close the pop-up 
message. 

2. Manually enter or navigate to the location of the saved 
report and open it. 

3. Refer to section 10.4.2 to check the records that appear in 
the report. 

4. If any corrections are required, make them in the 
corresponding tracking forms and/or data entry 
templates. 

5. Explanations of warnings listed in the report must be 
entered into the report by the data manager before data 
can be submitted (see section 11.1) 

 

10.4 Respondent List Validity Report 

If there are discrepancies between the response data that has been keyed in by data entry operators and 
corresponding student or school tracking information, ACER Maple will produce a Respondent List Validity 
Report (in Excel format) that contains information about these issues. Before you try to resolve them, make 
sure you have the relevant tracking forms and assessment instruments handy. 

There are two types of data inconsistencies listed in the report: errors and warnings. Errors and warnings in 
the report are organised into separate spreadsheets. Spreadsheet names clearly indicate which type of 
discrepancy the spreadsheet lists. 
  

 
The Respondent List Validity Report can contain multiple worksheets. Make sure you have 
checked the records in all worksheets in the report. 

10.4.1 Errors in Respondent List Validity Report 

Table 57 (page 166) lists errors that may appear in particular Error worksheets of the Respondent List Validity 
Report. Table 57 also explains how these errors can be resolved. 
  

 
Column names in square brackets appearing in messages within the report, such as [AMPL 
School No.] and [Line No.], will be replaced by the translated column names for LST_FRE. 
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After all corrections have been made in the appropriate data, attempt to validate the respondent list again. 
Your database cannot be submitted to ACER until all errors have been resolved and all warnings explained. 

10.4.2 Warnings in Respondent List Validity Report 

Table 58 (page 166) lists discrepancies that may appear in Warning worksheets of the Respondent List Validity 
Report and explains how they can be resolved. 
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Table 57: Respondent List Validity Report: Error worksheets – Possible errors and their resolutions 

Description Warning message in report How to resolve Action required 

<Instrument Name> (Error) worksheet 

One or more respondents 
are listed as participating in 
the tracking data but there is 
no data entered for them in 
the corresponding survey 
instrument 

Recorded as participating or 
attending instrument  
<Instrument ID> in tracking 
data, but is not entered in this 
instrument 

• Check the values in that column in the 
appropriate tracking Excel file. 

• Check the paper instruments for any 
instruments that may have been missed during 
data entry. 

• Contact the school to locate any missing 
instruments, or to verify information in STF. 

• Correct any errors in tracking data 
and update tracking in ACER Maple 

OR 
• Enter any missing records into 

corresponding assessment 
instrument template in ACER Maple 

Data is entered for a 
respondent in a survey 
instrument, but the 
respondent is listed as not 
participating in the tracking 
data 

Response data is entered, but 
respondent is not recorded as 
participating or attending 
instrument <Instrument ID> in 
tracking data 

• Check the values in that column in the 
appropriate tracking Excel file. 

• Check the paper instruments for any errors 
made during data entry 

• Contact the school to verify information in STF. 

• Correct any errors in tracking data 
and update tracking in ACER Maple 

OR 
• Correct or remove incorrect 

instrument records from ACER 
Maple 

Table 58: Respondent List Validity Report for student lists: Warning worksheets – Possible warnings and their resolutions  

Description Warning message in report How to resolve Action required 

<Instrument Name> (Warning) worksheet 

One or more respondents have 
data entered in one survey 
instrument but in the tracking 
data assigned a different survey 
instrument (only possible for 
rotated AMPL Booklets) 

Candidate was allocated  
<Instrument ID 1> in tracking 
data, but data entered into 
<Instrument ID 2> 

• Check that the student was accessed 
using the paper instrument that the data 
was entered into. 

• Enter student data into correct 
instrument there was a data entry 
mistake made in ACER Maple  

• Contact the school to get information on 
why different instrument was given to the 
student. 

• Correct or remove incorrect 
instrument records from ACER Maple 

OR 
• Save the report excel file produced by 

ACER Maple 
• Specify the reason for assigning 

assessment instrument different from 
what specified in tracking form and 
save the report Excel file.  
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Data manager should perform the tasks described in this chapter. 

 

11.1 Explaining Warnings 

Due to the complexity of test administration and data processing in large scale surveys, it is possible that 
some discrepancies reported by ACER Maple are actually valid data. These inconsistencies are listed in various 
validity reports as warnings. Therefore, the presence of warnings in validity reports will not prevent the 
Submit data function from being enabled in ACER Maple, but explanations must be provided to the ACER 
data management team as to how these inconsistencies occurred. 

It is essential for the data manager to provide explanations for all warnings that remain in any validity report, 
once those reports have been checked and any corrections to the data have been made. There are two 
validity reports may contain warnings:  
1. Update Institution Participation Validity Report produced when school participation information is 

imported into ACER Maple (sections 9.6 and 9.7); and  
2. Respondent List Validity Report produced after all participant responses have been entered into their 

corresponding assessment instruments (sections 10.3 and 10.4). 
  

 

Errors listed in the validity reports produced by ACER Maple will prevent users from 
completing the corresponding task and the Submit data function will not be enabled. 

It is possible ACER Maple did not produce one (or both) report(s) when the corresponding data management 
tasks were performed. This means there were no inconsistencies found in the data for the corresponding 
task. If the validity reports were not produced they do not need to be included in the data submission package 
(see section 11.4 for information about the content of the data submission package). The appropriate option 
should be ticked/checked (i.e. 3 - “No Warnings”) when completing questions Q4.1 and Q4.2 in the Data 
Submission Checklist document (see section A1.2). 

11.1.1 Explaining warnings in the Update Institution Participation Validity Report  

All warnings that remain in the Update Institution Participation Validity Report after you have successfully 
updated school participation for all schools (see section 9.6 and 9.7) must be explained in the validity report 
Excel file. 
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If the Update Institution Participation Validity Report was not produced when school 
participation was updated in ACER Maple (see section 9.6.2), this step is not required. 

To explain any warnings listed in the Update Institution Participation Validity Report: 
1. Manually enter or navigate to the location of the latest saved version of the Update Institution 

Participation Validity Report Excel file. 
2. Locate the first empty column adjacent to the cells containing data saved by ACER Maple (e.g. column C 

in Figure 109). 
3. Add the column heading “Explanations” (see Figure 109). 

4. Provide an explanation for each record listed in the report (see Figure 109). 
5. Save a new version of the validity report with “_Explained” added to the end of the file name. Ensure 

that the new file is saved in an appropriate location to be included with your database submission 
package. 

 
Figure 109: Filling up Update Institution Participation Validity Report Excel file 

The Update Institution Participation Validity Report will be reproduced by ACER staff upon receipt of the 
database submission package for each participating country. ACER reserves the right to not accept any 
database submission if the records listed in the validity report produced by ACER do not correspond to the 
explanations provided in the validity report Excel file included with your database submission package. 
 

 
If there are records in the Update Institution Participation Validity Report Excel file, each of 
them must be explained in the ‘Explanations’ column. 

11.1.2 Explaining warnings in the Respondent List Validity Report 
  

 
If the Respondent List Validity Report was not produced when respondent list data was 
validated in ACER Maple (see section 10.3), this step is not required. 

 

All warnings that remain in the Respondent List Validity Report after you have successfully validated 
respondent list data (see sections 10.3 and 10.4) must be explained in the validity report Excel file. 

To explain any warnings listed in the Respondent List Validity Report:  
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1. Manually enter or navigate to the location of the latest saved version of the Respondent List Validity 
Report Excel file. 

2. Locate the first empty column adjacent to the cells containing data saved by ACER Maple (e.g. column C 
in Figure 110). 

3. Add the column heading “Explanations” (see Figure 110). 
4. Provide an explanation for each record listed in the report (see Figure 110) 
5. Save a new version of the validity report with “_Explained” added to the end of the file name. Ensure 

that the new file is saved in an appropriate location to be included with your database submission 
package. 

 
Figure 110: Filling up Respondent List Validity Report Excel file 

The Respondent List Validity Report will be reproduced by ACER staff upon the receipt of the database 
submission package for each participating country. ACER reserves the right to not accept any database 
submission if the records listed in the validity report produced by ACER do not correspond to the explanations 
provided in the validity report Excel file included with your database submission package. 
 

 
If there are records in the Respondent List Validity Report Excel file, each of them must be 
explained in the ‘Explanations’ column. 
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11.2 Data Submission Schedule 

The data must be submitted to ACER within eight weeks of the completion of assessment.  

11.3 Checking that ACER Maple Data is Ready for Submission 

Once all required data has been successfully entered into ACER Maple and all errors has been corrected 
in ACER Maple, the Submit data function will be enabled. This function will combine all data files 
necessary for submission into a single zip file, which you will upload to your MS teams NC directory, 
Data Management folder. 
  

 

A data manager login must be used for the following function. 

To check that ACER Maple data is ready for submission to ACER: 
1. On the main screen select Final tasks > Submit data and then click Activate. The Submit data 

screen will appear (Figure 111). 

 
Figure 111: Submit data screen 

2. Click Check Warnings and Institution Participation. ACER Maple then performs a number of 
checks. The possible outcomes and required actions are described in Table 59. 
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Table 59: ACER Maple messages when checking warnings and institution participation 

Message Action required 

Your warnings and participation 
files are incomplete. Once these 
are finalised you will be able to 
export your data for submission. 

1. Update school participation in ACER Maple so that no errors are listed in 
Update School Participation Validity Report (section 9.6). 

2. Resolve all errors are listed in Respondent List Validity Report (section 
10.4.1). 

3. Attempt to submit the data again. 

Your warning and participation 
files have been completed, you 
can now export your data for 
submission.  

1. Take a screenshot of ACER Maple and save the picture in an appropriate 
location, as explained in the note below. The saved picture will need to 
be inserted into the Data submission Checklist document (see section 
A1.2). 

2. After the screenshot has been saved, click Export. All required data files 
will be combined into a single zip file which will be available for 
download. 

3. Select ‘Save File’ and save the zip file in an appropriate location. 
  

 
To take a screenshot: 

1. Press the ‘Alt’ and ‘PrintScn’ keys on your keyboard simultaneously. 
2. Open the Paint app. 
3. Press the ‘Ctrl’ and ‘V’ keys on your keyboard simultaneously (i.e. ‘paste’ function). 
4. Save a copy of the file in an appropriate location. 

 

3. After the screenshot and data has been saved follow the steps in section 11.4. 

11.4 Delivery Method 

To deliver your complete data submission package to ACER:  
1. Complete the Item Information for Cleaning documents (see section A1.1) and the Data 

Submission Checklist (see section A1.2)17. 
 Summarise information from the Session Reports and provide responses to all questions in 

the Item Information for Cleaning document. 
 Paste the screenshot of the ACER Maple message (see section 11.3) into the Data Submission 

Checklist. 
 Provide responses to all questions in the Data Submission Checklist. 

2. Add your 3-letter NC code to the file name of the zip file exported from ACER Maple in section 
11.3. 

3. Login to MS Teams and locate the Data Management folder within your NC directory. 
4. Within the Data Management folder for your NC, upload the database submission package that 

includes the following: 
 Submit_Data_<Date_Time>_[CNT].zip file as exported from ACER Maple 
 Completed Data Submission Checklist document (MS Word document) (section A1.2) 

 
 
 
17 The Word versions of these checklists can be found in the MS teams>AMPL Partner Collaboration>COVID-19 MILO>MILO 
International resources>Data Management Resources 
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 Completed Item Information for Cleaning document (MS Word document) (section A1.1) 
 Completed Update Institution Participation Validity Report (MS Excel spreadsheet), if 

applicable (section 11.1.1) 
 Completed Respondent List Validity Report (MS Excel spreadsheet), if applicable (section 

11.1.2) 
5. Send an e-mail to Maple Helpdesk <maplehelpdesk@acer.org> with the subject line “Data is 

ready for submission” and your 3-letter NC code in square brackets (i.e. [CNT]). 
  

 
ACER Maple only exports data necessary for analysis and reporting. This does not include 
confidential information, such as names collected by your NC during the  AMPL survey. 
Please keep the latest version of ACER Maple that was used to export data for submission, 
in case it is needed for future checks. 

11.5 Data Cleaning Participation 

Please designate a data manager who will work actively with ACER during the data processing. This 
person should be able to respond to any queries in a timely manner during a period of four to six weeks 
after database submission to ACER. 

Please do not hesitate to contact Alla Routitsky at <alla.routitsky@acer.org> and/or Alex Daraganov, 
Alexander.Daraganov@acer.org (cc to Maple Helpdesk <maplehelpdesk@acer.org>) if you have any 
questions regarding data submission. 

 

mailto:maplehelpdesk@acer.org
mailto:alla.routitsky@acer.org
mailto:Alexander.Daraganov@acer.org
mailto:maplehelpdesk@acer.org
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APPENDIX 1 DATA SUBMISSION CHECKLISTS 
A1.1 Item Information for Cleaning ........................................................................................... 173 
A1.2 Data Submission Checklist ................................................................................................. 178 

 

The Item Information for Cleaning and Data Submission Checklist word documents have been uploaded into 
the MS Teams>AMPL Partner Collaboration>Data Management folder. Please download the updated 
documents and use them in your data submission. 

Please fill these documents and include them into data submission package to ACER (see section 11.4).  
  

 
Please DO NOT use any other versions of these documents as they have been modified 
since the release of the software. 

 

A1.1 Item Information for Cleaning 

ITEM INFORMATION FOR CLEANING 
  
  

 
Please complete this form and return it with your data. 

 

Country  

NPM  

e-mail  

Data manager  

e-mail  
 
  

 
You may need to summarise relevant information from the Session Reports returned by 
Test Administrators to be able to answer the following questions. 
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Q1 Were there any problems with the test booklets? YES NO 

  1 2 

 For example poor printing; errors or omissions; missing pages; faulty cutting, folding 
or stapling 

  

 If ‘Yes’, please describe the nature and extent of the problem.   
    
    
    
    
    
    

 
  

 
In Q2 use as a booklet muber 1 and 2 for AMPL test booklets 1 and 2 respectively, and 
3 for national or regional test. 
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Q2 Were there any problems with specific test items? YES NO 

  1 2 

 For example errors or omissions, problems with graphics.   
 If ‘Yes’, please identify the booklet number, item number and student ID, and 

describe the problem. 
  

 If an item has a problem for a large number of students, please describe this problem in Q1 
providing the booklet number, the item number, and the number of students effected   

 Booklet Item Student ID    
       
       
       
       
       

 

Q3 Were there any problems with the questionnaires? YES NO 

  1 2 

 For example poor printing; errors or omissions; missing pages; faulty cutting, folding or stapling   
 If ‘Yes’, please describe the nature and extent of the problem.   
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Q4 Were there any problems with specific student questionnaire items? YES NO 

  1 2 

 For example errors or omissions, problems with graphics.   
 If ‘Yes’, please identify the item number and student ID, and describe the problem.   

 If an item has a problem for a large number of students, please describe this problem in Q3 
providing the booklet number, the item number, and the number of students effected   

 Item Student ID    

      

      

      

      

 

Q5 Were there any problems with specific school questionnaire items? YES NO 

  1 2 

 For example errors or omissions, problems with graphics.   
 If ‘Yes’, please identify the item number and principal ID, and describe the 

problem. 
  

 If an item has a problem for a large number of principals, please describe this problem in Q3 
providing the booklet number, the item number, and the number of students effected   

 Item Principal ID    
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Q6 Please notify us about any other matter that may require additional data cleaning 

   

  

  

  

  

  

THANK YOU! 
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A1.2 Data Submission Checklist 

DATA SUBMISSION CHECKLIST 
   
  

 
Please note that this is a checklist only. Please refer to Chapter 11 of this manual for more 
information 

 
Please insert a screenshot from data submission screen in ACER Maple here: 
 

 

 

Q1 

 

 

 

Have ALL of your required data been entered into ACER Maple? 

 

YES NO 

 Required data: 1 2 

 • List of Classes 
• List of Students 
• Student Tracking Forms 
• School Questionnaire Tracking Form 
   

• AMPL test booklets 
• Student Questionnaire 
• School Questionnaire 

  

 If ‘No’, please enter ALL the data BEFORE you proceed with data submission   
 

Q2 Have you entered student details in your ACER Maple List of Students for 
sampling? YES NO 

  1 2 

 If ‘No’, please upload a complete set of hard copies of LSTs to:  
MS teams>AMPL Partner Collaboration>{Your country 
folder}>Data Management 

  

 
 



Appendix 1: Data submission checklists AMPL DMM 

ACER © 2023 Commercial in Confidence Page 179 of 197 

Q3.1 
Have you explained ALL warnings in the Validate Respondent 
List Report? 

 

YES       NO NO WARNINGS 

  1      2    3 

 If ‘No’, please explain warnings in the latest Excel output of 
your Validate Respondent List Report BEFORE you submit your 

  

  

 Data submitted without Validate Respondent List Report or without 
warnings explained will not be cleaned within the timeframe.  

Please contact Alla Routitsky at: Alla.Routitsky@acer.org (cc 
maplehelpdesk@acer.org) if you have any questions about validity 
reports 

  

 

 

 
 

Q4 Have you summarised Item Information for Cleaning? YES NO 

  1 2 

 If ‘No’, please summarise item information BEFORE you submit your data.   
 

Q5 Please check that you included all materials required for submission: Included 

 ACER Maple Database extracted for data submission    

 Final version of the Validate Respondent List Report (with warnings explained)    
 Final version of the Update Institution Participation Validity Report (with warnings explained)    
 Item Information for Cleaning    

 

Q3.2 
Have you explained ALL warnings in the Update Institution 
Participation Validity Report? 

 

YES       NO NO WARNINGS 

  1      2    3 

 If ‘No’, please explain warnings in the latest Excel output of your 
Update Institution Participation Validity Report BEFORE you submit 

   

  

 Data submitted without all warning explained in Update Institution 
Participation Validity Report will not be cleaned within the timeframe.  

Please contact Alla Routitsky at: Alla.Routitsky@acer.org (cc 
maplehelpdesk@acer.org) if you have any questions about validity reports 
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Q6 Please notify us about any other matter that may require additional data cleaning 

   

  

  

  

  

  

THANK YOU! 
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A2.1 Installation Troubleshooting 

Manual exception configuration in the LAN settings to bypass the proxy 

This section explains how to configure exception in the LAN settings of the chosen browser (Google 
Chrome or Mozilla Firefox) on each PC to bypass the proxy when connecting to the IP of the PC hosting 
ACER Maple. 

1. Google Chrome 

1. Go to ‘Settings’ > ‘Advanced’. 
2. Scroll down to the ‘System’ section and click Open proxy settings (Figure 112).  

The ‘Internet Properties’ > ‘Connections’ window will appear (Figure 113). 

 
Figure 112: Google Chrome Advanced Settings 
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Figure 113: Google Chrome Internet Properties > Connections 

3. Click LAN Settings. The Local Area Network (LAN) Settings window will appear. 
4. Deselect ‘Use automatic configuration script’ and select ‘Use a proxy server for your LAN’.  Then 

in the Address field enter the IP address and port of the proxy server (as advised by your network 
administrator) (Figure 114Error! Reference source not found.). 

 
Figure 114: Local Area Network (LAN) Settings 

5. Click Advanced. The ‘Proxy Settings’ window will appear. 
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6. In the Exceptions field enter the IP address of the host PC (Figure 115). 

 
Figure 115: Proxy Settings 

7. Click OK three times to exit the Internet Properties windows. 

Mozilla Firefox 

1. Go to Options and scroll down to the Network Settings or Network Proxy section (Figure 116). 

 
Figure 116: Mozilla Firefox Options – Network Proxy section 

2. Click Settings. The Connection Settings window will appear. 
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3. Select ‘Manual proxy configuration’ and in the No proxy for field enter the IP address of the host 
PC (Figure 117). 

 
Figure 117: Mozilla Firefox Connection Settings 

4. Click OK and then close the Options tab. 

Network policy restrictions 

If you have problems during installation and the log file in 
…\ACER_MAPLE_V<#>\shiny\ShinyAppMsg.log has a line: “createTcpServer: permission denied”, then 
you are most likely experiencing the network policy restrictions: port 80 is blocked (reserved for 
internet protocols) and not available to the ACER Maple. 

To change the port: 
1. go into ACER Maple installation folder …\ACER_MAPLE_AMPL\shiny\acer_maple; 
2. open the file called ‘run_app_basic.R’ using any text editor (say, Notepad);  
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on line 13 you will see the code starting from ‘shiny::shinyAppFile …’ 
3. replace line 13 in the file with the line: 

shiny::shinyAppFile( "app_basic_structure.R", options = list(shiny.port = 8000, port = 8000, host = 
"0.0.0.0", launch.browser = T ) ); 

4. save the run_app_basic.R file; 
5. after the file is saved, try to start ACER Maple (same way as before). 

After this modification, every time when you connect to ACER Maple, specify the port in the URL 
address as: 127.0.0.1:8000. 

“Not in a hypervisor partition” error 

 
If you see a pop-up error message saying “Not in a hypervisor partition” instead of the 
purple UBUNTU window, please follow below steps to solve the issue. 
The error message 

 
 
The solution 
Step 1. Restart your laptop or desktop computer. Then, press the BIOS key when the boot 
screen appears to enter BIOS mode. (The BIOS key is usually the “ESC” key on the keyboard, 
but different computer models may have different BIOS keys) 

 
Step 2. Use the arrow keys to navigate the Configuration tab in the BIOS interface, where 
you can find the virtualization. 
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Step 3. Once you've located the virtualization item (IVT, AMD-V, or something related to 
virtualization), press Enter to confirm that it is enabled. 

 
Step 4. Click F10 to save your changes and exit BIOS. 

 
After enabling Virtualization in BIOS, restart your computer to restart the virtual machine 
in VirtualBox. You will open this VM smoothly this time. 
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A2.2 Resetting forgotten password 

 
Only data managers can reset forgotten passwords. Data administrators must ask their 
data manager to reset their forgotten password for them. 

To reset a forgotten password: 
1. Open ACER Maple: 
• If using single user deployment, in ACER_MAPLE_V<#> folder double-click acer_maple_start.bat. 
• If using multiple user deployment, paste the IP address of the host PC into the address bar of a 

browser.  
The Login screen will appear (Figure 118).  

 
Figure 118: ACER Maple Login screen 
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2. If you are a data manager, on the left-hand side of the Login screen under ‘Help’, click Forgot 
password. The Reset Password screen will appear (Figure 119). 

 
Figure 119: Reset Password screen 

3. Enter your domain: Survey ID (033), Entity ID (6 digits) and Admin ID (00). 
4. Enter your username. 
5. Click Get passkey. A passkey will appear in the Passkey field. 

6. E-mail the passkey, domain and username to Maple Helpdesk maplehelpdesk@acer.org. 
7. You will receive an e-mail from ACER containing the data required for the fields ACER public key, 

Reset code and TempMsg. Due to the time difference between your country and Australia, it 
may take up to 24 hours to receive this e-mail. 

8. After you receive e-mail from ACER, enter the ACER public key, reset code and TempMsg into the 
relevant fields. 

9. Click Reset password. 
10. Your password will be reset, and a temporary password will appear in a pop-up message. 
11. Copy the temporary password. 

12. Click Back. 
13. On the left-hand side of the Login screen under ‘Help’, click First time login. 
 

mailto:maplehelpdesk@acer.org
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A2.3 Restoring Data in ACER Maple 

ACER Maple can back up the entire database every time a user clicks Quit if this user clicks YES on the 
prompt asking whether the user wants to back up the data. The data backed up earlier on the same 
day will be overwritten. The data backed up the previous day is retained. If there is a need to keep 
data backed up earlier on the same day, the sub-folder within the ‘Backup’ folder with the current date 
should be copied to a secure location before the new data is backed up.  

All backups of the database are stored in the ‘…\ACER_MAPLE_V<#>\shiny\backups’ folder. The 
database backed up on a particular date is stored in the subfolder db_backup_<Date>. 

 
Figure 120: Subfolder with database backed up 07Jan 2020 

The actual backup consists of two database files: maple_database.db and maple_conf_database.db 
(Figure 121Error! Reference source not found.) 

 
Figure 121: Database files in subfolder backed up 07Jan 2020 

A subfolder with the username may also be created if the user clicked Quit button after he/she logged 
into ACER Maple. 

To restore the data in ACER Maple to the version backed up earlier, each of the two files needs to be 
copied into the ACER Maple folders that store the database files: 

• maple_database.db should replace the file with the same name in the …\shiny\tables 
folder; and 

• maple_conf_database.db should replace the file with the same name in the 
…\shiny\confidential_tables\ folder. 

A2.4 Re-sampling students. 

You may need to re-sample students from a school if the initial student list was incorrect and you are 
sure there is enough time to produce new tracking forms, and send these updated forms to the school 
before the test day. In this case, make sure that all old tracking form versions are deleted by you and 
the School Co-ordinator before you start the process. 

  

 

Do not re-sample students unless this has been agreed with ACER. 
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A data administrator login must be used for the following function. 

To re-sample students and allocate instruments to students: 
1. On the main screen select Sample and allocate instruments > Sample and allocate and then click 

Activate. The Sample and allocate instruments screen will appear (Figure 65). 
2. In the Select Population Type box select students. 
3. In the Select Combined Option box select the combined option available 
4. In the Select School Type list select ‘Already sampled’. 
5. Click List Available Institutions to Sample. In the Available for Sampling box the AMPL School 

Number of all schools which are available for sampling for the selected population type and 
combined option will be listed (Figure 66). 

 
Figure 122: Schools available for sampling listed in the Available for Sampling box 

6. In the Available for Sampling box select the AMPL School No. of all schools to be sampled. Use 
Shift and/or Ctrl to select multiple schools as required (Figure 67). 

 
Figure 123: Selecting multiple schools in the Available for Sampling box 

7. Click  to move these schools into the Selected for Sampling box (Figure 68). To remove 
schools from the Selected for Sampling box select the AMPL School No. in this box and then click 

. Once schools have been added to the Selected for Sampling box the Sample button will 
appear. 
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Figure 124: Multiple schools moved to the Selected for Sampling box 

8. Click Sample. ACER Maple will sample and allocate instruments to the selected population for 
the selected combined option in the selected schools. 

During the sampling and instrument allocation process ACER Maple performs some checks. The 
possible outcomes and required actions are described in Table 32 on page 100. 
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APPENDIX 3 BLIND SAMPLING 
  

 
This procedure can only be used if a school has agreed to participate, but the List of 
Students will not be received from the School Coordinator in time for student sampling. 
Blind sampling is more expensive and less relible than sampling from a List of Students with 
complete - and carefully checked - data. 
Blind sampling does not excuse the School Coordinator from preparing a List of Students. 
If blind sampling is being used: 
1. The number of students in the grade eligible for assessment must be obtained from 

the School Coordinator. 
2. The LST data must be prepared by the data administrator as shown in Table 60, and 

imported into ACER Maple (see section 5.4). Then students must be sampled (see 
chapter 6), and the STF template populated with students ID. 

3. At the same time, the LST data must be completed by the School Coordinator at least 
two days before the assessment takes place, as explained in the School Coordinator 
Manual. 

4. The Test Administrator must visit the school a day before the assessment and manually 
transfer the records into the STF according to Line No. value in the STF. 
For example, if line number 00003 appears in the STF, then the details of the third 
student from the LST completed by the School Coordinator must be transferred into 
STF. 
This must be done for every listed line number in the STF. 

5. The LST completed by the School Coordinator must be collected by the Test 
Administrator and sent to the NC after the assessment, along with all other materials. 

 

Table 60: Example LST data in Excel format ready to be imported into ACER Maple for blind sampling 

1 
 

 AMPL  
(F=1; 
M=2) MM YYYY 

Special  
Educational  

Needs 

2 
Class 
name Student name 

School 
No. 

Line 
No. Gender 

Month of 
Birth 

Year of 
Birth SEN 

3   1001 00001 9 99 9999 0 

4   1001 00002 9 99 9999 0 

5   1001 00003 9 99 9999 0 

6   1001 00004 9 99 9999 0 

7   1001 00005 9 99 9999 0 

8   1001 00006 9 99 9999 0 

10   1001 00007 9 99 9999 0 

11   1001 00008 9 99 9999 0 

12   1001 00009 9 99 9999 0 

13   1001 00010 9 99 9999 0 

14   1001 00011 9 99 9999 0 
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